MainView User Guide

Supporting

Version 6.1 of MainView Infrastructure

September 2012
Contacting BMC Software

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

Address  
BMC SOFTWARE INC  
2101 CITYWEST BLVD  
HOUSTON TX 77042-2827 USA

Telephone  
1 713 918 8800  
or  
1 800 841 2031

Fax  
1 713 918 8000

Outside United States and Canada

Telephone  
+01 713 918 8800

Fax  
+01 713 918 8000

© Copyright 2005 - 2012 BMC Software, Inc.

BMC, BMC Software, and the BMC Software logo are the exclusive properties of BMC Software, Inc., are registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

Explorer is a trademark or registered trademark of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

CICS, Current, DB2, IBM, IMS, MQSeries, MVS, NetView, VTAM, WebSphere, and z/OS are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

Linux is the registered trademark of Linus Torvalds.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

UNIX is the registered trademark of The Open Group in the US and other countries.

The information included in this documentation is the proprietary and confidential information of BMC Software, Inc., its affiliates, or licensors. Your use of this information is subject to the terms and conditions of the applicable End User License agreement for the product and to the proprietary and restricted rights notices included in the product documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED—RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to this address.
Customer support

Support website
You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this website, you can:

- Read overviews about support services and programs that BMC offers
- Find the most current information about BMC products
- Search a database for problems similar to yours and possible solutions
- Order or download product documentation
- Download products and maintenance
- Report a problem or ask a question
- Subscribe to receive proactive e-mail alerts
- Find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail
In the United States and Canada, if you need technical support and do not have access to the web, call 1 800 537 1813 or send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:yourSupportContractID, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC
Have the following information available so that Customer Support can begin working on your issue immediately:

- Product information
  - Product name
  - Product version (release number)
  - License number and password (trial or permanent)
- Operating system and environment information
  - Machine type
  - Operating system type, version, and service pack or other maintenance level such as PUT or PTF
  - System hardware configuration
  - Serial numbers
  - Related software (database, application, and communication) including type, version, and service pack or maintenance level
- Sequence of events leading to the problem
- Commands and options that you used
- Messages received (and the time and date that you received them)
  - Product error messages
  - Messages from the operating system, such as file system full
  - Messages from related software
License key and password information

If you have questions about your license key or password, contact Customer Support through one of the following methods:

- Send an e-mail message to customer_support@bmc.com. (In the Subject line, enter SupID:yourSupportContractID, such as SupID:12345.)
- In the United States and Canada, call 1 800 537 1813. Outside the United States and Canada, contact your local support center for assistance.
# Contents

**About this book** ................................................................. 11
**Related publications** ........................................................ 11
**Conventions** .................................................................... 11

## Chapter 1
Overview of the MainView environment .......................... 13

- MainView architecture ..................................................... 13
  - Coordinating address space (CAS) .............................. 15
  - Runtime Component System (RTCS) ......................... 16
  - Product address space (PAS) ...................................... 16
  - User address space (UAS) ........................................ 17

- Key features of MainView ............................................... 18
  - MainView interface options ...................................... 19
  - Automation and object management ........................ 21
  - Context determination ............................................. 22
  - Design data views .................................................. 24
  - Ease of navigation .................................................. 25
  - Historical data views .............................................. 26
  - Exception monitoring .............................................. 27
  - Security management systems ................................. 28

- MainView views and displays ........................................ 28
  - Types of views ........................................................ 29
  - Context of a view .................................................... 30
  - Working with views ................................................ 31

- Overview of online Help ................................................ 32
  - Online Help for MainView Explorer ......................... 32
  - Online Help for ISPF (windows mode) ..................... 33
  - Online Help for full-screen mode ............................ 33

## Chapter 2
Overview of the MainView interfaces ............................... 37

- MainView Explorer ......................................................... 37
  - The console ............................................................... 38
  - The view frame ........................................................ 45
  - The navigation frame ................................................. 57
  - The Plex displays ...................................................... 63
  - The messages frame ................................................ 67

- Windows mode ................................................................. 67
  - Overview of MainView windows ................................. 68
The control area ...............................................................69
The window information line ...........................................74
Full-screen mode .............................................................76

Chapter 3  Accessing MainView products 79
Starting a MainView Explorer session .................................79
Starting MainView Explorer in a browser .....................80
Starting MainView Explorer as a local application ..........81
Logging on to MainView Explorer ................................83
Setting a context in MainView Explorer .......................85
Starting a TSO session ....................................................86
Connecting to a different CAS .......................................88
Stopping a TSO session .................................................89
Transferring from full-screen mode to windows mode ....90
Transferring from windows mode to windows mode ......91
Transferring from windows mode to full-screen mode ...93
Transferring from full-screen mode to full-screen mode ..97
MainView Selection Menu options ...............................98

Chapter 4  Using the MainView interfaces 103
Working with views in MainView Explorer .......................103
Opening a view ............................................................104
Locating a view ............................................................105
Detaching a view ..........................................................105
Hyperlinking to other views .........................................106
Showing excluded fields in a view ..............................107
Showing header information ........................................107
Changing the font in a view .........................................108
Changing the colors in a view ......................................108
Moving columns and fields ........................................109
Resizing columns and fields .......................................110
Executing MainView commands .................................111
Client and host server information displayed in MainView Explorer ...112
Working with the Plex Map display ...............................112
Working with Plex Topology displays .........................113
Working with views in windows mode .......................114
Overview of the display area ....................................115
Working with screens ................................................121
Transfer methods between TSO ISPF terminal sessions ..123
Using the Messages and Codes display .......................124
## Chapter 5 Building views of data

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controlling data views in MainView Explorer</td>
<td>127</td>
</tr>
<tr>
<td>Refreshing view data (MainView Explorer)</td>
<td>128</td>
</tr>
<tr>
<td>Sorting view data (MainView Explorer)</td>
<td>129</td>
</tr>
<tr>
<td>Finding data in a view</td>
<td>130</td>
</tr>
<tr>
<td>Selecting multiple rows of data</td>
<td>131</td>
</tr>
<tr>
<td>Exporting view data on demand</td>
<td>132</td>
</tr>
<tr>
<td>Exporting view data automatically</td>
<td>134</td>
</tr>
<tr>
<td>Importing a view or chart</td>
<td>138</td>
</tr>
<tr>
<td>Copying view data to the clipboard</td>
<td>138</td>
</tr>
<tr>
<td>Publishing view images</td>
<td>139</td>
</tr>
<tr>
<td>Printing view data</td>
<td>140</td>
</tr>
<tr>
<td>Performing host actions from a view</td>
<td>141</td>
</tr>
<tr>
<td>Setting personal configurations</td>
<td>143</td>
</tr>
<tr>
<td>Opening a configuration</td>
<td>143</td>
</tr>
<tr>
<td>Saving a configuration</td>
<td>144</td>
</tr>
<tr>
<td>Working with configurations</td>
<td>144</td>
</tr>
<tr>
<td>Importing a screen</td>
<td>145</td>
</tr>
<tr>
<td>Working with charts</td>
<td>146</td>
</tr>
<tr>
<td>Types of charts</td>
<td>146</td>
</tr>
<tr>
<td>Toolbar buttons for charts</td>
<td>151</td>
</tr>
<tr>
<td>Opening a chart</td>
<td>153</td>
</tr>
<tr>
<td>Changing the chart type</td>
<td>154</td>
</tr>
<tr>
<td>Changing the items in a chart</td>
<td>154</td>
</tr>
<tr>
<td>Changing the font and colors in a chart</td>
<td>155</td>
</tr>
<tr>
<td>Changing the background of a chart</td>
<td>157</td>
</tr>
<tr>
<td>Changing the type of gauge</td>
<td>158</td>
</tr>
<tr>
<td>Rotating a 3D chart</td>
<td>159</td>
</tr>
<tr>
<td>Navigating and arranging topology charts</td>
<td>159</td>
</tr>
<tr>
<td>Copying a chart to the clipboard</td>
<td>160</td>
</tr>
<tr>
<td>Saving a chart to a file</td>
<td>161</td>
</tr>
<tr>
<td>Working with view containers</td>
<td>161</td>
</tr>
<tr>
<td>Overview of view containers</td>
<td>162</td>
</tr>
<tr>
<td>Creating view containers</td>
<td>163</td>
</tr>
<tr>
<td>Arranging views within a view container</td>
<td>165</td>
</tr>
<tr>
<td>Detaching the view container for viewing in a separate window</td>
<td>166</td>
</tr>
<tr>
<td>Removing views from a view container</td>
<td>166</td>
</tr>
<tr>
<td>Refreshing data in a view container</td>
<td>167</td>
</tr>
<tr>
<td>Selecting actions for views in a view container</td>
<td>168</td>
</tr>
</tbody>
</table>
Chapter 6  Customizing views 187

Customizing data display in MainView Explorer .................................................. 187
  Changing column headers and field names ................................................. 188
  Adjusting the precision of numeric data ....................................................... 189
  Showing zero ............................................................................................. 190
  Specifying a display mode .......................................................................... 191
  Specifying a summarization type ................................................................. 192
  Specifying thresholds ................................................................................ 194
  Customizing hyperlinks .............................................................................. 196
  Filtering data in a view in MainView Explorer ......................................... 200
  Adding fields to the Groupby list ................................................................. 206
  Adding fields to the Sort list ....................................................................... 207
  Adding to the Parameter list ........................................................................ 208
  Setting chart items (X or Y axis) ................................................................. 209
  Duplicating fields ....................................................................................... 210
  Excluding and including fields ................................................................... 210
  Saving customized views (MainView Explorer) ......................................... 211

Customizing data display in windows mode .................................................. 214
  Creating and saving customized views (windows mode) ......................... 215
  Using hyperlinks and menus to access views ............................................ 227
  Filtering data in a view in windows mode ................................................... 232
  Deleting a customized view ....................................................................... 244

Chapter 7  Working with historical data 247
Displaying historical data ................................................................. 247
  Examples of common TIME command requests ................................. 251
  Comparing historical system performance with current performance ... 253
  Viewing date and time fields for historical data ................................. 254
Working with historical batch reports .................................................. 254
  Overview of historical batch reports .................................................. 255
  Accessing the MainView Batch Reports panel ....................................... 256
  Setting up the MainView batch environment ........................................ 257
  Generating batch report JCL ............................................................... 258
  Managing batch report JCL members .................................................. 260
  Browsing batch reports for viewing online ......................................... 261
Viewing historical data in MainView Explorer ........................................ 261

Chapter 8 Working with full-screen mode displays ................................. 265
  Working with the Primary Option Menu ............................................. 265
    Primary Option Menu ..................................................................... 265
    Performance data display ............................................................... 266
    Returning to the Primary Option Menu ........................................... 268
  Specifying the target system ............................................................... 269
  Working with program function (PF) keys .......................................... 270
    Program function (PF) key definitions .............................................. 270
    Displaying the PF key definitions .................................................... 272
    Changing PF key assignments .......................................................... 273
  Controlling screens and displays in full-screen mode ............................. 274
    Splitting the screen ..................................................................... 275
    Exiting a display .......................................................................... 275
    Printing a screen .......................................................................... 276
    Refreshing a single display ............................................................. 276
    Scrolling a display ........................................................................ 277
    Wildcard characters in requests ....................................................... 279
    Expanding displays ...................................................................... 280
  Working with general services .......................................................... 282
    Using service refresh cycles ........................................................... 283
    Displaying logs ............................................................................ 296
  Transferring between applications in full-screen mode ......................... 304
This book contains detailed product information and is intended for system administrators and database administrators (DBAs).

Like most BMC documentation, this book is available in printed and online formats. To request printed books or to view online books and notices (such as release notes and technical bulletins), see the support website at http://www.bmc.com/support.

**Note**

Online books are formatted as PDF or HTML files. To view, print, or copy PDF books, use the free Adobe Reader from Adobe Systems. If your product installation does not install the reader, you can obtain the reader at http://www.adobe.com.

The software also offers online Help. To access Help, press F1 within any product or click the Help button in graphical user interfaces (GUIs).

**Related publications**

From the BMC Support Central website (http://www.bmc.com/support), you can use either of the following methods to access related publications that support your product or solution:

- Link to the BMC Documentation Center (https://webapps.bmc.com/infocenter/index.jsp) to browse documentation sets, or to view demos (short overviews of selected product concepts, tasks, or features)

- View individual product documents (books and notices) within the “A – Z Supported Product List”

You can order hardcopy documentation from your BMC sales representative or from the support site. You can also subscribe to proactive alerts to receive e-mail messages when notices are issued.

**Conventions**

This document uses the following special conventions:
- All syntax, operating system terms, and literal examples are presented in this typeface.

- Variable text in path names, system messages, or syntax is displayed in italic text: `testsys/instance/fileName`

- This document uses a symbol to show menu sequences. For example, `Actions => Create Test` instructs you to choose the `Create Test` command from the `Actions` menu.
Overview of the MainView environment

This chapter provides details about MainView architecture, an explanation of the key features, a description of views and displays, and an understanding of how to use online help.

MainView architecture

MainView is an integrated family of performance management and automation products that monitor and control traditional and parallel mainframes. MainView includes performance monitors, automated operations, and automation applications.

MainView product integration provides host system monitoring and automation (even in remote locations) through a common terminal session. Product integration is achieved through the BBI intercommunications technology.

BBI integrates the MainView performance products within a common communications framework that operates across multiple machines in multiple locations Figure 1 on page 15. A single terminal session can use one or more MainView products to monitor and manage multiple local or remote targets. Typical targets include:

- IBM z/OS (sysplex or nonsysplex)
- IBM subsystems (such as CICS, DB2, IMS, MQSeries, VTAM, or WebSphere)
- UNIX systems from The Open Group
- Linux systems from Linus Torvalds
- TCP/IP

For products that operate in MainView windows mode, the architecture provides a built-in separation of the data, application, and end-use dimensions of systems management. This separation facilitates maximum flexibility and extensibility. BBI
communications, data collection, and the end-user terminal session run in three distinct address spaces:

- Coordinating address space (CAS)
- Product address space (PAS)
- User address space (UAS)

This structure provides a consistent, flexible environment for managing hundreds of system images. Depending on the products installed, with this environment you can:

- Summarize data on a single system or across multiple system images
- View historical or real-time data from multiple systems, summarized in one view
- Enter commands for multiple products on multiple systems
- Apply simple or complex data-filtering conditions
- Access different systems and products quickly and easily with simple target switching, direct hyperlinks between products, or multiple concurrent views on one terminal session
Coordinating address space (CAS)

The CAS runs as a subsystem. It manages communication with CASs on other local and remote systems, and provides direct communication between an individual terminal session and a product address space.

Usually, one LPAR runs one CAS. However, a single CAS can communicate with an unlimited number of remote systems.

A product establishes an independent connection with its local CAS. You can add new products or upgrades to the architecture without affecting existing products or other configurations.
Each CAS contains a component called *Plex Manager*. Plex Manager provides administration and operations views that help you:

- Manage communication links with other CASs
- Monitor the activity of accessible products
- Create single system image (SSI) contexts
- Control security for products

**Runtime Component System (RTCS)**

RTCS provides programming services to all CASs, PASs, and UASs. It runs as a started task that starts soon after a system IPL occurs.

RTCS has no user interface (other than console commands to modify its operation), operates continuously, and seldom if ever needs to be stopped. For more information, refer to the *BMC Runtime Component System Configuration and Administration Guide*.

**Product address space (PAS)**

A PAS runs as a started task. It consists of special routines, including a data collector, to support one or more MainView products.

- The following MainView products use the MVS PAS:
  - CMF MONITOR
  - MainView *for z/OS*
  - MainView *for UNIX System Services*
  - MainView SYSPROG Services
  - MainView VistaPoint (for IBM MVS workloads)

One MVS PAS runs on a single system image and always connects to the CAS on that system image.

- The following MainView products use the BBI-SS PASs:
  - MainView AutoOPERATOR
MainView for CICS

— MainView for DB2

— MainView for DBCTL

— MainView for IMS Online

— MainView for WebSphere MQ

— MainView VistaPoint (for CICS, DB2, DBCTL, and IMS workloads)

Multiple instances of the BBI-SS PAS can run on a single system image and can contain one or more products. Depending on the products installed, the BBI-SS PAS might or might not connect to a CAS on that system image.

BBI-SS PASs on local and remote systems are linked. This linking provides cross-system communication for an individual terminal session through a local BBI-SS PAS to any other BBI-SS PAS.

The following MainView products use product-specific PASs:

— MainView for IP

— MainView for Linux - Servers

— MainView for VTAM

— MainView for WebSphere Application Server

— MainView Storage Resource Manager (SRM)

— MainView Transaction Analyzer

For MainView for Linux - Servers and MainView for VTAM, multiple instances of the PAS can run on a single system image. In the case of MainView for Linux - Servers, each PAS can monitor up to 500 Linux images. You can run multiple PASs to support the number of Linux images that you plan to monitor.

For MainView for IP, MainView for WebSphere Application Server, MainView SRM, and MainView Transaction Analyzer, only one product-specific PAS can be active for each product on a system image.

User address space (UAS)

The UAS is the home for a terminal session, which provides the end-user session for all MainView products. The terminal session connects to a CAS if one is available, to a BBI-SS PAS, or to both.
The following types of UASs are available:

- **MainView Host Gateway that uses MainView Explorer**
  Using MainView Explorer, you can access MainView products from a web browser or application that is running on your personal computer.

- **TSO address space**
  Using a TSO address space, you can access MainView products and perform other TSO/ISPF functions.

- **VTAM or EXCP address space that uses MainView Alternate Access**
  Using a separate address space that communicates with your terminal through either VTAM or EXCP, you can access MainView products and also perform other ISPF functions.

---

**Key features of MainView**

This topic provides essential information about the key features of MainView and describes how to utilize them to optimize their performance. It explains how to get the most out of the unique features of MainView and maximize your results.

BMC software recommends a thorough understanding of the following features to utilize every aspect of MainView and realize its ability to revolutionize the way you do your work:

- **MainView interface options on page 19**
- **Automation and object management on page 21**
- **Context determination on page 22**
- **Design data views on page 24**
- **Ease of navigation on page 25**
- **Historical data views on page 26**
- **Exception monitoring on page 27**
- **Security management systems on page 28**
MainView interface options

MainView gives you the flexibility to select the user interface that you prefer: Windows Explorer (a graphical user interface, or GUI), or windows mode (an ISPF-based interface). You can use either interface at any time during a session.

MainView Explorer

MainView Explorer is a desktop GUI that lets you access MainView products through your web browser or by installing the interface as an application in a local directory. With MainView Explorer, you can build views from comprehensive menus and with the ease of a mouse click.

MainView Explorer offers the following advantages:

- Diversity of data views
  With the GUI, you can see your data in more diverse ways. MainView Explorer can display data in enhanced chart types, such as topology diagrams, histograms, and three-dimensional bar charts. These exclusive views efficiently illustrate the relationships between data, visually accelerating the communication and understanding of data and ideas.
  For example, Plex Topology displays provide detailed, hierarchical views of the relationships between the products and systems in the sysplex. At a glance, you can see which systems are active and running MainView products.

- Ease of use
  The graphical environment of MainView Explorer lets you format, arrange, and manage your data in ways that are unmatched in a standard ISPF session. With the GUI, you can:
  - Open as many as 30 tabs of different views at one time
  - Detach your view into a separate window that you can open, resize, and close
  - Move columns and fields by clicking and dragging them
  - Resize and sort columns of data with the click of a mouse
  - Export data by taking a snapshot of it for viewing offline
  - Import snapshots of data views back into MainView Explorer
  - Copy data views to the clipboard

  With the speed and simplicity of a mouse click, you can also perform the following actions:
— Initiate searches for data
— Initiate line actions against views
— Initiate historical data views
— Display, hide, and initiate changes to the filter masks
— Control the refresh rate
— Select multiple rows of data to perform actions such as exporting, printing, or producing charts

Also, by clicking the 3270 node in the Context tree, you can see your data in ISPF format. Conversely, you can save any ISPF screen in windows mode and import it into MainView Explorer, which treats the data as though it were created in the GUI.

**Note**
For MainView functions that operate only in full-screen mode, MainView Explorer automatically opens an emulator window, as needed.

**Windows mode**

Users who prefer an ISPF interface can use windows mode, displaying up to 20 windows at once. The data is organized into a tabular view, and you can split the screen both vertically and horizontally. Because you can format the data into a variety of configurations, you can create views for any situation that you encounter. You can save these views for future use or delete them when no longer needed. Windows mode offers experienced users a familiar ISPF environment and powerful features for building and formatting views.

**Note**
The following MainView products have functions that operate in full-screen mode only, using standard ISPF conventions. These products shift from windows mode to full-screen mode as needed:

- MainView AutoOPERATOR
- MainView for CICS
- MainView for DB2
- MainView for IMS
Automation and object management

MainView products can collect information about problems as they happen and take corrective actions automatically. These automated actions improve your ability to provide high system availability.

MainView AutoOPERATOR mitigates the risks of outages by providing automated correct responses to conditions, as follows:

- Automates and coordinates management of system objects
- Manages starting up and shutting down procedures to ensure system availability
- Tracks each defined object
- Maintains the requested status of objects across the sysplex

By simplifying and streamlining automation processes without coding, MainView AutoOPERATOR also provides the following important benefits:

- Simplifies object management on different systems and sysplexes
- Simplifies object definition
- Maximizes resource availability
- Automatically distributes workloads to meet performance goals or to handle disaster situations

BMC automation products provide simple, nonprocedural rules to quickly and easily automate event handling. These products can also run advanced automation routines in REXX. Easy-to-use sample EXECs show how to send alerts through e-mail, pagers, and SNMP managers. Integration with BMC Event Manager (BEM) and BMC Atrium Orchestrator extends the reach of this comprehensive mainframe
automation family, completely supporting BSM and an enterprise-wide automation solution.

MainView Total Object Manager further extends the automation of system events to include coordinated management of system objects. Integrating the automation and object management capabilities into one complete automation solution provides an additional level of automated system availability.

The integration of MainView products simplifies the development of sophisticated system automation and coordinated object management. Integration also lets you use MainView Explorer to view an additional level of automated system availability, in an easy-to-understand flow diagram. For more information, see MainView AutoOPERATOR Basic Automation Guides and MainView Total Object Manager User Guide.

## Context determination

You can collect data from many systems in many locations and display it in a single view, as if it were from a single system. The built-in single system image (SSI) support gives you the power to monitor and manage multiple IBM z/OS systems as though they were one.

MainView enables you to determine the context of your data views. A context is a frame of reference for the data that you display in views. When you define a context, you specify a unique combination of target and product. You can select from predefined contexts and dynamic contexts that MainView provides, or create your own context to focus on specific data that you need.

Selecting your context defines which data to display—by creating vantage points that show only data that is relevant to your needs. In effect, the context acts as a high-level filter to narrow or increase the perspective as you require: you can create an unlimited number of virtual perspectives and construct the exact data view necessary for any situation. In this way, your data can be accessed and arranged into useful forms based on ongoing or daily needs. Similarly, you can discard or retain the context views as needed.

You can limit a context to a single target application or expand it to include all recognized targets that provide data to a MainView product. Contexts that include more than a single target are called SSI contexts. With SSI, you define the set of systems to be displayed in a single system image. This definition establishes a single point of control over all of the targets and products in a context from a single screen.

An SSI context uses the following criteria to select data to appear in your views:

- Target name (such as an IBM CICS region, IMS or DB2 subsystem, or z/OS system image)
■ Products attached to a coordinating address space (CAS)
■ Product attached to a product address space (PAS)

SSI is provided for both sysplex and nonsysplex environments. All levels of data, including detail data, are available in SSI mode. Consequently, you can display every data set that every job on every system is using on a particular DASD device. Furthermore, in SSI mode, you do not need to switch between images to see which jobs are causing a service class to deteriorate. Instead, you can view all of the following items running on all systems:

■ Every CICS transaction, region, program, file, terminal, and resource
■ Every DB2 thread, page set, buffer pool, lock, and resource
■ Every IMS transaction, region, program, database, class, and resource
■ IBM WebSphere MQ Queue Manager, queue, channel, and resource
■ All IP stacks, connections, response times, and throughput
■ IBM VTAM LU response time, throughput, VIPA, CSM, and resources
■ Storage controller, device, drawer, SMS group, and resource
■ WebSphere HTTP server user response time, cookie, heap, servlet, and WAS performance
■ All USS processes, threads, users, groups, file systems, directories, and resources

Additionally, you can remain in SSI mode but temporarily narrow the focus. This narrowed focus is called the scope. If you are viewing multiple targets, you can set the scope of your views to display selected targets within a context.

Narrowing the data into the specific form that you need increases your control over the data. This feature also increases your ability to glean the essential information from the extraneous and to uncover the best solution for any situation.

---

**Related Information**

■ “Context of a view” on page 30
■ “Setting a context in MainView Explorer” on page 85
■ “Displaying target systems” on page 180
■ “Displaying SSI context views in Plex Manager” on page 184
Design data views

Computer screens can display only a certain amount of data at one time. With MainView, you gain control of what your screen displays and how the data is arranged on it.

MainView empowers you to build your own view of data: a perspective that you construct for the exact viewpoint you need to monitor, manage, and execute your jobs. Understanding how to build these views helps you achieve the goal of complete control over your data and over systems management.

You work with two methods of control when building your view: query and form. Query controls which data MainView gathers, and form controls the data's display (through view customization and modification).

MainView's customization options let you arrange data elements into useful configurations that determine how the data will be displayed. You can build the exact perspective you need at the precise time that you need it. The customization settings are quick and versatile; you can change the view whenever you like and respond to the shifting changes of your system instantaneously. By designing your own view, you take control of your data and bring it into the best form for managing, analyzing, problem solving, and responding to diverse situations.

MainView offers the following ways to modify and customize your data views:

- Control the display of fields, including their format and position
- Create or change graphs of view data
- Create, change, or delete hyperlinks between views and other products
- Set keyword and positional parameters for a view, which can be used in filtering
- Set or remove data threshold conditions for a field
- Change the color in which data appears when it meets a specific condition, or substitute text for data that meets a specific condition
- Create a summary view, change which fields are summarized, or change how fields are summarized
- Create view containers to display multiple views and charts in a configuration
Ease of navigation

With MainView, you gain control not only of what your screen displays and how it arranges data, but also where it can take you.

MainView offers unparalleled ease of use and navigation through hyperlinks, menus, and commands that facilitate problem diagnosis, regardless of location or product. You never have to back out of what you are doing to go to another MainView component. Additionally, by splitting the display into multiple windows, you can view up to 20 different data views simultaneously, providing swift access to data across the sysplex. You do not need to log on and off constantly, or to consume resources by using session managers. Hyperlinks, menus, or commands are always available to help you get started on your next task.

Hyperlinks

Hyperlink fields provide a link to additional data that can offer greater detail about a potential problem. Hyperlinks can help you diagnose problems, regardless of location or product. You can easily define your own hyperlinks between views of data in one or more MainView products. Hyperlinks can cross product, subsystem, system, and sysplex boundaries seamlessly.

Menus

MainView includes an extensive network of menus, from high-level menus of products and components to object-specific menus that are related to a resource, job, or workload. Menus provide a quick, convenient way to access views. You can even create your own menu views to meet your site’s specific needs.

Commands

For users who prefer to type a command to get where they want to go, MainView offers a complete command-line interface. You can perform a variety of actions by executing primary commands. For instance, you can use commands to access data views as well as transfer between views within any MainView product, on any
system, and in any location. Alternatively, you can perform actions specific to a view by using line commands.

---

**Related Information**

- “Hyperlinking to other views” on page 106
- “Using hyperlinks and menus to access views” on page 227
- “Overview of menus” on page 228
- “Primary commands” on page 69
- “Line commands” on page 70

---

**Historical data views**

Most MainView products enable you to display data from the past. These historical data sets serve as a forum for examining situations from different perspectives within a consistent time frame, which can help you solve problems and manage systems.

To optimize the use of this historical data, you can:

- Re-create the operating environment as it existed yesterday, last week, or last month, and compare the historical data in one view with current system performance data in another view.

- Display multiple intervals of data that span hours, days, and weeks, and perform trending analysis on the historical performance of your system.

- Summarize multiple intervals of data and review past performance for a single resource or a group of resources over any time frame.

- Collect and report system performance information to help with capacity planning.

When you request information from MainView products online, detailed information from that point in time is preserved for as long as you need it. When required, you can arrange views of the historical data or export it to an external file.
Tip
You use MainView Explorer to create the graphs and charts that show historical data.

Related Information
- “Working with historical data” on page 247

Exception monitoring

MainView products include extensive exception monitoring features, ranging from setting simple thresholds for view data to managing sophisticated alerts and alarms.

The exception monitoring features can be categorized as simple thresholds, dynamic thresholds, exception reports, and action triggers:

- Simple thresholds
  You can customize any view to include a threshold value for an element displayed in the view. When a threshold is met, the color of the displayed data changes.

- Dynamic thresholds
  You can define dynamic thresholds for use anywhere in MainView that you can set a condition, such as when customizing an element in a view or defining an alarm.

- Exception reports
  The MainView Alarm Management component creates alarm reports based on performance goals that are continuously monitored. When a performance goal is not within acceptable parameters, an alarm report (also called an exception report) is created. You can set alarms for any (or all) severity levels, from informational to critical. Additionally, you can have the alarm reports provided to you in multiple ways.

- Action triggers
  Based on an alarm report, MainView Alarm Management can issue an alert to trigger an automated action. The action might create MVS console messages, create an alarm report for MainView AutoOPERATOR to process, call MainView AutoOPERATOR, or call the BMC Control-O product.

Although some products can create their own alerts, the MainView Alarm Management alert features are available to all MainView products. In contrast, all alarms are created through MainView Alarm Management. Additionally, you can
use MainView Alarm Management views to monitor alarm reports and all alerts (regardless of their origin).

For more information about exception monitoring, see MainView Alarm Management Guide.

**Security management systems**

The type of security that you implement depends on what products are installed at your site. The MainView environment provides an interface to ESMs by using standard System Authorization Facility (SAF) calls.

Like any security interface, MainView windows-mode security does not actually protect resources itself. Instead, the interface identifies MainView resources to your ESM and asks if a user is authorized to access those resources.

You can secure a product at a high level (such as general access to the product) and at much lower levels (for example, whether a user can use a specific command, or access a specific view). MainView supports security products such as IBM Resource Access Control Facility (RACF), Computer Associates CA Top Secret and CA ACF2, and various "in house" security programs.

For more information about securing your resources, see the MainView Security Guide and the MainView Security Reference Manual. You can also use the SERDEF views to list the available resources.

**MainView views and displays**

MainView products refer to the display of data as views (or as displays in full-screen mode). A view presents data that is acquired from a MainView product as a result of a command or action.

Each view consists of a query and a form. The query defines the data for the view, and the form defines how to present the data. When you request a view, the view's query executes against the data that the associated MainView product collects. The extracted data is then processed through the form template to configure the data's appearance in the view.

Each MainView product provides a variety of views or displays, but you can also create customized views. You can save customized views in a personal data set (unless disabled by your site administrator), or in a site data set to be shared by everyone.
Types of views

You can display data from MainView products in various types of views. A view can be layout specific, or defined by the data that it represents.

MainView offers the following types of views:

- Tabular view
  Tabular views display data about multiple resources, so that you can see large amounts of data at one time. Data is arranged in rows and columns. Each row provides information about the same item (such as a job, workload, transaction, or resource). Each column lists a single field of data about each item. You can scroll through the columns and fields to view all of the data in the view.

- Detail view
  Detail views display complete information about a particular element selected from another view. Data is arranged in a page-layout format by using fields that display single pieces of information about the element.

- Hybrid view
  Hybrid views contain specific information at the top and tabular information at the bottom. The top portion of the view is static, but you can scroll through the bottom portion.

- Summary view
  Summary views display data that represents multiple resources that are grouped by specific criteria. A summary view appears as a tabular or detail view, but it includes a context field to indicate what the data represents.
  Summarization is helpful for:
  
  — Grouping a system's similar resources and viewing performance data by groups of resources, especially when a single system image (SSI) context is active
  
  — Grouping information about a resource over multiple intervals of historical data and viewing performance trending data
Chart view (available in MainView Explorer only)
Chart views display data in a graphical format. The default chart style uses circular gauges. You can specify other chart styles, including two- or three-dimensional bar charts and pie charts.

Log view (available in MainView Logger only)
Log views display sequential, time-oriented data from the MainView Logger. You cannot use filters to sort log views. However, the log is indexed so that a few records can be retrieved from a vast quantity of records very quickly. While looking at a log view, you can use the LOGPROF command to set the index values. For more information about MainView Logger, see the MainView Administration Guide.

Related Information
“Working with charts” on page 146

Context of a view

A view’s context identifies a MainView product that is running on one or more target systems. After you set the context, any view that is opened displays data corresponding to that context.

A context can include a single target system or a single system image (SSI) that includes multiple target systems. General types of SSI contexts are as follows:

- **Defined SSI contexts** are either predefined by MainView Infrastructure or defined by your site to represent one or more targets for a given product. All MainView products provide the following defined SSI contexts:
  - **ALL** provides data from all targets on all systems in a multi-system environment.
  - **CURRSYS** provides data from all targets running on the local system.

- **Dynamic SSI contexts** are created by MainView Infrastructure or specific MainView products dynamically to represent natural groupings of targets (such as a sysplex). All MainView products provide the following dynamic SSI contexts:
  - **SYSPLEX** represents all targets for a given product in the sysplex.
  - **SYSTEM** represents all targets for a given product on a specific system. In this case, the system is identified by the CAS name that was assigned in the CASDEF view. Generally, the CAS name is the same as the z/OS system name;
however, if multiple CASs are running on a system, the CAS and z/OS names might differ.

— **SYSNAME** represents all targets for a given product on a specific system. In this case, the system is identified by the z/OS system name.

In addition to the provided contexts, your system administrator can create additional contexts.

**Related Information**

- “Context tree” on page 58
- “Setting a context in MainView Explorer” on page 85
- “The window information line” on page 74
- “Displaying data from multiple systems” on page 180

**Working with views**

In MainView Explorer and windows mode, data is displayed in views. You can refresh and lock views, filter views, and customize views. You can create customized views for your own screen data set, or for a site data set to be shared by everyone.

You can work with views in the following ways:

- **Refreshing and locking views**
  You can refresh the data in a view manually or automatically. Setting a view to automatically refresh itself is a convenient way to continually monitor information. Locking a view lets you study the data in the view at a particular point in time.

- **Filtering views**
  Filtering a view lets you see only the data that you want to see. You can filter the view’s query, the view's form, or both.

- **Customizing views**
  You can reorder the columns in a view, add or delete columns, add hyperlinks, change headings, change colors, set thresholds, and so on. You can save customized views for future use.
Related Information

- “Working with views in MainView Explorer” on page 103
- “Controlling data views in MainView Explorer” on page 127
- “Customizing data display in MainView Explorer” on page 187
- “Working with views in windows mode” on page 114
- “Controlling data views in windows mode” on page 173
- “Customizing data display in windows mode” on page 214
- “Working with historical data” on page 247

Overview of online Help

MainView offers online Help for quick reference about its features and functions. The following topics provide details about how to use online Help in each interface.

- “Online Help for MainView Explorer” on page 32
- “Online Help for ISPF (windows mode)” on page 33
- “Online Help for full-screen mode” on page 33

Online Help for MainView Explorer

MainView Explorer provides comprehensive online Help to explain basic concepts, icons and buttons, dialogs, views, and fields within views.

You can display Help as follows:

<table>
<thead>
<tr>
<th>For Help about</th>
<th>Complete this action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MainView Explorer in general</td>
<td>Either select Help =&gt; Help topics on the menu bar, or click the Help button on the console toolbar.</td>
</tr>
</tbody>
</table>
For Help about | Complete this action
--- | ---
Views | Click the Help button on the view toolbar.
Nodes in the navigation frame, or fields in a view | Right-click the node or field and select Help.
Dialogs | Click Help at the bottom of the dialog.

### Online Help for ISPF (windows mode)

Online Help in windows mode is context sensitive based on the position of the cursor.

You can get Help information about:

- Views that are associated with the active product
- View fields
- Window information line elements
- Commands
  For a list of MainView commands, see the *MainView Reference Summary.*
- The windows-mode interface

You can access the online Help by placing the cursor on an area of interest and pressing the **Help (PF1)** key. For online Help regarding MainView commands or views, enter **HELP** and the name of the command or view on the **COMMAND** line (such as **HELP TRANSfser** or **HELP PLEXOVER**). The Help is displayed in pop-up windows that overlay part of your screen.

**Note**
You can customize the online Help to meet your site’s needs. For example, you can create online Help for views, view elements, or any topic, and you can create hyperlinks within your own Help text. For more information, see the *MainView Administration Guide.*

### Online Help for full-screen mode

When operating in full-screen mode, you can display online Help information with any of these methods:
Using the Help (PF1) key

Use the following procedure to access online Help in full-screen mode. You can get online Help about the current full-screen application at any time.

1. From any screen, press the Help (PF1) key.

   An ISPF panel with information about the current application or service is displayed.

   **Tip**

   With some product services, you can move the cursor to any field and press Help (PF1) to get specific information about that field.

   Also, pressing Help (PF1) when an error message is displayed usually generates a detailed description of that error.

2. When finished, press the END (PF3) key to return to the original application or service.

Using the H line command

For the Current Traces, Active Timer Requests, and Analyzer Display Services applications, you can use the H line command to access application-specific online Help.

1. On the COMMAND line, type H.

   Help information is displayed about the service for the selected request.

Accessing the online Help tutorial

Use the following procedure to access the online tutorial.

1. From the Primary Option Menu, enter T on the COMMAND line to access the Tutorial Primary Menu.
2 From the menu, select the option that corresponds to the type of information you prefer:

- **Full-screen tutorials** provides information about all installed products and services that operate in full-screen mode. Menu options, applications, and commands are described in an extensive set of menus and panels.

- **News** tells you what is new in the current product release.

- **Tutorial exercises** offers step-by-step exercises to help new users learn about the product.

---

**Related Information**

- “Program function (PF) key definitions” on page 270
Overview of the MainView interfaces

You can display system performance data from the MainView products in a variety of user interfaces.

The following interfaces are available:

- **MainView Explorer**
  MainView Explorer is a client/server application that provides access to MainView products from your desktop via a web browser. (See MainView Explorer on page 37")

- **Windows mode**
  The MainView windows environment is an extension of the standard TSO/ISPF interface. When operating in windows mode, you can display one or more windows on your screen. (See Windows mode on page 67")

- **Full-screen mode**
  The MainView full-screen environment is a standard TSO/ISPF interface. Products that operate in full-screen mode offer data displays and application displays or menus. (See Full-screen mode on page 76")

**MainView Explorer**

MainView Explorer is a client/server application that provides access to MainView products from a web browser on your desktop.

Using MainView Explorer, you can:

- Display data in various chart types, including topology diagrams, histograms, and three-dimensional bar charts
- Use tree navigation and EZExplorer nodes to access data
Create and save personal configurations

Execute MainView product action commands

Customize data display

Display context-sensitive Help

MainView Explorer uses active icons that change their appearance to indicate the status of an object. Newly added or active mainframes, systems, subsystems, and workloads are displayed in the navigation tree automatically.

MainView Explorer consists of the following components:

■ Client
  The client runs as a signed Java applet under a web browser. When you click a MainView Explorer icon or hyperlink, the Java applet sends a request for information to the host server.

■ Host server
  The host server runs as an address space on an IBM z/OS system. The host server uses TCP/IP to communicate with one or more clients. The z/OS system must be running a CAS. Multiple host servers can run in a system and communicate with the same CAS or different CASs.
  When a client requests information, the host server sends the request to the connected CAS. After collecting the information from the appropriate PAS, the CAS sends the information back to the host server; the host forwards the information to the client, which displays it in the web browser.

Related Information

■ “Working with views in MainView Explorer” on page 103
■ “Controlling data views in MainView Explorer” on page 127
■ “Customizing data display in MainView Explorer” on page 187

The console

The MainView Explorer console consists of several frames. Each frame provides specific functions related to viewing or locating data.
Figure 2 on page 39 shows a sample console.

**Figure 2: MainView Explorer console**

![MainView Explorer console diagram]

**Legend**

1. Menu bar
2. Navigation frame
3. Messages frame
4. View frame

You can size, move, or close the navigation frame and the messages frame. The way that the console looks when you close it (for example, the console’s size) is used the next time you open the console.

**Tip**

You can restore the console's default layout by selecting **View => Restore default layout**.

For information about the menus on the menu bar, see the online Help.
Menu bar

The menu bar of the MainView Explorer console provides menu commands to control the appearance of the console.

File

The File menu controls configuration files and imported data files. The following commands are available from the File menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open configuration</td>
<td>Controls the creation and use of personal configurations</td>
</tr>
<tr>
<td>Save Configuration</td>
<td></td>
</tr>
<tr>
<td>Delete configuration</td>
<td></td>
</tr>
<tr>
<td>Set current configuration as default</td>
<td></td>
</tr>
<tr>
<td>Specify no default configuration</td>
<td></td>
</tr>
<tr>
<td>Close all views</td>
<td>Closes all open views</td>
</tr>
<tr>
<td>Export configuration</td>
<td>Export a configuration for use in the MVE Viewer</td>
</tr>
<tr>
<td>Export configuration (marked views only)</td>
<td></td>
</tr>
<tr>
<td>Import screen (3270)</td>
<td>Imports a 3270 screen definition that was created in windows mode with the SAVESCR command and treats it like a MainView Explorer configuration file</td>
</tr>
<tr>
<td>Import view or chart from file</td>
<td>Import a view or chart that was previously exported to a file</td>
</tr>
<tr>
<td>Import topology XML from file</td>
<td>Import a topology that was previously exported as XML to a file</td>
</tr>
<tr>
<td>Import custom sound from file</td>
<td>Import a sound file for use with threshold alarms</td>
</tr>
<tr>
<td>Import background image from file</td>
<td>Import an image file for use as a background image on charts</td>
</tr>
<tr>
<td>Create View Container</td>
<td>Create a new tab for a view container</td>
</tr>
<tr>
<td>Exit MainView Explorer</td>
<td>Terminates the MainView Explorer session and closes any detached views</td>
</tr>
</tbody>
</table>

View

The View menu controls whether certain elements of the console are displayed. If an option is selected, that element is displayed on the console. By default, all of the elements are displayed. The following options are available from the View menu:
### Options

The **Options** menu is used to set user preferences for the console. The following commands are available from the **Options** menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tabs at bottom            | Moves the view tabs that identify each view to the bottom of the view frame  
                             | By default, view tabs are displayed at the top of the frame                                                                                  |
| Do not prompt on exit     | Indicates whether to prompt you when exiting MainView Explorer                                                                                  |
| Background image          | Controls the use of a background image on charts  
                             | - None - does not display a background image  
                             | - Default - displays the default BMC background image on the Plex displays  
                             | - Custom - displays an image you have imported  
                             | - Apply to all charts - displays the background image on all charts, not just the Plex displays  
                             | - Image strength - adjusts the opacity of the background image                                                                               |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trees</td>
<td>Controls the display of the navigation frame, which contains the Context and Product trees</td>
</tr>
<tr>
<td>Messages</td>
<td>Controls the display of the messages frame</td>
</tr>
<tr>
<td>Restore default layout</td>
<td>Restores the default console layout</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Look and feel</td>
<td>Changes the look and feel of the console to one of the following</td>
</tr>
<tr>
<td></td>
<td>- Default - the BMC standard look and feel</td>
</tr>
<tr>
<td></td>
<td>- Windows - the look and feel of a Windows application</td>
</tr>
<tr>
<td></td>
<td>- Motif - the look and feel of a Sun Solaris application</td>
</tr>
<tr>
<td></td>
<td>- Java - the look and feel of a Java application</td>
</tr>
<tr>
<td></td>
<td>Changes the text size (small, medium, or large) used for views</td>
</tr>
</tbody>
</table>

**Help**

The **Help** menu provides access to online Help for MainView Explorer. The following commands are available from the **Help** menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help topics</td>
<td>Opens the MainView Explorer online Help system</td>
</tr>
<tr>
<td>About BMC MainView Explorer</td>
<td>Displays version and copyright information about MainView Explorer</td>
</tr>
</tbody>
</table>

**Related Information**

- “Setting personal configurations” on page 143
- “Importing a screen” on page 145
- “Importing a view or chart” on page 138
- “Specifying thresholds” on page 194
- “Changing the background of a chart” on page 157

**Toolbar buttons**

Toolbar buttons are displayed across the top of the console. You can place the mouse pointer over any button in the toolbar to display a brief description of that button.
Table 1 on page 43 explains the purpose of each toolbar button.

Table 1: Toolbar buttons for the MainView Explorer console

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![open]</td>
<td>Open configuration</td>
<td>Lets you select a library from which to open a configuration</td>
</tr>
<tr>
<td>![save]</td>
<td>Save configuration</td>
<td>Lets you select a library to which to save the current configuration</td>
</tr>
<tr>
<td>![import]</td>
<td>Import data from file</td>
<td>Lets you select a local directory from which a previously exported view can be imported into MainView Explorer</td>
</tr>
<tr>
<td>![xml]</td>
<td>Export</td>
<td>Writes all nodes to an xml file. This displays a file chooser dialog</td>
</tr>
<tr>
<td>![xml]</td>
<td>Import</td>
<td>Imports an xml file of nodes and displays a topology chart</td>
</tr>
<tr>
<td>![create]</td>
<td>Create View container</td>
<td>Creates a new view container</td>
</tr>
<tr>
<td>![terminate]</td>
<td>Terminate current request</td>
<td>Terminates an outstanding request. This button remains lit (enabled) while the request busy indicator is spinning. Click this button to terminate the request.</td>
</tr>
<tr>
<td>![forward]</td>
<td>Bring forward any detached views</td>
<td>Brings any detached views to the front of the display</td>
</tr>
<tr>
<td>![help]</td>
<td>Help topics</td>
<td>Opens the MainView Explorer online Help system</td>
</tr>
<tr>
<td>![exit]</td>
<td>Exit MainView Explorer</td>
<td>Terminates the MainView Explorer session and closes any detached views</td>
</tr>
<tr>
<td>![request]</td>
<td>Request busy indicator</td>
<td>Spins to indicate that a request is outstanding. You can use the Terminate current request button to terminate the request.</td>
</tr>
</tbody>
</table>
Related Information

- “Opening a configuration” on page 143
- “Saving a configuration” on page 144
- “Importing a view or chart” on page 138

Status line

The status line at the bottom of the console displays information about computer memory and system requests, and specific column and field information.

Figure 4: Sample status line

| Request(s) pending: 3 |

The status line displays:

- The status of system requests
- Identifying information for a particular column or field

Tip

You can display this information by moving your cursor over a column or field in a view.

A gauge indicating how much of your computer’s memory the Java Runtime Environment (JRE) has allocated to MainView Explorer

Tip

If you hover your cursor over the gauge, the tooltip displays the amount of memory being used.

Working with frames

You can resize or hide the navigation and messages frames relative to the view frame. You can also vertically resize or hide the upper and lower portions of the navigation frame.

To resize a frame

1. Position the mouse pointer on the right or middle border of the navigation frame, or the top border of the messages frame.
The pointer becomes a double arrow.

2 Hold down the left mouse button and drag the border in the direction you want.

**To hide or show a frame**

1 Perform one of the following actions:

- To hide a frame, click the small arrowhead on the right or middle border of the navigation frame, or the top border of the messages frame.
- To show a hidden frame, select **View => Trees** or **View => Messages**.

**The view frame**

The view frame displays open views as tabbed pages.

*Figure 5: View frame*

**Legend**

1 View tab

2 Toolbar buttons
3 Header buttons

4 Command line (not displayed on charts or the Plex Map view)

5 Status line

View tabs

The view tabs provide an easy way to display any view in the view frame. Each tab contains the name of the view and an icon that indicates the type of view.

Clicking on a tab brings the view to the forefront of the frame. By default, the tabs are displayed at the top of the frame, as shown in the following figure. You can move the view tabs to the bottom of the frame by selecting Options => Tabs at bottom.

![View tabs example]

Generally, the tab for a newly opened view is positioned to the right of the rightmost tab in the view frame. However, alternate forms of a view (such as tabular, detail, and chart views) are grouped together.

View tabs use the following icons to indicate the view type:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Type of view</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Tabular view icon]</td>
<td>Tabular view</td>
</tr>
<tr>
<td>![Alternate form icon]</td>
<td>Alternate form of a view, such as a detail view</td>
</tr>
<tr>
<td>![Chart icon]</td>
<td>Chart for a view</td>
</tr>
<tr>
<td>![Plex Map icon]</td>
<td>Plex Map</td>
</tr>
<tr>
<td>![Plex Topology icon]</td>
<td>Plex Topology</td>
</tr>
<tr>
<td>![3270 emulator icon]</td>
<td>3270 emulator</td>
</tr>
<tr>
<td>![Alerts icon]</td>
<td>Alerts view</td>
</tr>
</tbody>
</table>

Placing the mouse pointer over a view tab displays information about that view. The resulting tooltip contains the name of the view, the MainView product to which it belongs, and the context.

Note

The status line at the bottom of the view frame provides information for the current view. However, you can display a tooltip for any view tab by placing your mouse over that tab.
**Toolbar buttons for views**

In the view frame, each tabbed page contains a row of buttons that perform functions on the currently displayed view.

**Figure 6: Sample toolbar buttons for views**

The toolbar buttons that are displayed for a particular view depend on the type of view. For example, the **Chart** button is not displayed on chart views or any view that does not support charts (such as the Plex Map or Alerts view). On the other hand, chart views support additional toolbar buttons that other view types do not.

You can place the mouse pointer over any button in the toolbar to display a brief description of that button. Table 2 on page 47 further explains the purpose of each toolbar button.

**Table 2: Toolbar buttons for MainView Explorer views**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Refresh" /></td>
<td>Refresh</td>
<td>Refreshes the data that is displayed in the current view by retrieving new data from the host. Refreshing a view or any alternate form of the view (such as a chart or detail view) automatically refreshes all forms of the view. If you select the <strong>Publish view data</strong> button, an updated picture of the view and any associated chart is written to the specified file.</td>
</tr>
<tr>
<td><img src="icon" alt="Synchronize" /></td>
<td>Synchronize</td>
<td>Locates and highlights the current view in the Product tree. If you opened the view by selecting a configuration before setting the context, the context is set and the view is located in the Product tree.</td>
</tr>
<tr>
<td><img src="icon" alt="Properties" /></td>
<td>Properties</td>
<td>Opens the Properties dialog for the current view. From the Properties dialog, you can change characteristics such as the font, color, refresh rate, chart type, filters, time frames, and items that are displayed in the view.</td>
</tr>
<tr>
<td>Icon</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="icon" alt="Print icon" /></td>
<td>Print</td>
<td>Opens the Print dialog to send the current view or chart to a printer. The image expands to fit a printed page in portrait or landscape mode.</td>
</tr>
<tr>
<td><img src="icon" alt="Detach icon" /></td>
<td>Detach this view</td>
<td>Detaches the current view from the view frame and creates a separate window. You can move and size the detached window independently of the MainView Explorer window. A detached window closes when you exit MainView Explorer. In a detached window, the Attach button reattaches the window as a tabbed page in the view frame. <strong>Note:</strong> You cannot detach the Plex Map view.</td>
</tr>
<tr>
<td><img src="icon" alt="Help icon" /></td>
<td>Help</td>
<td>Displays online Help for the current view.</td>
</tr>
<tr>
<td><img src="icon" alt="Copy icon" /></td>
<td>Copy data to clipboard</td>
<td>Copies the data from the view to the clipboard in tab-separated format. From the clipboard, you can paste the data into a word processor or spreadsheet application.</td>
</tr>
<tr>
<td><img src="icon" alt="Previous icon" /></td>
<td>Previous time interval</td>
<td>Displays data from the previous recorded time interval.</td>
</tr>
<tr>
<td><img src="icon" alt="Reset icon" /></td>
<td>Reset time to current</td>
<td>Display data for the current interval.</td>
</tr>
<tr>
<td><img src="icon" alt="Next icon" /></td>
<td>Next time interval</td>
<td>Displays data from the next recorded time interval.</td>
</tr>
<tr>
<td><img src="icon" alt="Save icon" /></td>
<td>Save customized view</td>
<td>Saves the customized view definition without closing the view.</td>
</tr>
<tr>
<td><img src="icon" alt="Chart icon" /></td>
<td>Chart</td>
<td>Displays a chart of the current view data.</td>
</tr>
<tr>
<td><img src="icon" alt="Map icon" /></td>
<td>Create topology map</td>
<td>Displays a topology chart of the current view data.</td>
</tr>
<tr>
<td>Icon</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Auto-refresh</td>
<td>Starts or stops an automatic data refresh cycle for the view. When you select <strong>Auto-refresh</strong>, the button color changes from red to green and the tooltip displays the refresh rate. If an auto-refresh rate was not previously set, a default rate of 15 seconds is used. To stop the automatic data refresh cycle, click <strong>Auto-refresh</strong> again. <strong>Note:</strong> You cannot refresh the Plex Map view automatically.</td>
</tr>
</tbody>
</table>
| ![Icon](image) | Export view data | Creates three files in the export directory:  
- A data file named with view name, underscore, context name and the numeric extension .1  
- A data file similarly named with the extension .csv  
- A view definition file similarly named with the extension .vdf  
You may change the name to be used for these files in the export dialog. All the fields in the view (even excluded fields) are exported to the two data files. After the view data is exported, the .csv file can be opened in a spreadsheet application and the .1 file can be imported into MainView Explorer or the MVE Viewer. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Publish view images</td>
<td>Opens the Choose a directory dialog, which lets you select the local directory to which you want to publish the view data. When you select <strong>Publish view data</strong>, a JPEG of the view and its chart (if one is open) are written to a file along with an HTML file. You can display the view and its chart in a web browser by double-clicking the HTML file.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show excluded fields</td>
<td>Displays fields (or columns) that are defined in the view definition as being excluded. Some view fields might be defined in the host view definition as excluded fields. By default, data for these fields is retrieved from the host but is not displayed in the view. The column header for excluded fields appears in a lighter shade.</td>
</tr>
</tbody>
</table>
| ![Icon](image) | Enable selections | Enables the selection of multiple rows of data by using the Ctrl or Shift key and the left mouse button. After you select rows of data, you can:  
  - Export them to a file  
  - Copy them to the clipboard  
  - Print them  
  - Perform a host action against them  
  - Produce a chart of their data  
To disable the selection of multiple rows, click **Enable selections** again. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| ❌   | Close    | Closes the current view and removes it from the view frame. When you close a primary view, any alternate forms of the view (such as a chart or detail view) are also closed.  
**Note:** You cannot close the Plex Map view. |

---

**Related Information**

- “Toolbar buttons for charts” on page 151
- “Saving customized views (MainView Explorer)” on page 211
- “Working with charts” on page 146
- “Copying view data to the clipboard” on page 138
- “Exporting view data on demand” on page 132
- “Publishing view images” on page 139
- “Refreshing view data (MainView Explorer)” on page 128
- “Showing excluded fields in a view” on page 107
- “Selecting multiple rows of data” on page 131

---

**Header buttons**

In tabular views, header buttons display the column heading. They can also include the current column settings, such as which columns are being used for grouping, sorting, summarization, charting, and positional parameters.

The column that is used for the primary sort order is marked with a solid arrow, indicating the direction of the sort. The secondary sort column (if any) is marked with a hollow arrow indicator.
Context-sensitive menus

Each view includes context-sensitive menus that offer general and specific options for the view.

Context-sensitive menus provide:

- Options that apply to the entire view
- Options that are specific to a column
- Options that are specific to a row or a field within the row

You can display options for your current view by right-clicking a view tab or the blank part of the view toolbar. Right-clicking a column header button displays options for that column, and right-clicking in a data row displays options for that row or field.

For example, right-clicking a view tab displays the following pop-up menu of options for the current view:
In addition to closing the view, you have the following options:

- **Toolbar help** displays information about the view toolbar.

- **Mark for configuration** selects this view to be included in a configuration that will be saved or exported.

- **Hide toolbar** toggles to hide and reshown the toolbar at the top of the frame on this view.

- **Refresh data** manually refreshes the data on this view.
- **Properties** opens the Properties dialog box for the view.

- **Print** lets you send the current view or chart to a printer. The image expands to fit a printed page in portrait or landscape mode.

- **Detach this pane** detaches the view from the view frame and creates a separate window.

- **Help for this view** displays product help for the current view.

- **Copy data to clipboard** copies the view’s data to the clipboard in tab-separated format.

- **Open chart** opens the chart form for this view in a new tab.

- **Create topology map** opens a topology map for the view.

- **Summary view** indicates a summary form is available for this view. Clicking on the FORM command opens the summary view in a new tab.

- **Show header info** displays information in the header buttons regarding which columns are being used for grouping, sorting, summarization, charting, and positional parameters as well as the current form filters in use. You can also show the field IDs for each field, which are used in threshold and hyperlinks.

- **Show excluded fields** displays fields (or columns) that are defined in the view definition as being excluded.

- **Auto-Refresh** toggles starts or stops auto-refresh mode for this view. If an auto-refresh rate has not been set, then the default rate of 30 seconds is used. When this toggle is depressed (auto-refresh running), the color changes to green and the tool-tip and view status line display the refresh rate.

- **Export view data** exports the view's data to a file in comma-separated values (CSV) format. You can then open the file in a spreadsheet application, or import the file back into MainView Explorer.

- **Publish view images** publishes the view image for access in a browser. You can place JPEG files of the view and its chart (if one is open) in a local directory along with an HTML file, which enables you to publish the view to other users in a stand-alone web browser.
- **Show excluded fields** displays fields (columns) that are defined in the view definition as being excluded.

- **Show filter masks** displays filter masks below each column header to facilitate data filtering.

- **Enable selections** lets you select multiple rows of data by using the Ctrl or Shift key and the left mouse button.

- **Save customized view** saves any changes that you made to the view definition, without closing the view.

When you right-click a field, in addition to displaying online Help for the field, you might have the following options:

- **Copy** copies the row data cell for this field (column) to the clipboard.

- **Summary view** displays a summary form of this view as shown in the following example:
Clicking on FORM command opens the summary view in a new tab and uses the selected field as the GROUPBY element.

- **Hyperlink** displays the hyperlink command if a hyperlink is defined for the field. To execute the hyperlink, click on the command. If no hyperlink is defined, this option does not appear on the menu.

- **Line action** displays a list of actions that you can perform (if line actions are available). To perform an action, click the action name. If no line actions are available, this option does not appear on the menu.

**Related Information**

- “Copying view data to the clipboard” on page 138
- “Exporting view data on demand” on page 132
- “Publishing view images” on page 139
- “Saving customized views (MainView Explorer)” on page 211

**Command line**

Near the bottom of most views, the **Command** line offers a convenience for users who are familiar with the 3270 interface. You can enter commands directly on this line instead of using the Properties dialog box or pop-up menus.

An example follows:

![Command line example](image)

**Related Information**

- “Executing MainView commands” on page 111
Information line

An information line is displayed near the bottom of most views.

An example follows:

The information line provides the following information:

- Export icon if the view is exporting data
- Name of the current view
- MainView product to which the view belongs
- @context for the view
- Date and time the data was collected from the host
- Refresh rate [:30] (when automatic refresh is active)
- The number of rows of data and the current row position are displayed in the right-hand section of the view information line.

The navigation frame

The navigation frame appears on the left side of the MainView Explorer console. The upper portion of the navigation frame contains the Context tree, and the lower portion contains the Product tree.

An example follows:
Icons or nodes on the trees represent subsystems, system images, MainView products, and views. The final node on any branch of the Context tree represents a target context. The final node on any branch of the Product tree represents a view.

You can display a brief description of a node by right-clicking the node and selecting Help. Expand or collapse a branch in the tree by clicking the + and - icons, or by double-clicking the node.

You can close the navigation frame by clicking the Close button in the upper right corner, or by selecting View => Contexts to clear the Contexts option. You can redisplay the frame by selecting View => Contexts again.

**Context tree**

The Context tree is split into three tabs, with each tab showing a tree of available contexts organized in a different manner.
The following table on page 59 describes the tabs and which nodes they display:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Shows major nodes for</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Contexts by area]</td>
<td>Each subsystem that is being monitored by one or more MainView products</td>
</tr>
<tr>
<td></td>
<td>For example, an MVS node is present if MainView for z/OS is installed on the host. Other area nodes include CICS, DB2, IMS, NETWORK, STORAGE, UNIX, WEB, and PLEX. Each area node contains system nodes for each system image that is being monitored by a MainView product. Each system node contains the target context nodes, which represent specific MainView products running on one or more target systems.</td>
</tr>
<tr>
<td>![Context by system]</td>
<td>Each system image (represented by a CAS) within the sysplex</td>
</tr>
<tr>
<td></td>
<td>Each system node contains the target context nodes.</td>
</tr>
<tr>
<td>![Context by product]</td>
<td>Each MainView product that is running in the sysplex.</td>
</tr>
<tr>
<td></td>
<td>Each product node contains the target context nodes.</td>
</tr>
<tr>
<td></td>
<td>Under each product, the single system image (SSI) contexts that are available for that product are shown.</td>
</tr>
</tbody>
</table>

You can use any of the Context trees to:

- Set a target context (or an SSI context from the Contexts by product tree)

When you set a context, the label above the Context tree shows the selected context for a single product, and the Product tree is expanded to show the product and its views. The selected context applies to all views that you subsequently open from the Product tree.
Display a dashboard view of gauges that indicate the general health of a target context, as viewed by a particular product. From these gauges, you can hyperlink to other views and attempt to correct any problems with the target system. You can display this dashboard view by double-clicking a target context icon, or by right-clicking the icon and selecting Display gauges.

Related Information

- “Context of a view” on page 30
- “Setting a context in MainView Explorer” on page 85

Product tree

For the MainView product that is associated with the selected context, the Product tree displays standard nodes and the product node.

The Product tree is shown in the following figure:

![Product tree](image)

PLEX node

The PLEX node displays the Plex Map. The Plex Map shows the active MainView products, the systems on which they are active (each represented by a CAS), and the connections between them.

You can display the Plex Map by clicking the PLEX node icon.

Related Information

- “The Plex displays” on page 63
**Alerts node**

The Alerts node displays a view of exception messages indicating that threshold conditions have been met.

Double-click the Alerts icon to display alerts from all systems in the view frame, as shown in the following figure:

A turquoise column heading (such as Alert Text) indicates that hyperlinks are defined for the fields in the column. Double-clicking a field in the column activates the corresponding hyperlink. The target view is displayed in the view frame.

**3270 node**

The 3270 node displays the 3270 emulator window.

Some views contain hyperlinks to ISPF-only views. When you activate a hyperlink, the emulator window is automatically invoked to provide access to those views. You can open the emulator window manually by double-clicking the 3270 icon.

You can display the keyboard map for the 3270 emulator by clicking the Properties button in the emulator window and selecting the Keyboard Map tab of the dialog. The key assignments are not modifiable.

**Product node**

The Product node displays the Product tree.
After you set a context, the Product tree expands to display the MainView product for which that context is valid. You can display the Product tree by double-clicking the Product node icon 📚.

For each product code shown in the Product tree, Table 3 on page 62 shows the corresponding product or component name. The Product tree displays only the products that are available to the user.

Table 3: Product codes in the Product tree

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMF</td>
<td>CMF MONITOR</td>
</tr>
<tr>
<td>MVALARM</td>
<td>MainView Alarm Management</td>
</tr>
<tr>
<td>MVAO</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MVCICS</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td>MVDB2</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>MVEXP</td>
<td>MainView Explorer</td>
</tr>
<tr>
<td>MVIMS</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>MVIP</td>
<td>MainView for IP</td>
</tr>
<tr>
<td>MVLNX</td>
<td>MainView for Linux - Servers</td>
</tr>
<tr>
<td>MVMQS</td>
<td>MainView for WebSphere MQ</td>
</tr>
<tr>
<td>MVMVS</td>
<td>MainView for z/OS</td>
</tr>
<tr>
<td>MVSRM</td>
<td>MainView Storage Resource Manager (SRM)</td>
</tr>
<tr>
<td>MVSPS</td>
<td>MainView SYSPROG Services</td>
</tr>
<tr>
<td>MVTAT</td>
<td>MainView Transaction Analyzer</td>
</tr>
<tr>
<td>MVTOM</td>
<td>MainView Total Object Manager</td>
</tr>
<tr>
<td>MVUSS</td>
<td>MainView UNIX System Services</td>
</tr>
<tr>
<td>MVVP</td>
<td>MainView VistaPoint</td>
</tr>
<tr>
<td>MVVTAM</td>
<td>MainView for VTAM</td>
</tr>
<tr>
<td>MVWEB</td>
<td>MainView for WebSphere Application Server</td>
</tr>
<tr>
<td>PLEX</td>
<td>Plex Manager</td>
</tr>
</tbody>
</table>

Expanding a product node displays the EZExplorer node and view folder nodes.

You can use the view folders listed beneath the EZExplorer node to list the views by name. For example, the DMON folder contains device views sorted by view name. If you do not know which view displays the information that you want, you can find it by double-clicking the EZExplorer node. The node contains folders of views grouped by functionality. The views are identified by a description (such as Cache Overview),
with the view name in parentheses, rather than view names. For example, the Devices folder lists some key device activity views.

You can open a view by double-clicking its icon, or by right-clicking the icon and selecting **Open view**. You can also right-click and select:

- **Help** to display information about the view
- **Open with parameters** to pass parameters with the view request
- **Open chart** to open a chart for the view without opening the backing view

**Tip**
To locate a view in a product node, EZExplorer node, or folder node without scanning the list, right-click the node’s icon and select **Locate view**.

**Related Information**
- “Controlling data views in MainView Explorer” on page 127
- “Working with charts” on page 146

**The Plex displays**

The Plex displays (Plex Map, Products Plex Topology, and Systems Plex Topology) provide information about the systems that are active in your sysplex and which MainView products are running.
The Plex displays are as follows:

- Plex Map depicts the active MainView products, the systems on which they are active (each represented by a CAS), and the connections between them.

- Products Plex Topology depicts the relationship between the MainView products running in your sysplex and the systems on which they are running.

- Systems Plex Topology depicts the relationship between the systems running in your sysplex and the MainView products running on them.

**Note**
The Plex displays are shown in permanent tabs that you cannot close. You can change the font, color, and background of the Plex displays in the same way that you make these changes for charts.

**Related Information**

- “Plex Map display” on page 64
- “Plex Topology displays” on page 65
- “Changing the font and colors in a chart” on page 155
- “Changing the background of a chart” on page 157

**Plex Map display**

Using the Plex Map, you can see which systems are active and running MainView products.

The default arrangement displays system image boxes at the top and MainView products at the bottom. Each system image box lists the subsystem areas that are being monitored.

The Plex Map (Figure 8 on page 65) uses the following conventions:

- Green lines indicate active connections.

- Red lines indicate once-active connections that have terminated.
Yellow lines indicate connections that are late in responding; they will subsequently turn either red or green.

Figure 8: Plex Map example

Plex Topology displays

The Plex Topology displays provide detailed, hierarchical views of the relationships between the products and systems in the sysplex.

The Plex Topology displays are as follows:

- Products Plex Topology depicts the relationship between the MainView products running in your sysplex and the systems on which they are running. Each outer leaf node represents a context (product on a target system).

- Systems Plex Topology depicts the relationship between the systems running in your sysplex and the MainView products running on them. Each outer leaf node represents a context (product on a target system).

Figure 9 on page 66 is an example of the Systems Plex Topology in a radial layout.
Figure 10 on page 66 is an example of the Systems Plex Topology in a linear layout (displayed by selecting the Linear check box at the bottom of the display).

Figure 9: Systems Plex Topology in a radial layout example

Figure 10: Systems Plex Topology in a linear layout example
The messages frame

The messages frame displays a log of product messages, including requests to the host server.

The messages frame appears across the bottom of the MainView Explorer console, as shown here:

You can close the messages frame by selecting View => Messages and clearing the Messages option. You can redisplay the frame by selecting View => Messages again.

Windows mode

The MainView windows environment is an extension of the standard TSO/ISPF interface. When operating in windows mode, you can display one or more windows on your screen. A window information line defines the top border of each window.

Figure 11 on page 67 shows an example of a windows-mode display.

Using windows mode, you can:

- See system performance data displayed in as many as 20 windows
- Display multiple systems as a single system image (SSI)
- Summarize data for many resources into a single row
- Display historical data that was collected over time
Navigate through data using hyperlinks and menus

- Customize the display of data and online Help
- Export data to a data set or print it to SYSOUT

Related Information

- “Working with views in windows mode” on page 114
- “Controlling data views in windows mode” on page 173
- “Customizing data display in windows mode” on page 214
- “Working with historical data” on page 247

Overview of MainView windows

In windows mode, data is displayed in views. When you request a view, it is shown on your screen in a MainView window.

A window includes:

- A control area where you can enter commands and see the active window status
- A window information line that shows window and view status information
- A display area for product views

Figure 12 on page 68 shows a view in a MainView window.

Figure 12: Sample MainView window

<table>
<thead>
<tr>
<th>ddmmmyyyy</th>
<th>hh:mm:ss</th>
<th>MAINVIEW WINDOW INTERFACE (Vv.r.mm)</th>
<th>COMMAND</th>
<th>SCROLL</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURR WIN</td>
<td>1</td>
<td>ALT WIN</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>&gt;W1 =PLEXOVER==SYSB==*==ddmmmyyyy==hh:mm:ss==PLEXMGR==D==1</td>
<td>COMMAND</td>
<td>SCROLL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C Context</td>
<td>Product</td>
<td>Description</td>
<td>Status</td>
<td>Server</td>
</tr>
<tr>
<td>SYSB</td>
<td>PLEXMGR</td>
<td>Target Manager</td>
<td>Active</td>
<td>PLEXMGR</td>
</tr>
</tbody>
</table>
The control area

You can use the control area to enter commands, scroll view data, and activate and manage multiple windows.

The control area contains the following fields:

- **COMMAND**
- **SCROLL**
- **CURR WIN** (current window)
- **ALT WIN** (alternate window)

By default, a single window is opened when you initially enter a product. To see data from multiple views simultaneously, you can split the display area into multiple windows as described in "Creating a window". The **CURR WIN** and **ALT WIN** fields identify and indicate which window is active when you have multiple windows open.

For any of these elements, you can receive online Help by selecting the element with your cursor and pressing the Help (PF1) key.

---

**Primary commands**

MainView products that run in windows mode provide primary commands.
You can use the **COMMAND** line to enter the following types of primary commands:

- Names of views that you want to see
- Alternate form commands
- Data access commands
- Data control commands
- Informational commands
- Session commands
- Window management commands

For descriptions of these commands, see the *MainView Reference Summary*, or type **HELP COMMANDS** on the **COMMAND** line.

**Line commands**

You can perform actions specific to a view using line commands while running in windows mode.

Line commands, also known as actions, are unique characters that perform actions that are specific to a view. In tabular views, the first column of each row is the line command field (not all tabular views contain a line command field).

Type a line command next to a resource's record and press the **ENTER** key. If the line command is not successful, a return code is displayed in the line command field to indicate the results of the action.

To see a list of the valid line commands for a view, do one of the following:

- Place the cursor in the line command field and press the **Help (PF1)** key.
- Type **HELP ACTIONS** in the **COMMAND** field and press the **ENTER** key.

To see a list of return codes, place your cursor on the highlighted words *return code* in the Help and press the **ENTER** key.
The width of the line command field on a given view determines how much of the return code is displayed. For example, WARN might appear as W, WA or WAR.

In some MainView product views, OK is displayed in the line command field when a line command is successful.

**Types of view parameters**

View parameters filter information so that you see only the data that is important to you, such as data with a specific status.

You can filter information with the following methods:

- PARm and QPARm commands
- Positional parameters
- Keyword parameters

**PARm and QPARm commands**

The PARm command filters existing data only. The QPARm command reissues a query with the specified filters and displays new data.

*Note*

Because PARm does not update existing data (and, therefore, does not require a query), PARm saves system resources.

You can enter PARm on the COMMAND line of a current view with positional parameters or with the internal name for the element that you want to filter, as follows:

\[ \text{PAR} \{ \text{value1} \mid \text{keyword} (\text{value}) \} \]

where

- \text{value1} is a filter condition applied as a positional parameter. You can use this condition only for positional parameters that are valid for the view you want to filter. You can view a list of these parameters by placing your cursor on the view name and pressing the Help (PF1) key.

- \text{keyword} is a filter condition applied as a keyword parameter. The keyword parameter is the internal name for an element. The filter condition is used with the element name and must be enclosed in parentheses as \text{elementName(value)}. To
see the valid keywords for a view, you can use the SHOWFilt command. SHOWFilt shows all filters that are currently in effect.

**Example**
The default positional and keyword parameters for the PLEX view are PRODUCT and CONTEXT. PRODUCT is the first positional parameter and CONTEXT is the second. If you wanted to see the status for a specific context, you could enter the following command while in the PLEX view:

```plaintext
PARM * SSIC*
```

For more information about the PARm command, type **HELP PARm** on the **COMMAND** line.

**Positional parameters**
Positional parameters are location specific and determined by their position in relation to other parameters. You enter positional parameters on the **COMMAND** line in a specific order with a view name.

You can enter positional parameters as follows: `viewName parm1 parm2 parm3`.

To determine which positional parameters you can use in a view, use either of the following actions to access online Help:

- Enter **HELP** with the view name, and select the positional parameters topic.
- Select the view name from the window information line with your cursor, press the **Help (PF1)** key, and select the positional parameters topic.

You must enter the parameters in the sequence shown in the online Help. You must use an asterisk (*) as a placeholder for each parameter that you are not using.

**Example**
If you want to filter status information to INACTIVE only and it is the third parameter for a view, enter the following string on the **COMMAND** line:

```plaintext
viewName * * INACTIVE
```

**Keyword parameters**
Keyword parameters are internal element names that you can enter with a view name on the **COMMAND** line.

You can use the following syntax when entering keyword parameters: `viewName elementName (value)`.

The variable `elementName` is the internal name for an element and the variable `value` is the filter condition.
Tip
To see the valid keywords for a view, you can use the SHOWFilt command. This command shows you all filters currently in effect

You can also filter view data by using the commands and customization options described in "Filtering data in a view in windows mode".

Related Information
■ “Filtering data in a view in windows mode” on page 232

Scroll function

If additional rows or columns are available within a window, you can scroll up and down through the rows, or left and right through the columns.

You can scroll by using:

■ Your PF keys, to scroll a numerical amount specified in the SCROLL field

■ Commands, to scroll a numerical amount indicated by the command, or by an amount specified in the SCROLL field

For scrolling up and down, the scroll amount is the number of rows to be scrolled. For scrolling left and right, it is the number of fields to be scrolled, not the number of characters.

Example
The command RIGHT 3 scrolls the view data three whole fields to the right.

A scroll amount entered with a command takes precedence over any amount specified in the SCROLL field. For help on how to use this field, place your cursor on the SCROLL field in a window and press the Help (PFI) key. You can hyperlink from there for a description of the commands that you can use to scroll view data.

You can see and change the PF key assignments with the KEYS command. For more information about this command, type HELP KEYS on the COMMAND line.
The window information line

The window information line shows the status of active windows and views, and delimits multiple windows.

The line from the following figure is Figure 13 on page 74. The line comprises the elements that are described in Table 4 on page 74.

Figure 13: The window information line

<table>
<thead>
<tr>
<th>more</th>
<th>view</th>
<th>form</th>
<th>context</th>
<th>scope</th>
<th>date</th>
<th>time</th>
<th>nnnnu</th>
<th>prodid</th>
<th>l</th>
<th>n</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4: Window information line elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Indicates you can see more data by scrolling to the right</td>
</tr>
<tr>
<td></td>
<td>The &lt; character indicates more data to the left; a plus sign (+) indicates more data to the left and right.</td>
</tr>
<tr>
<td>W n</td>
<td>c</td>
</tr>
<tr>
<td></td>
<td>W n means this window is in waiting status. Valid values for n are 1 through 20.</td>
</tr>
<tr>
<td></td>
<td>c is a one-letter character that shows the window's status. For example, T indicates that this window is new and is ready to receive commands; no view is active in the window.</td>
</tr>
<tr>
<td></td>
<td>For a list of possible statuses, place your cursor on a status character and press the Help (PF1) key. You can hyperlink from a status character listed in the online Help to see a description of what the character means.</td>
</tr>
<tr>
<td>view</td>
<td>Specifies the name of the view being displayed in the window, such as PLEXOVER</td>
</tr>
<tr>
<td>form</td>
<td>Specifies the name of the form that is being used to display the data in the view</td>
</tr>
<tr>
<td></td>
<td>This name appears when you use the FORM command to display the data in a different format as described in &quot;Forms and queries&quot;.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>context</strong></td>
<td>Specifies the name of the current target (such as SYSB) or a predefined SSI context that includes multiple targets. ALL is a predefined context that provides data from all target systems in a multi-system environment. CURRSYS is a predefined context that provides data from all target systems running on the local system. For a description of the CONTEXT command, enter HELP CONTEXT on the COMMAND line of a window.</td>
</tr>
<tr>
<td><strong>scope</strong></td>
<td>Identifies a target selected with the SCOPE command from an SSI context in an active window. An asterisk (<em>) indicates that the view is showing information for all targets in the context, for example: ALL=====</em>==== This example means all target data for the ALL context is being displayed. The SCOPE command limits the view of the context to the specified target. For example, assume you are viewing the predefined context of ALL, and you enter the following command: COMMAND ===&gt; SCOPE SYSB The window information line shows the following information: ALL=====SYSB==== For a description of the CONTEXT and SCOPE commands, enter HELP and the command name on the COMMAND line of a window.</td>
</tr>
<tr>
<td><strong>date</strong></td>
<td>Indicates the date (in day, month, year format, such as 15APR2001) when view data in the window was last updated, or the end of the represented interval if the data is historical.</td>
</tr>
<tr>
<td><strong>time</strong></td>
<td>Indicates the time (in hours, minutes, seconds format, such as 06:13:59) when view data in the window was last updated, or the end of the represented interval if the data is historical.</td>
</tr>
<tr>
<td><strong>nnnnu</strong></td>
<td>Specifies a length of time (nnn) and a unit of time (u) expressed in intervals (I), minutes (M), hours (H), days (D), or weeks (W). This value appears only when the duration parameter is specified with the TIME command for historical data. For more information about historical data, enter HELP TIME on the COMMAND line of a window.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **mode** | Indicates BROWSE or EDIT mode  
These modes are used for system administration views and replace date and time elements on the information line when either one is in effect.  
*BROWSE* is shown when you are viewing existing system administrative definitions (for example, a list of workloads or sampler definitions).  
*EDIT* is shown when you have an edit lock on the definitions to change them or create new ones. |
| **prodid** | Specifies the name of the MainView product you are using (for example, PLEXMGR). |
| **l** | Identifies the location of the form that is being displayed  
A value of *D* indicates the form is in a distributed library; this means the form is as originally distributed with the product. A value of *U* means the form is in a user library and is a customized version of the form. |
| **n** | Identifies the number of rows of data (or records) displayed in the view, up to a maximum of 99999  
If the number of records being displayed exceeds 99999, the number is rounded down and scaled; thousands are shown as *nnn* K and millions as *n* M. |

Online Help also provides information about these elements. Place the cursor on any element in the window information line and press the **Help (PF1)** key.

---

**Related Information**

- “Creating a window” on page 115
- “Forms and queries” on page 174
- “Working with historical data” on page 247

---

### Full-screen mode

The MainView full-screen environment is a standard TSO/ISPF interface. Products that operate in full-screen mode offer data displays and application displays or menus. These displays follow ISPF conventions for selecting, scrolling, and splitting the screen.
The following Figure 14 on page 77 shows an example of an application in full-screen mode:

**Figure 14: Example of a full-screen mode application**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Log Display</th>
<th>General services</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGT</td>
<td>DB2F</td>
<td></td>
</tr>
<tr>
<td>LINE= 12,340</td>
<td>LOG= #1</td>
<td>STATUS= INPUT</td>
</tr>
<tr>
<td>TIME= 17:51:38</td>
<td>INTV===&gt; 3</td>
<td></td>
</tr>
<tr>
<td>12:11:00</td>
<td>DS0560W (04)</td>
<td>12:11:00 ECSA % UTILIZATION(TOTAL) = 71 (&gt;70) ********</td>
</tr>
<tr>
<td>12:12:00</td>
<td>DS0560W (05)</td>
<td>12:12:00 ECSA % UTILIZATION(TOTAL) = 71 (&gt;70) ********</td>
</tr>
<tr>
<td>12:12:55</td>
<td>XS6311I</td>
<td>BBI/SESSION FOR -CPS17 - TERMINATED</td>
</tr>
<tr>
<td>12:13:00</td>
<td>DS0560W (06)</td>
<td>12:13:00 ECSA % UTILIZATION(TOTAL) = 71 (&gt;70) ********</td>
</tr>
<tr>
<td>12:14:00</td>
<td>DS0560W (07)</td>
<td>12:14:00 ECSA % UTILIZATION(TOTAL) = 71 (&gt;70) ********</td>
</tr>
<tr>
<td>12:15:00</td>
<td>DS0560W (08)</td>
<td>12:15:00 ECSA % UTILIZATION(TOTAL) = 72 (&gt;70) ********</td>
</tr>
<tr>
<td>12:16:00</td>
<td>DS0560W (09)</td>
<td>12:16:00 ECSA % UTILIZATION(TOTAL) = 71 (&gt;70) ********</td>
</tr>
<tr>
<td>12:17:00</td>
<td>DS0560W (10)</td>
<td>12:17:00 ECSA % UTILIZATION(TOTAL) = 71 (&gt;70) ********</td>
</tr>
<tr>
<td>12:22:11</td>
<td>XS6304I</td>
<td>BBI/SESSION FOR -LAA1 - TO -D31X- INITIATED</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0561I</td>
<td>13:12:00 ECSA % UTILIZATION(TOTAL) NO LONGER &gt; 70</td>
</tr>
<tr>
<td>13:28:48</td>
<td>DSNW131I</td>
<td>STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:28:49</td>
<td>DSN9022I - DSNWVCM1 'STOP TRACE' NORMAL COMPLETION</td>
<td></td>
</tr>
<tr>
<td>13:53:02</td>
<td>DS0560W (01)</td>
<td>13:53:00 ECSA % UTILIZATION(TOTAL) = 72 (&gt;70) ********</td>
</tr>
<tr>
<td>13:54:00</td>
<td>DS0560W (02)</td>
<td>13:54:00 ECSA % UTILIZATION(TOTAL) = 74 (&gt;70) ********</td>
</tr>
<tr>
<td>13:55:01</td>
<td>DS0560W (03)</td>
<td>13:55:00 ECSA % UTILIZATION(TOTAL) = 74 (&gt;70) ********</td>
</tr>
<tr>
<td>13:56:00</td>
<td>DS0560W (04)</td>
<td>13:56:00 ECSA % UTILIZATION(TOTAL) = 74 (&gt;70) ********</td>
</tr>
<tr>
<td>13:57:01</td>
<td>DS0560W (05)</td>
<td>13:57:00 ECSA % UTILIZATION(TOTAL) = 74 (&gt;70) ********</td>
</tr>
<tr>
<td>13:58:00</td>
<td>DS0560W (06)</td>
<td>13:58:00 ECSA % UTILIZATION(TOTAL) = 74 (&gt;70) ********</td>
</tr>
</tbody>
</table>

For more information, see Working with full-screen mode displays on page 265.

**Related Information**

- "Transferring between applications in full-screen mode" on page 304
Accessing MainView products

You access a MainView product by starting a terminal session: either a MainView Explorer session or a TSO session.

The following topics will get you started:

■ Starting a MainView Explorer session on page 79
■ Starting a TSO session on page 86

Starting a MainView Explorer session

You can run MainView Explorer sessions either in a web browser or from a directory on your computer.

MainView Explorer looks and acts the same way whether running as a signed Java applet in a browser or as a Java application installed on your computer. However, using a browser offers several advantages:

■ No client installation is required, and sessions start quickly.

■ Because the applet is cached in the Java plug-in cache, the applet does not need to be downloaded again until a new version becomes available on the host server.

■ If a newer version of MainView Explorer is detected on the host server, the applet refreshes automatically.
Starting MainView Explorer in a browser

Use this procedure to start MainView Explorer in a browser, running as a signed Java applet.

**Before you begin**

Ensure that the MainView Explorer host server is running, as described in the *MainView Administration Guide*.

**To start MainView Explorer in a browser**

1. In a web browser, enter the URL `http://host:port`.

For the *host* variable, use the IP address or name of the system on which the MainView Explorer host server is executing. For *port*, use the value that was specified for the PORT parameter in the host server procedure. (The distributed procedure name is BBMXPJCL; however, it might have been renamed during installation at your site.)

**Example**

The following examples show valid URLs:

- `http://bmcysc:3950`
- `http://172.18.9.82:3950`

MainView Explorer launches and prompts you to log on. To start your MainView Explorer session, see Logging on to MainView Explorer on page 83.
**Tip**
After MainView Explorer launches, you should bookmark the URL for easier access in the future.

---

**Where to go from here**

Complete the logon procedure, and set a context for your session. (You must set the context in order to access product views in the Product tree.)

**Related Information**

**Next Task to Perform:**

- “Logging on to MainView Explorer” on page 83

**Supporting Information:**

- “Setting a context in MainView Explorer” on page 85

---

**Starting MainView Explorer as a local application**

Use this procedure to install MainView Explorer as a local application on your computer and run sessions from there.

BMC provides an automated installation wizard that installs MainView Explorer as a Java application in a directory of your choice. The installation wizard also:

- Updates your computer registry for future installations
- Updates your Start menu with an entry for launching MainView Explorer
- Gives you the option to create a shortcut on your desktop

**Before you begin**

Ensure that the MainView Explorer host server is running, as described in the *MainView Administration Guide*.

You must have the Oracle Java Runtime Environment (JRE) installed on your computer. The installation wizard will check for the JRE on your computer and will install it from the MainView Explorer host server if necessary.
To install MainView Explorer on your computer

1. In a web browser, enter `http://host:port/install.ehtm` in the address bar.

   For the `host` variable, use the IP address or name of the system on which the MainView Explorer host server is executing. For `port`, use the value that was specified for the `PORT` parameter in the host server procedure. (The distributed procedure name is BBMXPJCL; however, it might have been renamed during installation at your site.)

   **Example**
   
   The following examples show valid URLs:

   - `http://bmcsc:3950/install.ehtm`
   - `http://172.18.9.82:3950/install.ehtm`

   **Note**
   
   The MainView Explorer installation wizard is a signed Java applet. If your site prohibits running signed Java applets, you can install MainView Explorer manually. For instructions, go to `http://host:port/download.ehtm`.

2. Follow the instructions in the wizard to complete the installation.

To start MainView Explorer as a local application

1. After installing MainView Explorer, use the **Start** menu or click the MainView Explorer desktop icon to start a MainView Explorer session.

   MainView Explorer launches and prompts you to log on. To start your MainView Explorer session, see Logging on to MainView Explorer on page 83.

   **Note**
   
   If a more current version of MainView Explorer is detected on the host server, the application prompts you to invoke the installation applet and install the new version.

Where to go from here

Complete the logon procedure, and set a context for your session. (You must set the context in order to access product views in the Product tree.)
Related Information

Next Task to Perform:

- "Logging on to MainView Explorer" on page 83

Supporting Information:

- "Setting a context in MainView Explorer" on page 85

Logging on to MainView Explorer

After starting MainView Explorer (either in a web browser or from a local directory), use this procedure to log onto your session. During logon, you will also have the option to allocate user data sets for personal use.

To log on to MainView Explorer

1. At the Windows security prompt for BMC, click OK (or Yes).

   **Tip**
   You can select the **Always** check box to prevent the security prompt from appearing for subsequent sessions.

2. In the Logon dialog box, type your TSO user ID and the corresponding password in the **User ID** and **Password** boxes.

   **Note**
   If your TSO password has expired or you want to change your password, use the **New password** box.
   MainView Explorer uses your ID and password for security checking only and does not log you onto a TSO system. In fact, you can already be logged on with the same TSO user ID.

3. If the **Allocate user datasets for personal use** check box is available, indicate whether to allocate user data sets to contain your customized views and configurations (instead of saving them to the site-wide data sets):

   **Note**
   If you do not see this box, your site administrator disabled allocation of user data sets; you can skip to Step 5 on page 84.

   - If you do not want to allocate user data sets, clear the **Allocate user datasets for personal use** box and all boxes below it.
If you want to allocate user data sets, select the **Allocate user datasets for personal use** check box.

4 If you selected **Allocate user datasets for personal use** in Step 3 on page 83, provide the following information:

   a In the **Template for user datasets** box, specify the template for your data set names.

   The template can consist of your TSO prefix (%UPREFIX), your user ID (%USERID), and the data set name (%BBDEF). You can arrange them in any order. Only %BBDEF is required, and it resolves to BBVDEF or BBCDEF (BBVDEF for customized views, and BBCDEF for customized configurations). If you do not specify %BBDEF in your template, BBVDEF or BBCDEF is added to the data set name as the low-level qualifier.

   **Example**

   The following examples show valid templates and the user data sets that are allocated if the user ID is **MYID01**:

   - %USERID.TEST.%BBDEF (or %USERID.TEST) allocates MYID01.TEST.BBVDEF (and BBCDEF).
   - PROD.U%BBDEF.%USERID allocates PROD.UBBVDEF.MYID01 (and UBBCDEF).
   - %USERID.&SYSNAME..%BBDEF allocates MYID01.SYSC.BBVDEF (on SYSC).

   Including the system variable &SYSNAME.., as shown in the last example, enables you to use the same data set template on different system images.

   b To insert the %USERID token in the template, select the **Insert token for User ID** box.

   c To insert the %UPREFIX token in the template, select the **Insert token for User prefix** box.

   **Note**

   If your site administrator specified a template in the MainView Explorer host server startup procedure, the **Template for user datasets** box and the **Insert token** boxes are grayed out. If you choose to allocate user data sets, they will be named according to the site-defined template.

   d If the **Insert token for User prefix** box is checked (either by you or because of the site-wide template), type your TSO user prefix in the **User prefix** field.

5 Click **OK**.
MainView Explorer opens in a separate window. The window that contains the splash screen must remain open during the MainView Explorer session.

Where to go from here

Set a context for your session in order to access product views in the Product tree.

Related Information

Next Task to Perform:

- “Setting a context in MainView Explorer” on page 85

Setting a context in MainView Explorer

Before you can access product views in the Product tree, you must set a context.

The Product tree does not contain a product until you set a context. A context consists of a MainView product running on one or more target systems. The target can be a single target system or an SSI context that includes multiple target systems.

After you set the context, any view that is opened displays data for that context. You can change the context of a view that is already open by using the Context tab in the Properties dialog box.

To set a single-target context

1. Use any of the Context trees (by area, system, or product) to navigate to the desired target system (as identified by the icon).

   **Note**
   
   If a target context has become inactive, the icon changes color from green to red.

2. Right-click the target and select **Set context**.

   **Tip**
   
   Alternatively, you can double-click the target to set the context and display the default view of gauges for the context.

To set an SSI context

1. In the Context by Product tree, open a product and navigate to an SSI context (as identified by the icon).
2 Right-click the SSI context, or any of the target systems under it, and select **Set SSI context**.

After you set a context, the Context indicator at the top of the navigation frame indicates the target or SSI context and the product. Additionally, the Product tree expands to display the MainView product for which that context is valid.

---

**Related Information**

- "Context of a view" on page 30
- "Context determination" on page 22

---

**Starting a TSO session**

Use the procedure in this topic to start a TSO session for a MainView product.

**Before you begin**

Ensure that the CAS and PAS are active (if necessary for the applications that you want to access). If you need to start them, see the *MainView Administration Guide* for CAS and PAS startup instructions.

**Note**

The first time you access MainView on a system, you will be prompted to allocate user-level data sets. You will be prompted again on subsequent logons until you allocate these files.

**To start a TSO session**

1 Execute the MainView CLIST in one of the following ways:

   - Select the appropriate ISPF menu or panel option.
   - On the **COMMAND** line, enter `TSO EX 'hlq.UBBSAMP(MainView)'`.
   - Start a VTAM or EXCP MainView Alternate Access terminal session that executes the MainView CLIST. (For more information, see the *MainView Alternate Access Implementation and User Guide*.)

2 If the Connection panel (Figure 15 on page 87) is displayed next, use it to choose a connection or to set a default connection.
This panel lists the available connection points on the system image under which your TSO session is running. The target PAS that you select must be at the same release and maintenance level as the code running in the MainView CLIST.

**Figure 15: Connection panel**

Your Connection for full screen mode (BBI-SS PAS) on this system is not defined or your default is not available. Choose a connection from the list below.

Note: Setting the default connection will cause this display to be skipped at startup. Use MAINVIEW option 0 to reset.

<table>
<thead>
<tr>
<th>Sel</th>
<th>Type</th>
<th>AA0</th>
<th>Target</th>
<th>Alias</th>
<th>Description</th>
<th>SSID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CICS</td>
<td>Y</td>
<td>AAOCS4TB</td>
<td>CICS TARGET</td>
<td>TB62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CICS</td>
<td>Y</td>
<td>AAOC12B</td>
<td>CICS TARGET</td>
<td>AOQA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CICS</td>
<td>Y</td>
<td>AAOC12J</td>
<td>CICS TARGET</td>
<td>AOQA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tip**

If you set a default connection now and want to change it later, you can do so from the MainView Selection Menu: select option 0.2 and then **Connection**.

3 On the MainView Selection Menu, select a MainView product area or option by typing the appropriate value in the **OPTION** field.

**Figure 16: MainView Selection Menu**

```
------------------------- MAINVIEW Selection Menu --------------------------
OPTION  ===>                                              DATE   -- mm/dd/yy
          TIME   -- hh:mm
          USERID -- tsoid
          MODE   -- ISPF v.r

Solutions for:
A  Automated Operations
C  CICS
D  DB2
I  IMS
L  Linux
N  Network Management
S  Storage Management
T  Application Management and Performance Tuning
W  WebSphere and MQSeries
Z  z/OS and USS

Enter X to Terminate Y
```

For more information about each option on the MainView Selection Menu, see the online Help.

**Note**

If you select a product that is not installed at your site, an INVALID OPTION message is displayed.
After you select a MainView product area, the menu for that product or products is displayed. For example, if you select option N (Network Management), the Network Management Solutions menu is displayed, as shown in the following figure:

**Figure 17: Sample product area menu - Network Management Solutions**

<table>
<thead>
<tr>
<th>OPTION</th>
<th>Network Management Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE</td>
<td>dd/mm/yy</td>
</tr>
<tr>
<td>TIME</td>
<td>hh:mm</td>
</tr>
<tr>
<td>USERID</td>
<td>tsoid</td>
</tr>
<tr>
<td>MODE</td>
<td>ISPF v.r</td>
</tr>
</tbody>
</table>

Management

1. MVIP MAINVIEW for IP
2. MVVTAM MAINVIEW for VTAM

Operations

E ALERTS Alert Management

General Services

M MESSAGES Messages and Codes
P PARMS Parameters and Options

All MainView product areas have a menu similar to this one. From a product area menu, you can typically access:

- One or more MainView products
- The Alert Management component of MainView Alarm Management
- The Messages and Codes online display
- The MainView Parameter Editors menu

Some product area menus have additional, product-specific options.

**Related Information**

- “Connecting to a different CAS” on page 88
- “Stopping a TSO session” on page 89

**Connecting to a different CAS**

Use the following procedure to connect to a CAS other than your session's default CAS.

1. From the MainView Selection Menu, select option 0 (Parameters and Options).
2. On the Terminal Session Parameter Select menu, select the option that applies to your product.
3 On the MainView Parameter Editors menu, select Control to display the Session Control Parameters panel.

**Figure 18: Session Control Parameters panel**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Subsystem ID</th>
<th>Confirm CAS</th>
<th>XDM mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>====&gt;</td>
<td>BBCS</td>
<td>====&gt; NO</td>
<td>====&gt; NO</td>
</tr>
</tbody>
</table>

(CAS Subsystem ID, ? for list of active SSIDs)

(Display CAS Connect Session Control, Yes/No)

(Execute session in diagnostic mode, Yes/No)

Press END to save updates or HELP for more information.

4 Specify the CAS to which you want to connect:

- If you know the ID of the CAS, type it in the **Subsystem ID** field and press **Enter**.

- If you do not know the ID, leave **Subsystem ID** blank (or enter a question mark) and press **Enter** to list active CAS IDs. The list also identifies which release of MainView Infrastructure each CAS is running; your selected CAS must be running the same release as the MainView CLIST that you used to start your terminal session. Type **S** or **/** by the ID of the CAS that you want, and press **Enter**.

  **Note**

  The selected ID is saved in your profile and appears in the **Subsystem ID** field next time you log on.

**Related Information**

- “Starting a TSO session” on page 86
- “Stopping a TSO session” on page 89

---

**Stopping a TSO session**

Use this procedure to stop a TSO session and return to the MainView Selection Menu.

1 Exit all active products by using one of the following methods:

- On the **COMMAND** line, enter =X.

- Press the **End (PF3)** key until you reach the MainView Selection Menu.

- From a Primary Option Menu (full-screen mode only), select option **X**.

---

Chapter 3  Accessing MainView products  89
Use the QUIT command.

From the MainView Selection Menu, select option X or press the End (PF3) key.

**Note**
You might be returned to a product's initial menu when you issue the QUIT command. From there, you can press the End (PF3) key to reach the MainView Selection Menu.

### Related Information
- “Starting a TSO session” on page 86
- “Connecting to a different CAS” on page 88

---

**Transferring from full-screen mode to windows mode**

Use the TRANsfer command to switch from products in full-screen mode to products in windows mode and back again.

1. Enter `TRANsfer target product;view`, replacing the variables as follows:
   - `target` is the system or subsystem that is being monitored.
   - `product` is one of the product values listed in Product values for transfer to windows mode.
   - `view` is the name of the view that you want to display.

**Note**
In this command, the semicolon (;) is the default command delimiter. If you are connecting to a CAS in windows mode for the first time, you might need to specify two command delimiters i(;;). The CAS connection message can interrupt ISPF command processing and cause the view command that follows the delimiter to be lost. If the transfer from full-screen mode to windows mode is not successful with one command delimiter, reissue the TRANsfer command with two delimiters.

<table>
<thead>
<tr>
<th>Table 5: Product values for transfer to windows mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product value</strong></td>
</tr>
<tr>
<td>CMF</td>
</tr>
<tr>
<td>Product value</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>MVALARM</td>
</tr>
<tr>
<td>MVCICS</td>
</tr>
<tr>
<td>MVCSMON</td>
</tr>
<tr>
<td>MVDAC</td>
</tr>
<tr>
<td>MVDB2</td>
</tr>
<tr>
<td>MVIMS</td>
</tr>
<tr>
<td>MVP</td>
</tr>
<tr>
<td>MVLNX</td>
</tr>
<tr>
<td>MVMQS</td>
</tr>
<tr>
<td>MVMVS</td>
</tr>
<tr>
<td>MVSP</td>
</tr>
<tr>
<td>MVSRM</td>
</tr>
<tr>
<td>MVTA</td>
</tr>
<tr>
<td>MVUSS</td>
</tr>
<tr>
<td>MVVP</td>
</tr>
<tr>
<td>MVVTAM</td>
</tr>
<tr>
<td>MVWEB</td>
</tr>
<tr>
<td>PLEXMGR</td>
</tr>
</tbody>
</table>

**Example**

To access the PLEXOVER view in Plex Manager, enter this command:

```
TRANSFER * PLEXMGR;PLEXOVER
```

---

**Transferring from windows mode to windows mode**

Use the CONtext command to switch from one product running in windows mode to another product running in windows mode.

1. Enter `CONtext [type:] [SSIname | target] product;view`, replacing the variables as follows:
   - `type` is one of the following dynamic SSI contexts:
     - SYSPlex: all targets for a given product in the named sysplex (such as SYSP)
—SYSTem: all targets for a given product on the named system, as identified by the CAS name (such as SYST)

—SYSName: all targets for a given product on the named system, as identified by the z/OS system name (such as SYSN)

- SSIname | target is a named SSI context or a target system or subsystem.
- product is one of the product values listed in Product values for transfer to windows mode.
- view is the name of the view that you want to display.

--- Example ---

To access the PLEXOVER view in Plex Manager, enter this command:

CONtext * PLEXMGR;PLEXOVER

--- Table 6: Product values for transfer to windows mode ---

<table>
<thead>
<tr>
<th>Product value</th>
<th>To access this product</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMF</td>
<td>CMF MONITOR Online</td>
</tr>
<tr>
<td>MVALARM</td>
<td>MainView Alarm Management</td>
</tr>
<tr>
<td>MVCICS</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td>MVCSONM</td>
<td>COMMON STORAGE MONITOR (CSMON)</td>
</tr>
<tr>
<td>MVDAC</td>
<td>MainView for DATA ACCELERATOR Compression</td>
</tr>
<tr>
<td>MVDB2</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>MVIMS</td>
<td>MainView for IMS Online and MainView for DBCTL</td>
</tr>
<tr>
<td>MVP</td>
<td>MainView for IP</td>
</tr>
<tr>
<td>MVLNX</td>
<td>MainView for Linux - Servers</td>
</tr>
<tr>
<td>MVMQS</td>
<td>MainView for WebSphere MQ</td>
</tr>
<tr>
<td>MVMSV</td>
<td>MainView for z/OS</td>
</tr>
<tr>
<td>MVSP</td>
<td>MainView SYSPROG Services</td>
</tr>
<tr>
<td>MVSRM</td>
<td>MainView Storage Resource Manager (SRM)</td>
</tr>
<tr>
<td>MVTA</td>
<td>MainView Transaction Analyzer</td>
</tr>
<tr>
<td>MVUSS</td>
<td>MainView for UNIX System Services</td>
</tr>
<tr>
<td>MVVIP</td>
<td>MainView VistaPoint</td>
</tr>
<tr>
<td>MVVTAM</td>
<td>MainView for VTAM</td>
</tr>
</tbody>
</table>
Transferring from windows mode to full-screen mode

You can transfer from windows mode to full-screen mode by either using the TRANsfer command or defining a hyperlink to switch from windows to full-screen mode.

**Note**
The PMGLAUTH program is required for transferring from windows mode to full-screen mode. For implementation instructions, see the MainView Common Customization Guide.

### Using the TRANsfer command

Use the TRANsfer command to switch from products in windows mode to products in full-screen mode and back again.

The TRANsfer command allows you to quickly access data from different products that operate in different interfaces. With this command, you can easily change the data view from a product in windows mode to a product that operates in full-screen mode or vice versa.

**Before you begin**

To use this command, you will need to know the system that you want to access and the desired product.

**To switch from windows mode to full-screen mode**

1. Enter `TRANsfer target product`, replacing the variables as follows:

   - `target` is the system or subsystem that is being monitored.

   - `product` is one of the product values listed in Product values for transfer to full-screen mode.
### Table 7: Product values for transfer to full-screen mode

<table>
<thead>
<tr>
<th>Product value</th>
<th>To access this product</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>CAO</td>
<td>MainView AutoOPERATOR for CICS</td>
</tr>
<tr>
<td>CICS</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td>DB2</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>IAO</td>
<td>MainView AutoOPERATOR for IMS</td>
</tr>
<tr>
<td>IMS</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>MAO</td>
<td>MainView AutoOPERATOR for z/OS</td>
</tr>
</tbody>
</table>

**Example**

To access the MainView AutoOPERATOR for z/OS menu on system A, enter this command:

**TRAN SYSA MAO**

---

### To transfer from windows mode to a specific full-screen application

1. Enter `TRANsfer target product;command target`, replacing the variables as follows:

   - **target** is the system or subsystem that is being monitored.
   - **product** is one of the product values listed in Product values for transfer to full-screen mode.
   - **command** is one of the application transfer commands listed in Transfer commands for full-screen applications.

**Example**

To access the System Status application for MainView AutoOPERATOR for z/OS on system A, enter this command:

**TRAN SYSA MAO;STATUS**
In this command, the semicolon (;) is the default command delimiter. If you are connecting to a CAS in windows mode for the first time, you might need to specify two command delimiters in a row (;;). The CAS connection message can interrupt ISPF command processing and cause the view command that follows the delimiter to be lost. If the transfer from full-screen mode to windows mode is not successful with one command delimiter, reissue the TRANsfer command with two delimiters.

### Table 8: Transfer commands for full-screen applications

<table>
<thead>
<tr>
<th>Application transfer command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COD</td>
<td>CODES</td>
</tr>
<tr>
<td>CYC</td>
<td>CYCLE</td>
</tr>
<tr>
<td>FOC</td>
<td>FOCAL</td>
</tr>
<tr>
<td>JOU</td>
<td>JOURNAL</td>
</tr>
<tr>
<td>KEY</td>
<td>KEYS</td>
</tr>
<tr>
<td>LOGMSG</td>
<td></td>
</tr>
</tbody>
</table>

Note: To return to full-screen mode, press the End (PF3) key or use the Quit command.

| TI | Time-initiated EXEC requests |

### Hyperlinking to full-screen mode

By customizing a hyperlink, you can directly access a full-screen application from windows mode. Use the following procedure to define a hyperlink to switch from products running in windows mode to products running in full-screen mode.

1. Go to the product and decide where you want to enter the hyperlink.
2. Use the CUSTom primary command to display view customization.
3. To select the Hyperlink option, specify H.
4. Position the cursor on the field where you want the hyperlink defined, and press Enter.
5. Enter `TRANsfer target product;command`, replacing the variables as follows:

   - `target` is the system or subsystem that is being monitored.
■ *product* is one of the product values listed in **Product values for transfer to full-screen mode**.

■ *command* is one of the application transfer commands listed in **Transfer commands for full-screen applications**.

### Table 9: Product values for transfer to full-screen mode

<table>
<thead>
<tr>
<th>Product value</th>
<th>To access this product</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>CAO</td>
<td>MainView AutoOPERATOR for CICS</td>
</tr>
<tr>
<td>CICS</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td>DB2</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>IAO</td>
<td>MainView AutoOPERATOR for IMS</td>
</tr>
<tr>
<td>IMS</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>MAO</td>
<td>MainView AutoOPERATOR for z/OS</td>
</tr>
</tbody>
</table>

### Table 10: Transfer commands for full-screen applications

<table>
<thead>
<tr>
<th>Application transfer command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COD</td>
<td>CODES</td>
</tr>
<tr>
<td>CYC</td>
<td>CYCLE</td>
</tr>
<tr>
<td>FOC</td>
<td>FOCAL</td>
</tr>
<tr>
<td>JOU</td>
<td>JOURNAL</td>
</tr>
<tr>
<td>KEY</td>
<td>KEYS</td>
</tr>
<tr>
<td>LOGMSG</td>
<td></td>
</tr>
</tbody>
</table>

*Note:* To return to full-screen mode, press the **End (PF3)** key or use the Quit command.

In this command, the semicolon (\(;)\) is the default command delimiter. If you are connecting to a CAS in windows mode for the first time, you might need to specify two command delimiters in a row (\(;;\)). The CAS connection message can interrupt ISPF command processing and cause the view command that follows the delimiter to be lost. If the transfer from full-screen mode to windows mode is not successful with one command delimiter, reissue the TRANsfer command with two delimiters.

6. Save the view by using the **S** option in view customization.
7 Test your new hyperlink to ensure that the command string executes properly.

Transferring from full-screen mode to full-screen mode

Use the product value code to transfer from a product that operates in full-screen mode to the Primary Option Menu of a different product that operates in full-screen mode.

To transfer from a product in full-screen mode to another product that runs in full-screen mode

1 Enter product on the COMMAND line, where product is one of the product values listed in Product values for transfer to full-screen mode.

Table 11: Product values for transfer to full-screen mode

<table>
<thead>
<tr>
<th>Product value</th>
<th>To access this product</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>CAO</td>
<td>MainView AutoOPERATOR for CICS</td>
</tr>
<tr>
<td>CICS</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td>DB2</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>IAO</td>
<td>MainView AutoOPERATOR for IMS</td>
</tr>
<tr>
<td>IMS</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>MAO</td>
<td>MainView AutoOPERATOR for z/OS</td>
</tr>
</tbody>
</table>

Note

- You can make more than one transfer request. However, you are usually limited to a maximum of four transfers. Each preceding request is maintained. Pressing the END (PF3) key displays the previous application where the transfer request was made.
- The PMGLAUTH program is required for operating in full-screen mode on both sides of an ISPF split screen.
- "Transfer between applications in full-screen mode" lists all transfer commands for all full-screen applications.

Example

To transfer from the MainView for DB2 History Traces application to MainView AutoOPERATOR for z/OS, enter MAO on the COMMAND line.
MainView Selection Menu options

The MainView Selection Menu provides access to the following functions:

Table 12: MainView Selection Menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Product/Utility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Parameters and Options</td>
<td>MainView Parameter Editors menu is displayed. This menu is not part of a product, but is a utility for customizing your MainView session parameters. This menu provides access to session control parameters for all MainView products. For more information about the MainView Parameter Editors menu or an individual session parameter, access the online help facility for the desired option. The KEYS and MVParms commands are available for quick-path access to the MainView Parameter Editors menu, so you do not have to exit your product to access this session parameters utility.</td>
</tr>
<tr>
<td>E</td>
<td>Alerts and Alarms</td>
<td>Alerts and Alarms menu is displayed. This menu provides access to MainView Alarm Management.</td>
</tr>
<tr>
<td>P</td>
<td>PLEX Management (PLEXMGR)</td>
<td>Plex Manager EZPLEX easy menu is displayed. Plex Manager, which is shipped with all products that run in windows mode, is activated as soon as a system’s CAS is started. With Plex Manager, you can monitor and manage targets and the connections between all products that run in windows mode on all systems.</td>
</tr>
<tr>
<td>Option</td>
<td>Product/Utility</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| U      | Utilities, Tools, and Messages | Utilities, Tools, and Messages menu is displayed. This menu provides access to:  
  - The journal logs used by some MainView products  
  - The MainView batch reporting facility (MVBATCH)  
  - The Messages and Codes display |
| A      | Automated Operations | MainView AutoOPERATOR menu is displayed. This menu provides access to MainView AutoOPERATOR products. |
| C      | CICS | CICS Solutions menu is displayed. This menu provides access to:  
  - MainView for CICS  
  - Energizer for CICS |
| D      | DB2 | DB2 Solutions menu is displayed. This menu provides access to MainView for DB2.  
  **Note:** To access RxD2, you can type RX on the COMMAND line or in the OPTION field of any full-screen MainView application. |
| I      | IMS | IMS Solutions menu is displayed. This menu provides access to:  
  - MainView for IMS  
  - MainView for DBCTL |
<p>| L      | Linux | Linux Solutions menu is displayed. This menu provides access to MainView for Linux-Servers. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Product/Utility</th>
<th>Description</th>
</tr>
</thead>
</table>
| N      | Network Management | Network Management Solutions menu is displayed. This menu provides access to:  
  - MainView for IP  
  - MainView for VTAM |
| S      | Storage Management | Storage Management Solutions menu is displayed. This menu provides access to MainView Storage Resource Manager (SRM) products. |
| T      | Application Management and Performance Tuning | Application Management and Performance Tuning menu is displayed. This menu provides access to:  
  - MainView Batch Optimizer  
  - MainView VistaPoint  
  - MainView FOCAL POINT  
  - MainView Transaction Analyzer |
| W      | WebSphere and MQSeries | WebSphere and MQSeries Solutions menu is displayed. This menu provides access to:  
  - MainView for WebSphere Application Server  
  - MainView for WebSphere MQ |
<table>
<thead>
<tr>
<th>Option</th>
<th>Product/Utility</th>
<th>Description</th>
</tr>
</thead>
</table>
| Z      | z/OS and USS   | z/OS and USS Solutions menu is displayed. This menu provides access to:  
  - CMF MONITOR  
  - MainView for z/OS  
  - MainView for UNIX System Services  
  - MainView SYSPROG Services |
Using the MainView interfaces

This chapter explains how to work with views in MainView Explorer and in windows mode.

See the following topics for working with views:

- Working with views in MainView Explorer on page 103
- Working with views in windows mode on page 114

*Note*
For information about how to use full-screen mode, see Working with full-screen mode displays on page 265.

Working with views in MainView Explorer

These topics explain the basics of working with views in MainView Explorer.
Opening a view

The final node on any branch of the Product tree represents a view. The following procedure explains several ways to open a view.

1. Locate the view in the navigation frame.

2. Perform one of the following actions:
   - Double-click the view icon.
   - Right-click the view icon and select **Open view**.
   - Right-click the view icon and select **Open with parameters**. Whatever you enter in the pop-up dialog is appended to the view request and is sent as is, without further validation.

The view is displayed in the view frame.
Tip
You can configure MainView Explorer to open a specific view automatically when you open MainView Explorer.

Related Information
■ “Setting personal configurations” on page 143

Locating a view

Use the following procedure to determine where a view is located in a product node, an EZExplorer node, or a view folder node.

1 Right-click the desired node and select Locate view.

2 Select a view from the Select view name list.

3 (optional) To locate and open the view in the view frame, select the Launch view when located check box.

4 Click OK.

The Product tree expands as necessary, and the view node is highlighted. If you selected the Launch view when located check box, the view opens in the view frame.

Detaching a view

Use the following procedure to detach an individual view from the MainView Explorer window. The view is displayed in a separate window and you can move, size, or close it independently of the MainView Explorer window. Closing MainView Explorer also closes any detached views.

To detach a view

1 Perform one of the following actions:
   ■ On the view toolbar, click the Detach button.
   ■ Right-click the view tab or the blank part of the view toolbar, and select Detach.
Note
You cannot detach the Plex Map.

To reattach a view

1. Click the Attach button on the detached view window.

Hyperlinking to other views

Most views contain hyperlinks. You can use the hyperlinks to access related or more detailed information about the view.

To hyperlink to another view

1. Double-click a field or a gauge in a view.

If the field or gauge has a hyperlink defined, the hyperlink's target view will open as a separate page in the view frame. In tabular and detail views, turquoise column headings indicate that the fields in that column have hyperlinks defined.

Tip
Alternatively, you can right-click a field or gauge, select Hyperlink, and select the hyperlink name. If the Hyperlink command does not appear on the menu, no hyperlink is defined for that field or gauge.

Note
If the defined hyperlink includes a TRANSFER command to an ISPF-only view, MainView Explorer automatically invokes its 3270 emulator to display the view. A dialog prompts you to log on to the host if necessary and to navigate to the MainView Selection Menu. When the MainView Selection Menu is displayed, MainView Explorer submits the TRANSFER command and displays the target view.

Related Information

- “3270 node” on page 61
Showing excluded fields in a view

Some fields in a view might be defined in the host view definition as excluded (or hidden) fields. Use the following procedure to display excluded fields. By default, data for these fields is retrieved from the host but is not displayed in the view.

To display excluded fields in a view

1. Right-click the view tab, or the blank part of the view toolbar, and select Show excluded fields.

   **Note**
   By default, data for these fields is retrieved from the host but is not displayed in the view.

   The view is redisplayed with all of the fields that are defined in the view.

   **Tip**
   You can remove the previously excluded fields by clearing the Show excluded fields option.

Showing header information

Use this procedure to display information regarding which columns are being used for grouping, sorting, summarization, charting, and positional parameters directly in the header buttons. You can also display the filters (form filters) that are currently in use.

To show header information

1. Right-click the view tab or the blank part of the view toolbar, and select Show header info.

2. Select one of the following options from the menu:
   - Show headings only
   - Show fields grouped by
   - Show fields sorted by
   - Show fields for charting
   - Show positional parameters
Changing the font in a view

Use the following procedure to change the font and point size of the text that is displayed in MainView Explorer views.

1. From the view that you want to change, perform one of the following actions:
   - On the view toolbar, click the Properties button.
   - Right-click the view tab or the blank part of the view toolbar, and select Properties.

2. On the Font tab of the Properties dialog box, select a font from the Font list and a point size from the Point size list.

   The font in the current view is changed.

3. (optional) Click Use this font for all to apply your changes to all views.

   **Tip**

   If you later want to restore default fonts, selecting Factory defaults for all restores MainView Explorer's original fonts; selecting Default restores the fonts that were last saved as the default (either user-defined or the original fonts).

   If you have saved font settings in a configuration and want to restore the originally distributed defaults, you must delete the configuration and save it again.

Related Information

- “Working with configurations” on page 144

Changing the colors in a view

MainView uses different colors in a view to indicate that threshold conditions have been met, to identify headers containing hyperlinks, and to distinguish different parts of the view. By default, all colors are defined in the host view definition, but you can use this procedure to customize them to meet your specifications.

1. From the view that you want to change, perform one of the following actions:
■ On the view toolbar, click the Properties button.

■ Right-click the View tab or the blank part of the view toolbar, and select Properties.

2 On the Color tab of the Properties dialog box, scroll through the list and select the part of the view that you want to change.

The current color for that part of the view is displayed in the color box to the right of the list.

3 Click a color from the palette, or click Custom and select a custom color.

The selected color is displayed in the color box and in the view.

4 Repeat Step 1 on page 108 and Step 3 on page 109 to change other parts of the view.

5 (optional) Click Use these colors for all to apply your changes to all views.

**Tip**
If you later want to restore default colors, selecting Factory defaults for all restores MainView Explorer's original colors; selecting Default restores the colors that were last saved as the default (either user-defined or the original colors). If you have saved color settings in a configuration and want to restore the originally distributed defaults, you must delete the configuration and save it again.

**Related Information**
■ “Working with configurations” on page 144

---

**Moving columns and fields**

Use the following procedures to move columns and fields in MainView Explorer.

**To move columns in a tabular view**

1 Select the column that you want to move.

2 Drag the column header to the column that you want it to follow.
Tip
If the column that you want your selection to follow is not visible, drag your selection to the far left or right. The view scrolls so that you can find the column.

To move fields in a detail view

1. Select the name of the field that you want to move.
2. Drag the name to the field that you want it to follow.

Resizing columns and fields

In MainView Explorer, you can resize columns and fields to meet your specifications.

Before you begin

Consider the following guidelines before resizing columns and fields:

- For data in columns, the specified width controls the width of the entire column (heading and data). For data in fields, the specified width controls the width of the data field only.

- If a column is not wide enough to display the data, alphanumeric data is truncated from the right, and numeric data is replaced with # characters.

- Allow enough room in a column or field for bar graph or hexadecimal data if either As graph or As hex is selected for Display Mode.

- The value for a field cannot exceed 66 characters.

To resize a column in a tabular view

1. Drag the column’s border to the left or right.

   Tip
   You can reset the column to its default width by double-clicking the column border.

To resize a column or field

1. Right-click the column’s header or the field, and select Format data.
2. In the Width field, specify the width that you want.
3 Click **Apply** or **OK**.

## Executing MainView commands

If you are familiar with the 3270 interface, optionally use the following procedure to enter commands for a view. Use this procedure if you prefer to use the **Command** line instead of the Properties dialog or pop-up menus.

### Before you begin

The following restrictions apply:

- The command syntax is not validated before the command is sent to the host. If the command is syntactically incorrect or incomplete, an error message is displayed.
- Commands must be valid for the current view.
- Commands that control MainView windows on the 3270 interface are not supported.

### To execute a MainView command from MainView Explorer

1. On the **Command** line, type the command in the entry box.

   **Tip**
   
   You can enter multiple commands by delimiting them with a semicolon (;). If you do not have a view open, right-click a folder in the Product tree and select **Enter command**.

2. To send the command to the host for execution, click the **Send** button or press **Enter**.

   Generally, the current view is replaced by the results of the command. However, if you enter the FORM command, the requested form is displayed as a new tab in the view frame.

3. **(optional)** To redisplay the previously entered command, click the **Recall** button.

   You can click the **Recall** button repeatedly to cycle through the last 10 commands that you entered.
Client and host server information displayed in MainView Explorer

Setting a product as the context in MainView Explorer lets you view client and host server information.

MainView Explorer is displayed as product MVEXP in the Product tree. If you set MVEXP as the context, the following views are available:

- **HSINFO (Host Server Summary)**
  Displays the following information about the MainView host server:
  - System
  - Job name
  - Version
  - IP address
  - Port number
  - Number of connected clients
  - Maximum clients allowed

- **CLIENTS (Client Sessions Overview)**
  Lists the client user IDs that are currently connected to the host server and the IP address, connection date and time, and number of open views for each user.

Working with the Plex Map display

In the Plex Map display, you can use this procedure to rearrange the objects, switch the Context tree, and isolate selected nodes.

**To rearrange objects**

1. Place the cursor over an object, hold down the left mouse button, and drag the object to the desired location.

**Tip**

You can redisplay the default arrangement by clicking the Reset button at the top of the view frame.
To switch the Context tree

1 Perform one of the following actions:

- Click an area name within the system image box (such as MVS under SJSCXTS7).
  The Context tree is switched to the Contexts by area tree, and the system node (SJSCXTS7) is expanded to show the target contexts.

- Click a CAS name at the top of the system image box (such as SJSCXTS7).
  The Context tree is switched to the Contexts by system tree, and the system node is expanded to show all of the target contexts on that system.

- Click a product name in one of the product boxes (such as CMF).
  The Context tree is switched to the Contexts by product tree, and the product node is expanded to show all of the systems on which the product is running.

To isolate a selected node in the Plex Map

1 Complete one of the following actions:

- Right-click a system image box and select Isolate node.
  The Plex Map is redrawn to show only that system image and all products that are running on it.

- Right-click a product box and select Isolate node.
  The Plex Map is redrawn to show only that product and all systems on which the product is running.

Tip
You can redisplay the complete Plex Map by right-clicking the isolated node and clearing the Isolate node option.

Working with Plex Topology displays

Use the following procedure to work with the Plex Topology displays, which is much the same as working with the Plex Map.

To use the Plex Topology objects

1 Complete the following actions:
■ To locate a context node in the Context tree in the navigation frame, to set the context in the Product tree in the navigation frame, and to launch a dashboard view for that product, double-click a context node.

■ To locate a context on the Context tree in the navigation frame, right-click a context node and select **Set context tree**.

■ To populate the Product tree in the navigation tree, right-click a context node and select **Set product tree**.

**Note**
All of the actions described in "Navigating and arranging topology charts" apply for the Plex Topology displays.

**Related Information**
■ “Navigating and arranging topology charts” on page 159

---

**Working with views in windows mode**

These topics explain the basics of working with views in windows mode.

**Related Information**
■ “Overview of the display area” on page 115
■ “Creating a window” on page 115
■ “Maximizing a window” on page 119
■ “Closing a window” on page 120
■ “Working with screens” on page 121
■ “Transfer methods between TSO ISPF terminal sessions” on page 123
■ “Using the Messages and Codes display” on page 124
Overview of the display area

In windows mode, each window includes a control area, information line, and display area. In the display area, you can create multiple windows, split windows, expand windows, and close windows.

Creating a window

By default, the MainView terminal session starts with a single window. You can create multiple windows, horizontally and vertically. This capability enables you to monitor and manage several systems from a single point of control, and see varying levels of detail from a single display.

You can open a maximum of 20 windows simultaneously in each ISPF session.

To open a hyperlink in a new window

1. Create a new window by splitting the display either horizontally or vertically.

   The number of the active window is shown in the CURR WIN field in the window control area at the top of the display. The new window is empty and has a window status of T in its window information line, which means the window is available to receive view or window commands.

   **Tip**

   You can change the active window by entering the following command on the COMMAND line:

   \texttt{W n}

   The variable \( n \) specifies the number of the window that you want to be the active window. The value of \( n \) can be from 1 through 20. For more information about this command, type \texttt{HELP Wn} on the COMMAND line.

2. In the ALT WIN field, type the number of the new window in which to open the hyperlink.

3. Place your cursor on a highlighted element in the window that you want to hyperlink from, and press Enter.

   The hyperlink is shown in the new window.
Use an ampersand (&) and the window number (such as &2) to retain the alternate window between actions to avoid having to retype the number every time you want to hyperlink to a view in that window.

Example of creating windows

This example uses the Plex Manager product to demonstrate creating windows. Plex Manager is a MainView system administration product that manages the connections between systems and MainView products.

Example of using the Plex Manager product to create a screen

1. Enter the following CONTEXT command to access the Plex Manager product and the PLEX view:

   CON * PLEXMGR;PLEX

   Note
   The asterisk (*) specifies the local CAS where your terminal session is connected. For more information about this command, type HELP CON on the COMMAND line.

   PLEX is the Plex Manager view that lists all active MainView products, their targets, and their target status.

   The PLEX view is displayed:

<table>
<thead>
<tr>
<th>Product</th>
<th>Context</th>
<th>System</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>MVDB2</td>
<td>DB2L</td>
<td>SYSB</td>
<td>PRODUCTION DB2</td>
<td>Active</td>
</tr>
<tr>
<td>MVIMS</td>
<td>IMSCTL</td>
<td>SYSA</td>
<td>IMS</td>
<td>Active</td>
</tr>
<tr>
<td>MVIMS</td>
<td>IMSM</td>
<td>SYSA</td>
<td>IMS</td>
<td>Active</td>
</tr>
<tr>
<td>MVMS</td>
<td>SYSB</td>
<td>SYSB</td>
<td>MAINVIEW for z/OS</td>
<td>Active</td>
</tr>
<tr>
<td>MVMS</td>
<td>SYSC</td>
<td>SYSC</td>
<td>MAINVIEW for z/OS</td>
<td>Active</td>
</tr>
<tr>
<td>MVMS</td>
<td>SYSA</td>
<td>SYSA</td>
<td>MAINVIEW for z/OS</td>
<td>Active</td>
</tr>
<tr>
<td>MVVP</td>
<td>SSICICS</td>
<td>SYSA</td>
<td>SPECIALIZED SOFTWARE V</td>
<td>Active</td>
</tr>
<tr>
<td>MVVP</td>
<td>PUBCICS</td>
<td>SYSA</td>
<td>BBCS PUBLIC CICS</td>
<td>Active</td>
</tr>
<tr>
<td>MVVP</td>
<td>GUPCICS4</td>
<td>SYSA</td>
<td>GUPTA CICS V4.10</td>
<td>Active</td>
</tr>
<tr>
<td>MVVP</td>
<td>GUPCICS</td>
<td>SYSA</td>
<td>GUPTA CICS V5.10</td>
<td>Active</td>
</tr>
<tr>
<td>MVVP</td>
<td>TERXCICS</td>
<td>SYSA</td>
<td>TENERA</td>
<td>Active</td>
</tr>
<tr>
<td>MVVP</td>
<td>SYSB</td>
<td>SYSB</td>
<td>MAINVIEW VistaPoint</td>
<td>Active</td>
</tr>
</tbody>
</table>

2. On the COMMAND line, type HS, move the cursor down the screen to a position where you want the top of the second window to appear, and press Enter.

   The second window that you created should be displayed as the active window in the CURR WIN field.
3 In the **ALT WIN** field, type **2**, but *do not* press **Enter**.

This action sets the second window that you just created as a destination for a hyperlink from the first window.

4 In the first window, place the cursor on a product in the list and press **Enter**.

For example, if selecting MVDB2 from the first window (W1) displays that product’s main menu in the second window (W2).

```
<table>
<thead>
<tr>
<th>Product</th>
<th>Context</th>
<th>System</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>MVDB2</td>
<td>DB2L</td>
<td>SYSB</td>
<td>PRODUCTION DB2</td>
<td>Active</td>
</tr>
<tr>
<td>MVIMS</td>
<td>IMSCTL</td>
<td>SYSA</td>
<td>IMS</td>
<td>Active</td>
</tr>
<tr>
<td>MVIMS</td>
<td>IMSM</td>
<td>SYSA</td>
<td>IMS</td>
<td>Active</td>
</tr>
<tr>
<td>MVMVS</td>
<td>SYSB</td>
<td>SYSB</td>
<td>MAINVIEW for z/OS</td>
<td>Active</td>
</tr>
<tr>
<td>MVMVS</td>
<td>SYSC</td>
<td>SYSC</td>
<td>MAINVIEW for z/OS</td>
<td>InActive</td>
</tr>
<tr>
<td>MVMVS</td>
<td>SYSA</td>
<td>SYSA</td>
<td>MAINVIEW for z/OS</td>
<td>InActive</td>
</tr>
</tbody>
</table>
```

**Note**

Window 2 (W2) is now the active window, as indicated by the **2** in the **CURR WIN** field.

5 On the **COMMAND** line, type **VS**, move your cursor in the second window to a place where you want to split the window in half vertically, and press **Enter**.

The third window that you created should be displayed as the active window in the **CURR WIN** field.

**Note**

Placing your cursor in the window control area at the top of the display and pressing **Enter** splits the entire display either vertically or horizontally.

6 In the **ALT WIN** field, type **3**, which makes window 3 the destination for a hyperlink from any window.
Select another active product from the first window to hyperlink to that product's main window in window 3, as shown in the following example:

```
ddmmmyyyy hh:mm:ss -------- MAINVIEW WINDOW INTERFACE (Vv.r.mm) ----------
COMMAND ===> SCROLL ===> CSR
CURR WIN ===> 1        ALT WIN ===> 3
>W1 -PLEX-------------SYSB-----*--------ddmmmyyyy--hh:mm:ss----PLEXMGR--D---17
```

The main menu shown in window 3 is the result of a hyperlink from the active MVMVS product in window 1. You now have multiple windows open with a different product in each window. With multiple windows, you can track several targets from a single display. You can also use multiple windows to select views that contain hyperlinks, and progressively move to more detail in each window.

**Related Information**

- “Displaying data from multiple systems” on page 180
- “Creating a window” on page 115

**Splitting windows**

Use the following procedure to split windows horizontally and vertically in a view.

**To split a window horizontally or vertically**

1. Indicate how you want to split the screen:
   - For a horizontal split, type **HS** on the **COMMAND** line.
   - For a vertical split, type **VS**.

2. Place the cursor where you want the new window to begin and press **Enter**.

   The command splits the display at the cursor position and creates another window.
Maximizing a window

When several windows are open, you can maximize one to get a better look at it. You can also set a timed cycle for refreshing the view data.

To expand a window to its maximum size

1. Perform one of the following actions:
   - Specify the MAXimize command with the number of the window preceding it (such as W2.MAX).
   - Put the number of the window that you want to maximize in the CURR WIN field and enter MAX on the COMMAND line.

The window that you specify fills the display area.

Note

To see other views, you can scroll through each one in sequence by entering NEXT or PREVious on the COMMAND line.
To return all of the windows that you created to the display area, enter RESTore on the COMMAND line.

To specify a timed, data refresh cycle for views in multiple windows

1. Enter the MAXimize command, as described in Step 1 on page 119 of the preceding procedure.

2. Enter the NEXT or PREVious command as follows:
   - To scroll forward through each view in a timed, data refresh cycle, type NEXTnnn, where nnn is the number of seconds from 3 through 999.
   - To scroll backward through each view in a timed, data refresh cycle, type PREVnnn, where nnn is the number of seconds from 3 through 999.
**Example**

Assume that you have four windows open with a view displayed in each one, and you have maximized one of the views. If you enter `PREV 15`, the data in each view is displayed and refreshed every 15 seconds; this process starts with the view in the maximized window where you entered `PREV 15` and scrolls backward through all four views in a 15-second, data-refresh cycle.

---

**Note**

To cancel the data refresh cycle, use the attention interrupt key:

- For SNA terminals, use the `ATTN` key.
- For non-SNA terminals, use the `PA1` key.

On some keyboards, you must press the `RES` key to unlock the attention interrupt key. IBM defines the attention interrupt procedure, and MainView uses the keys that are assigned by this procedure. TSO uses the same keys.

---

**Closing a window**

Use the following procedure to close a window.

1. In the **CURR WIN** field, type the number of the window that you want to close.

2. On the **COMMAND** line type **CLOse** and press **Enter**.

When you close a window, its display space is given to any adjoining windows.

---

**Note**

If you used the MAXimize command to maximize a window, you must use the RESTore command to restore all of the windows before closing them. The CLOSE command does not work when windows are maximized.

---

**Tip**

To close all open windows at once, use the `RESet` command. `RESet` leaves a single empty window. The empty window has a status of T in the window information line, indicating it is available to receive view or window commands. The `RESet` command also deletes all entries in any view or form stacks.

To clear a window of its contents, but not close it, use the `CLEar` command.
Working with screens

You can save multiple windows as one screen under a single name. You can save screens in your own screen data set, or in a site data set to be shared by everyone.

Screens are useful when you frequently display the same combination of views, and always in the same windows. For example, you might want to save a screen of windows that show the performance of three different systems.

**Note**
If you are looking at multiple views and request a screen, all of the open windows containing your views are closed.

**Related Information**

- “Creating a window” on page 115

Creating screens

Use the following procedure to create and save screens with multiple windows.

1. Allocate a standard partitioned data set for your screen definitions called `userid.BBSDEF`, where `userid` is your TSO user ID.

   Your personal screen definition is displayed instead of a site-wide screen definition by the same name. If you want to contribute to the site library, contact your system administrator.

2. Open multiple windows displaying the views that you want to save.

3. On the **COMMAND** line, type `SAVESCR` and press **Enter**.

4. In the Save Screen Definition dialog, type a name for your screen in the **Name** field.

5. *(optional)* In the **Description** field, type a description of the screen.

6. In the **Replace** field, specify **Y** to overwrite a screen definition of the same name.

7. Enter **END** to save the screen definition.
Note
If you create a screen definition on a large display monitor and then try to display that screen on a smaller monitor, you receive an error message. However, screens that you create on a smaller monitor always expand to fill the area afforded by a larger monitor.

Related Information
- “Creating a window” on page 115

Displaying screens
Use the following procedure to redisplay previously created screens.

1. Perform one of the following actions:
   - Enter `SCReen name`, where `name` is the name that you specified in the Save Screen Definition dialog.
   - Use the SCREENS view to list all of the screen definitions that have been saved for your user session, plus those shared by your site.

   Each MainView product contains a SCREENS view. If all of your MainView products are installed on the same system, their screen definitions appear in one SCREENS view. You can see what screens your site has by entering the SCREENS command on the COMMAND line.

   These screen definitions contain specific views that reflect the current time and contain refreshable data. They give you ideas for creating your own screen definitions and provide a starting point from which you can begin using hyperlinks to explore system performance.

Setting an initial screen
When you start a MainView product, use the following procedure to display a screen with a set of views that are customized to your site's needs.

To set an initial screen

1. Create the screen that you want.
2. On the COMMAND line, type `MVParms` and press Enter.
3. From the MainView Parameter Editors menu, select the DISPLAY option.
The Information Display Parameters dialog is displayed.

4 In the **Initial screen** field, type the name of your screen.

You can specify only screen names. If you want to use a single view for your initial screen, save it as a screen.

---

**Note**

This initial screen is used when you access any MainView product. If you use a screen that you created with views from one product and then access a different product initially, you will still get the initial screen that you created.

---

**Related Information**

- "Creating screens" on page 121

---

**Transfer methods between TSO ISPF terminal sessions**

You can switch between products in either windows mode or full-screen mode without exiting your current terminal session. These transfer functions make it easier to work with products in both windows mode and full-screen mode.

All of your MainView products are designed to work together within the same TSO/ISPF terminal session. Through commands, you can easily access data from different products that operate in either interface. Thus, you can transfer from:

- Full-screen mode to windows mode
- Windows mode to windows mode
- Windows mode to full-screen mode
- Full-screen mode to full-screen mode

Also, when working in windows mode, you can define a hyperlink to a product that operates in full-screen mode. For a list of the transfer methods available for each type of transfer, see Table 13 on page 123.

**Table 13: Mode paths and transfer methods**

<table>
<thead>
<tr>
<th>Mode path of transfer</th>
<th>Transfer method</th>
</tr>
</thead>
<tbody>
<tr>
<td>From full-screen mode to windows mode</td>
<td>Use the TRANSfer command</td>
</tr>
<tr>
<td>From windows mode to windows mode</td>
<td>Use the CONtext command</td>
</tr>
</tbody>
</table>

---

Chapter 4 Using the MainView interfaces 123
### Mode path of transfer

<table>
<thead>
<tr>
<th>From windows mode to full-screen mode&lt;sup&gt;a&lt;/sup&gt;</th>
<th>Transfer method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the TRANSfer command</td>
<td></td>
</tr>
<tr>
<td>Define a hyperlink</td>
<td></td>
</tr>
<tr>
<td>From full-screen mode to full-screen mode</td>
<td>Enter the product code on the command line</td>
</tr>
</tbody>
</table>

<sup>a</sup>The PMGLAUTH program is required for transferring from windows mode to full-screen mode. For implementation instructions, see the *MainView Common Customization Guide.*

---

**Note**

To perform these transfers, you need to know the system that you want to access and the desired product. Convenient tables that list this information are available in the procedures for each type of transfer.

---

### Using the Messages and Codes display

An explanation of any message from a MainView product is available for review in the Messages and Codes display. Use the following procedures to view message descriptions.

**To view a single message directly**

1. Use MSG `msgNumber` primary command on any COMMAND line.

**To view a message from a list**

1. Access the Messages and Codes panel by using one of the following methods:
   - Use the MSG primary command on any COMMAND line
   - Select the Messages option on:
     - The MainView Selection menu
     - Any MainView product area menu that has this option
     - The General Services option of the Primary Option Menu (in full-screen mode)
2. On the Messages and Codes panel, find a message by scrolling through the list or using the Locate primary command.
3. Display the message description by selecting the message from the list or use the Select primary command.
The message description provides the following information:

- Why the message was issued
- The action that the system takes
- Any action that the user should take
- The module where the message originated

**Note**

- All messages and codes for all MainView-installed products, including offline products, are in this list.
- ISPF short messages are listed in alphabetic order before the numbered messages and codes.
- The messages and codes are obtained from the BBMLIB data set. This data set can be browsed if a terminal session is not available.
- When messages are written to the system console, such as WTOs, the BBI-SS PAS ID is appended whenever appropriate.

**Related Information**

- “Program function (PF) key definitions” on page 270
Working with views in windows mode
Building views of data

This chapter shows you how to build views of data in MainView Explorer and in windows mode.

Controlling data views in MainView Explorer

The following topics show you how to change and compose data views, empowering you to establish the exact perspective of data you need at any time.

You can control the composition of data views in a variety of ways. For example, use features such as find, sort, select, import and refresh to build the view of data. Once composed, you can perform actions to the view data such as exporting, copying, publishing and printing.
Refreshing view data (MainView Explorer)

The data displayed in a view is static. When you refresh the data in a view, new data is retrieved from the host and displayed in the view. Refreshing data in a view automatically refreshes the data in any alternate form of the view, such as a chart or detail view. You can refresh data manually, or automatically at a specified interval.

Note

You cannot refresh the Plex Map view automatically.

To refresh the data in a view

1. Use one of the following methods:

   Manually

      On the view toolbar, click the Refresh button.
- Automatically
  On the view toolbar, click the **Auto-Refresh** button.
  Data in the view is refreshed automatically at the specified rate, as displayed in the status line of the view. If an automatic refresh rate was not previously set in the Properties dialog box for the view, a default rate of 15 seconds is used.

**To set the automatic refresh rate**

1. From any view (except the Plex Map view), perform one of the following actions:
   - On the view toolbar, click the **Properties** button.
   - Right-click the view tab or the blank part of the view toolbar, and select **Properties**.

   The Properties dialog box is displayed.

2. On the Refresh tab, drag the slider to the number of seconds that MainView Explorer should wait between data refreshes.

   The minimum allowed is 15 seconds, and the maximum is 300.

3. Perform one of the following actions:
   - To set the rate *and* start the refresh cycle, click the **Start** button.
   - To set the rate without starting the cycle, click the **Close** button.

**To stop an automatic data refresh cycle**

1. From a view that is in auto-refresh mode, perform one of the following actions:
   - On the view toolbar, click the **Auto-Refresh** button.
   - Open the Refresh tab of the Properties dialog box and click the **Stop** button.

**Related Information**

- “Specifying thresholds” on page 194

---

**Sorting view data (MainView Explorer)**

In tabular views, rows of data are sorted by a particular column, as specified in the host view definition. By default, numeric data is sorted in descending order, and
character data is sorted in ascending order. However, you can use the following procedure to change the sort order of data.

A solid arrow marks the column that is used for the primary sort order; the arrow indicates the direction of the sort. A hollow arrow marks the secondary sort column (if any). Up to four levels of sort order might be specified in the host view definition.

**To change the sort order of data**

1. Click the column heading that you want to sort.

   **Tip**
   Clicking the column heading again would sort the data in the opposite order.

   **Note**
   The sort order is retained until you re-sort the data or close the view.

---

### Finding data in a view

In a tabular view, use the following procedure to search for specific data in a given column.

MainView Explorer searches the view data until it finds an alphanumeric character string that matches the one you specified. That data is then displayed as the first row of the view.

**To find data in a view**

1. In a tabular view, identify a column in which you want to search for data.

2. Right-click the column header button and select **Find**.

3. In the entry box of the Find in column dialog, specify the alphanumeric string that you want to find.

   - For character fields, you can use the following generic qualifiers in any combination:

     — An asterisk (*) represents any number of characters.
     
     An asterisk can appear in any position in the data string. For example, the asterisk at the beginning of *SYS finds data such as TSTSYS and PRODSYS. SYS*9 finds data such as SYSTEST9 and SYSPROD9. SYS* or just SYS finds data such as SYSTEST and SYS9.
A question mark (?) represents a single character in a specific position. You can use as many question marks as you want, and you can place them in any position in the data string. For example, specifying ?GS finds LGS9 and TGS5 but not BAGS1.

For numeric fields, you cannot use generic qualifiers. However, you can search for numeric values that are formatted in kilobytes, megabytes, or gigabytes (such as, 8K, 8M, or 8G).

For example, if you specify 8K in the search field for a numeric column, MainView Explorer finds the first row that has a value >= 8000, whether the field is displayed as 8K or 8138.

4 Specify a direction for the search by selecting the Forward or Backward radio button.

The search will proceed forwards or backwards from the first line in the display.

5 To begin the search, click the Find next button.

MainView Explorer searches for an occurrence of the specified data in that column. If the data is found, the row that contains the data is displayed as the first row of the view. You can search for the next occurrence of the data by clicking the Find next button again.

6 To close the Find in column dialog, click the Cancel or Close button.

Selecting multiple rows of data

If you need to perform actions for a subset of the data in a tabular view, use the following procedure to highlight selected rows.

You can perform any of the following actions against the selected rows:

- Export them to a file
- Copy them to the clipboard
- Print them
- Perform a host action against them
- Produce a chart of their data
To select multiple rows of data

1. From a tabular view, perform one of the following actions:
   - On the view toolbar, click the **Enable selections** button.
   - Right-click the view tab or the blank part of the view toolbar, and select **Enable selections**.

2. Select multiple rows of data by using one of the following methods:
   - To select the rows individually, click the first row, hold down the **Ctrl** key, and click additional rows.
   - To select adjacent rows, click the first row, hold down the **Shift** key, and click the last row.

   **Tip**
   You can disable the selection of multiple rows by clicking **Enable selections** again.

---

**Related Information**

- “Exporting view data on demand” on page 132
- “Copying view data to the clipboard” on page 138
- “Printing view data” on page 140
- “Performing host actions from a view” on page 141
- “Opening a chart” on page 153

---

**Exporting view data on demand**

Exporting a view is a good way to take a snapshot of view data. The view data is exported to a file in a comma-separated value (CSV) format; you can open the file in a spreadsheet application or import it back into MainView Explorer.

For tabular views, all data rows are exported by default, but you can also export only selected rows of data.
To export all rows

1 From any view, perform one of the following actions:

- On the view toolbar, click the **Export data to file** button.
- Right-click a column header button (in tabular views) or a field (in detail views) and select **Export data to file**.

All of the current view's data is exported, including data in fields that are excluded or hidden.

2 From the Choose a directory to export to dialog, select a local directory in which you want to save the exported file and click the **Open** button.

3 With the directory open, click the **Save** button.

A file name is generated for the exported data in the local directory. The name consists of the view name and a numeric extension, starting with 1 (such as JOVER.1). The view name is used as the basis for the exported file name regardless of what you specified in the Choose a directory to export to dialog.

**Note**

Each time you request the export function for this view, an additional file is generated, and the file extension is incremented by one (JOVER.2, and so on). This sequence enables you to import the exported data later and cycle through the series of snapshots.

To export selected rows

1 From a tabular view, select the data rows that you want to export.

2 Either click the **Export data to file** button on the view toolbar, or drag the selected rows to that button.

3 From the Choose a directory to export to dialog, select a local directory in which you want to save the exported file and click the **Open** button.

4 With the directory open, click the **Save** button.

**Related Information**

- “Selecting multiple rows of data” on page 131
Exporting view data automatically

You can configure MainView Explorer to automate data export. Automatic export lets you export view data to a selected directory on a local or network drive.

Automatic export writes the current view data to the specified directory whenever you click **Refresh** or, if the view is in auto-refresh mode, at every refresh interval.

Automatic export offers the following benefits:

- You can start MainView Explorer from any launched view and automatically export data from that view at regular intervals.

- You can view the exported data through the MainView Explorer Viewer (MVE Viewer), without having to log onto the mainframe.

- You can use a single data file for all automatic exports (the default) or a new file for each export:
  
  - By default, each export overwrites the data file that has extension `.1` (`viewDataFile.1`). With this method, if MVE Viewer is in auto-refresh mode, this file always contains current data.

  - If you prefer to preserve data history and compare data over time, you can use a new file for each export. This method increments the data file extension by 1 each time data is exported. When viewing the exported data through MVE Viewer, you can cycle through the series of snapshots by clicking **Refresh**.

Setting automatic export to preserve data history

Use the following procedure to preserve data history when using automatic export. For each export, automatic export will write data to a new file instead of overwriting the same file every time.

1. From any view (except the Plex Map view), perform one of the following actions:
   
   - On the view toolbar, click the Properties button.

   - Right-click the view tab or the blank part of the view toolbar, and select **Properties**.

2. On the **Refresh** tab of the Properties dialog box, check the **Preserve history with each refresh** box.

   Each refresh writes the current view data to the `viewDataFile.1` file and, also, creates an additional file with an incrementing numeric extension. The previous
viewDataFile.1 file is saved with an extension of .2. Each refresh causes the extension of previously exported files to increase by 1 (the .1 file becomes .2, .2 becomes .3, and so on).

**Note**
You must manually manage the files that accumulate.

3 (optional) In the **Number of history files** box, select the maximum number of history files to accumulate.

   The default value is 20.

4 Click the **Start** button.

**Tip**
You can use the MVE Viewer to see current data or historical data at the same time. Use the **Previous** and **Next** buttons and the **Current** button on the toolbar to control which short-term history file you are viewing.

### Overview of the MVE Viewer

The MainView Explorer Viewer (MVE Viewer) is a stand-alone application that lets you see view data that was exported from MainView Explorer.

MVE Viewer does not require you to log onto the mainframe host. MVE Viewer runs as an applet within a browser (using the same cached jar file that MainView Explorer uses).

With MVE Viewer, you can import any data file from a local or network drive to which you have access. As Figure 19 on page 136 shows, the imported data occupies a separate pane, which you can detach and manipulate. The following actions are available with the MVE Viewer:

- Changing threshold colors
- Formatting headers and data
Using all charting functions, including the selection of chart styles and items for charting

Figure 19: Sample of MVE Viewer

Hyperlinks (but not actions) are also available. When a hyperlink is sent to the MainView Explorer host server, the host server looks for an active MainView Explorer session on your desktop. If a session is active, the host server sends the link to it, opening a pane with the view in your active MainView Explorer session. If no active session is found, a MainView Explorer session is launched (which requires your logon), and the link is sent to that session.

If you have access to a network drive to which an active MainView Explorer session is exporting view data, you can view that data without logging onto the host. In this manner, you can use MainView Explorer as a data server.

Launching the MVE Viewer

Use the following procedures to launch the MVE Viewer, either as an applet within a browser, or with a requested view.
To launch MVE Viewer within a browser

1 From your browser, enter the following URL, replacing *host* and *port* with the appropriate names:

   http://host:port/viewer.ehtm

To launch MVE Viewer with a requested view

1 From your browser, enter the following URL, replacing *host*, *port*, and *directoryName* with the appropriate names:

   http://host:port/viewer.ehtm?import=directoryName

In this URL, *directoryName* is the directory that you set for automatic export.

Whenever you specify a directory for export or import, the directory name is saved in your preferences. When you launch MVE Viewer with an import parameter, MVE Viewer searches that directory for a file with that name and with an extension of .1. If the file is found, MVE Viewer adds that view to the stack of view panes. You can even specify a series of views, separated by commas, and all views found will be added to the stack.

**Example**

http://sysa:3940/viewer.ehtm?import=jflow,sysstat,lparstat

You can also import XML topology views this way by adding the .xml extension to the import specification.

**Example**

http://sysa:3940/viewer.ehtm?import=sysplex.xml

Example of using automatic export and the MVE Viewer

This topic demonstrates using automatic export and the MVE Viewer to see combined sysplex information through a single system image (SSI).
Example
Assume that, for each data center, you have launched MainView Explorer with a particular view that shows its sysplex data. You can now automatically export this view at a regular interval to a common network directory. MVE will automatically concatenate these files together. This combined file could then be imported by any data center (into an MVE session or MVE Viewer).

The imported view can be shown as a topology, showing the statuses of all connected sysplexes. Also, because each row of data carries the host and port that exported it, a hyperlink can launch a MainView Explorer session to the correct sysplex (host and port).

Importing a view or chart

For view data or charts that were exported to a file, use the following procedure to import the view or chart back into MainView Explorer.

1. From the File menu, select Import data from file or Import chart from file.

   The Import view from file dialog is displayed.

2. Locate the file that you want to import and click the Open button.

   The imported view or chart is displayed in the view frame, replacing the current display. The status line at the bottom of the view frame displays the context and time for the imported view. The data in the view or chart is static.

   Tip
   Some directories from which you select views to import might show a series of files with the same name but incremented numeric extensions. You can display those files in order by clicking the Refresh button on the view toolbar.

Copying view data to the clipboard

You can copy data from the current view to the clipboard in tab-separated format. You can then paste the data into a word processor or spreadsheet application.

For tabular views, all data rows are copied by default, but you can also copy only selected rows of data.
To copy all rows

1 From any view, perform one of the following actions:

- On the view toolbar, click the **Copy data to clipboard** button.
- Right-click the View tab or the blank part of the view toolbar, and select **Copy data to clipboard**.

All of the current view's data is copied, including data in fields that are excluded or hidden.

To copy selected rows

1 From a tabular view, select the data rows that you want to copy.

2 Either click the **Copy data to clipboard** button on the view toolbar, or drag the selected rows to that button.

---

**Related Information**

- “Selecting multiple rows of data” on page 131

---

Publishing view images

Use the following procedure to publish a tabular view and its chart to other users. This procedure places JPEG files of the view and its chart (if one is open) in a local directory, along with an HTML file.

When a user double-clicks the HTML file, the view and its chart are displayed in a web browser. This option enables users to see a view without being logged on to MainView Explorer. The published view can be put into auto-refresh mode, which enables users to display the latest data by clicking the **Reload** button on their browsers. The view remains available to other users until you discontinue the publishing process.

---

**Note**

You cannot publish an alternate form of a view. The tab icon for an alternate form, 
, does not have a magnifying glass on it.

---

To publish a view to a file

1 From a tabular view or chart, perform one of the following actions:
On the view toolbar, click the **Publish view images** button.

Right-click the view tab or the blank part of the toolbar and select **Publish view images**.

2 From the Choose a directory dialog, select a local directory in which you want to save the JPEG and HTML files, and click the **Open** button.

3 With the directory open, click the **Save** button.

The file names that are generated consist of the view name (unless you change it) and the extensions `.jpg` and `.html`. The files are replaced each time the view is refreshed, either manually or by automatic data refresh.

### To stop publishing a view

1 From a view or chart that is currently being published, perform one of the following actions:

   - On the view toolbar, click the **Publish view images** button.
   
   - Right-click the view tab or the blank part of the toolbar and select **Publish view images**.

The JPEG and HTML files that were saved in a local directory are no longer updated.

### Printing view data

Use the following procedure to print all of the data currently displayed in a view, or selected rows of data in the view.

The view data is automatically formatted to fit the page size and print orientation of the selected printer.

#### To print the currently displayed data

1 From any view, perform one of the following actions:

   - On the view toolbar, click the **Print** button.

   - Right-click the view tab or the blank part of the view toolbar, and select **Print**.

2 From the Print dialog, select a printer and click **OK**.
Beginning with the first row that is currently displayed, a single page of data is sent to the printer. Using a smaller font size prints more data.

**To print selected rows of data**

1. From a tabular view, select the data rows that you want to print.

2. Either click the Print button on the view toolbar, or drag the selected rows to that button.

3. From the Print dialog, select a printer and click OK.

   All selected rows of data are sent to the printer, even if they span more than one page.

---

**Related Information**

- “Changing the font in a view” on page 108
- “Selecting multiple rows of data” on page 131

---

**Performing host actions from a view**

For a view that has resources on the MainView host, use the following procedures to perform host actions. You can perform line actions (for one or more resources) or primary actions (for the entire view of data).

---

**Tip**

You can terminate an action request at any time by clicking the **Terminate current request** button. MainView Explorer cancels any action requests that have not started. The status line shows how many requests were canceled.

---

**To perform a line action against a single resource**

1. Display the view from which the action is to be performed.

2. *(for tabular views only)* Locate the row of data that represents the resource on which you want to perform the action.

3. Right-click any field in the row of a tabular view, or any field in a detail view, and select **Line action**.

   A list of line actions for the resource as a whole is displayed. If no line actions are available, the **Line action** option will not be shown.
4 From the **Line action** menu, select an action.

The requested action is performed against the one resource that is represented by the row (in a tabular view) or the view (in a detail view).

**To perform a line action against multiple resources**

1 From a tabular view, select the data rows against which you want to perform an action.

2 Right-click any field and select **Line action**.

   If you right-click the key field for a view (generally the first column in a tabular view), a list of line actions for the resources is displayed.

   If you right-click any other field, and the **Line action** command is available, a list of line actions specific to that field is displayed.

3 From the **Line action** menu, select an action.

   The requested action is performed against the selected resources. When all of the line actions are complete, the view is refreshed. The status line shows how many action requests were processed.

**To perform a primary action against a view**

1 Display the view from which the action is to be performed.

2 Right-click a column header button (in a tabular view) or a field (in a detail view) and select **Primary action**.

   A list of primary actions for the view is displayed.

3 From the list of primary actions for the view, select an action.

   The primary action is performed immediately, unless the action name is followed by an ellipsis (such as, Add... ); selecting such an action displays a dialog in which you can overtype the value of one or more fields.

   If the action is successful, the view is refreshed. If the action is unsuccessful, a window containing MainView host messages is displayed. These messages are documented in the MainView windows-mode, online message system.

---

**Tip**

You can also use the **Command** line to perform primary actions.
Setting personal configurations

From the File menu, you can open, close, save, or delete a personal or site configuration. You can also set a default configuration, or import a 3270 screen definition to save as a configuration.

Configurations are particular arrangements of views and settings designed to meet personal or site requirements. For example, you can open several views (from one or more contexts or products), set one or more views in auto-refresh mode, and detach and arrange them with a certain size and location (along with any accompanying charts, detached or not). You can save your favorite configurations in a user library or a site library (SBBCDEF) to be used again and shared with other users. With the configuration feature, you can specify one or more complete configurations of system state.

From your saved configurations, you can specify the one that you want to open automatically when you start MainView Explorer. Because these configurations are saved in mainframe data sets, you can access them from any web-connected computer.

Opening a configuration

Use the following procedure to open a configuration.

1. From the File menu, select Open configuration.

2. Complete the Open configuration dialog:
   a. Set your library by selecting the site or user radio button.
   b. From the list of available configurations, select the one that you want and click Open.

The specified configuration is opened, and any currently open views that are not part of the configuration are closed.
Saving a configuration

Use the following procedure to save a configuration.

1. From the File menu, select Save configuration.

2. Complete the Save configuration dialog:
   
   a. Set your library by selecting the site or user radio button.
   
   b. From the list of available configurations, select one that you want to replace, or type the name of a new configuration in the File name field.
   
   c. (optional) In the Description field, enter a description that can help you distinguish this configuration from others.
   
   d. (optional) Select one or more of the following check boxes:

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set initial context to</td>
<td>Automatically sets the initial context to the one that is specified when you start a MainView Explorer session</td>
</tr>
<tr>
<td>Set as default configuration at start of session</td>
<td>Opens this configuration as the default whenever you start a MainView Explorer session</td>
</tr>
<tr>
<td>Replace member if it already exists</td>
<td>Replaces an existing configuration member</td>
</tr>
</tbody>
</table>

3. Click Save.

Working with configurations

Use the following procedures to set or clear the default configuration, or to delete any configuration.

To set a default configuration

1. From the File menu, select Set current configuration as default.
The current configuration becomes the default configuration that opens when you start a MainView Explorer session.

**To clear the default configuration**

1. From the **File** menu, select **Specify no default configuration**.

   The configuration that had been set as the default no longer opens when you start a MainView Explorer session.

**To delete a configuration**

1. From the **File** menu, select **Delete configuration**.

   2. Complete the Delete configuration dialog:
      
      a. Set your library by selecting the **site** or **user** radio button.
      
      b. From the list of available configurations, select the one you want and click **Delete**.

**Importing a screen**

Use the following procedure to import into MainView Explorer any 3270 screen definition that was created in windows mode.

1. From the **File** menu, select **Import screen (3270)**.

   2. Complete the Import screen (3270) dialog:
      
      a. Set your library by selecting the **site** or **user** radio button.
      
      b. From the list of available screen definitions, select the one that you want to import and click **Open**.

   MainView Explorer opens the screen as if it were a configuration file. You can tailor the display and save it as a configuration.

---

**Related Information**

- “Creating screens” on page 121
- “Saving a configuration” on page 144
Working with charts

Charts provide a graphical depiction of view data or the hierarchical relationships between objects. The default chart type depends on the view, but you can select other types. You can also customize a chart's font, background color, and displayed items.

Related Information

- "Types of charts" on page 146
- "Toolbar buttons for charts" on page 151
- "Opening a chart" on page 153
- "Changing the chart type" on page 154
- "Changing the items in a chart" on page 154
- "Changing the font and colors in a chart" on page 155
- "Changing the background of a chart" on page 157
- "Changing the type of gauge" on page 158
- "Rotating a 3D chart" on page 159
- "Navigating and arranging topology charts" on page 159
- "Copying a chart to the clipboard" on page 160
- "Saving a chart to a file" on page 161

Types of charts

You can display view data in various chart types. Charts depict the hierarchical relationships between objects and present data.

The following chart types are available:

- Two-dimensional line, area, column, and bar charts as shown in Figure 20 on page 147
- Three-dimensional line, area, column, and pie charts as shown in Figure 21 on page 148
Gauge charts as shown in Figure 23 on page 150

Topology charts as shown in Figure 24 on page 151

You can use the topology chart with any tabular view. Views that are good candidates for summarization (group by) are also good candidates for topology.

Figure 20: Two-dimensional bar chart example
Figure 21: Three-dimensional column chart example
Figure 22: Three-dimensional pie chart example
Figure 23: Gauge chart example
Figure 24: Topology chart example

![Topology chart example](image)

**Toolbar buttons for charts**

Each chart that is displayed in a view frame contains a row of buttons that perform functions on the currently displayed chart.

Figure 25: Sample toolbar for charts

![Sample toolbar for charts](image)

Some of the toolbar buttons for a chart perform the same function as they do for a view (as described in "Toolbar buttons for views"). You can place the mouse pointer over any button in the toolbar to display a brief description of that button. Table 14 on page 152 lists each chart icon and describes its function.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Icon](reset.png) | Reset | **On a topology chart**, centers the root node, resets the zoom to 100%, and resets the rotation to 0˚
**On a three-dimensional chart**, resets the rotation to 0˚ |
| ![Icon](stacked.png) | Stacked | Controls whether the data in two-dimensional bar and area charts is stacked or overlapping
By default, the data in two-dimensional bar and area charts is overlapping. |
| ![Icon](2d_bar.png) | 2D Bar | Changes the current chart to a two-dimensional, horizontal bar chart |
| ![Icon](2d_column.png) | 2D Column | Changes the current chart to a two-dimensional, vertical column chart |
| ![Icon](2d_area.png) | 2D Area | Changes the current chart to a two-dimensional area chart |
| ![Icon](2d_line.png) | 2D Line | Changes the current chart to a two-dimensional line chart |
| ![Icon](3d_column.png) | 3D Column | Changes the current chart to a three-dimensional, vertical column chart |
| ![Icon](3d_area.png) | 3D Area | Changes the current chart to a three-dimensional area chart |
| ![Icon](3d_line.png) | 3D Line | Changes the current chart to a three-dimensional line chart |
| ![Icon](3d_pie.png) | 3D Pie | Changes the current chart to a three-dimensional pie chart |
| ![Icon](gauge.png) | Gauge | Changes the current chart to a display of gauges |
| ![Icon](topology.png) | Topology | Changes the current chart to a topology chart |

**Related Information**

- “Toolbar buttons for views” on page 47
Opening a chart

Use the following procedures to open chart forms of a view. By default, a chart represents all of the resources in a tabular view. You can also open a chart of selected resources.

Note
You can change the number of rows included in the chart data with the slider tool. By default, the chart includes the rows visible in the view pane. With the slider tool, you can specify that 10 to 100 rows (data points) from the starting row displayed in the view pane be included in the chart. The slider appears on the status line of the chart just to the left of the row pointer.

To open a chart of the entire view

1. Perform one of the following actions:
   - On the view toolbar of a tabular view, click the Chart button or Topology button.
   - Right-click the view icon in the Product tree and select Open chart. The chart of the view data opens directly, without the accompanying tabular view. MainView retrieves view data from the host as if you had opened the view.

   The default chart type or the topology chart for the view is displayed in the view frame. The chart represents all of the resources in the view.

Note
The Chart button is not displayed on charts or any view that does not support charts (such as the Plex Map or Alerts view).

To open a chart of selected resources

Note
This procedure does not apply to topology charts. Topology charts always display all of the items in the view.

1. From a tabular view, select the data rows that you want to chart.

2. Either click the Chart button on the view toolbar, or drag the selected rows to that button.

   The default chart type for the view is displayed in the view frame. The chart represents only resources that you selected.
Changing the chart type

Use the following procedure to change the chart type without having to refresh the data.

To change the chart type

1. From any view or chart, perform one of the following actions:
   - On the toolbar, click the **Properties** button.
   - Right-click the view tab or the blank part of the toolbar, and select **Properties**.

2. From the Chart tab of the Properties dialog box, select a chart type by clicking the appropriate radio button.

   If the chart is open, the data is redisplayed with the newly selected chart type. The selected chart type remains in effect until you change it.

   If no chart is open, the selected chart type takes effect the next time that a chart is opened for that view. When you close the view, the chart reverts to its default.

   **Tip**
   Alternatively, you can change the chart type by clicking the appropriate button on the chart toolbar.

Related Information

- “Toolbar buttons for charts” on page 151

---

Changing the items in a chart

The host view definition defines the items that are displayed in a chart. However, you can use the following procedure to change the items that are displayed as the X-axis and Y-axis fields.

To change the items in a chart

1. From any view or chart, perform one of the following actions:
   - On the toolbar, click the **Properties** button.
   - Right-click the view tab or the blank part of the toolbar, and select **Properties**.
2 From the Items tab of the Properties dialog, select the items that you want to display in a chart by using the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set X-item</td>
<td>Sets an item from the upper list box as the X-axis data field for a graph.</td>
</tr>
<tr>
<td></td>
<td>The X-axis appears at the left or bottom of a graph. On a pie or gauge chart,</td>
</tr>
<tr>
<td></td>
<td>the X-axis value is used as a title.</td>
</tr>
<tr>
<td>Add Y-item</td>
<td>Sets up to eight items from the upper list box as Y-axis fields for a graph.</td>
</tr>
<tr>
<td></td>
<td>Each Y-axis value is plotted against the X-axis value. If a pie or gauge chart</td>
</tr>
<tr>
<td></td>
<td>is selected:</td>
</tr>
<tr>
<td></td>
<td>- Multiple Y-axis values are charted as segments of the pie or dials for the</td>
</tr>
<tr>
<td></td>
<td>gauge.</td>
</tr>
<tr>
<td></td>
<td>- The X-axis is used as a label.</td>
</tr>
<tr>
<td>Remove item</td>
<td>Removes an item from the lower list box, which is the list of currently</td>
</tr>
<tr>
<td></td>
<td>selected items.</td>
</tr>
</tbody>
</table>

### Changing the font and colors in a chart

Use the following procedures to change the fonts and colors for the current chart, or for all charts of the same type. You can make the changes temporary or permanent.

**To change the font in a chart**

1. From any chart, perform one of the following actions:
   - On the view toolbar, click the Properties button.
   - Right-click the view tab or the blank part of the view toolbar, and select Properties.

2. On the Font tab of the Properties dialog box, select a font from the Font list and a point size from the Point size list.

3. Click **Use this font for all type charts** to apply your changes to all views.
To change the colors in a chart

1. From any chart, perform one of the following actions:
   - On the view toolbar, click the Properties button.
   - Right-click the view tab or the blank part of the view toolbar, and select Properties.

2. On the Color tab of the Properties dialog box, scroll through the list and select the part of the view that you want to change.
   The current color for that part of the view is displayed in the color box to the right of the list.

3. Click a color from the palette, or click Custom and select a custom color.
   The selected color is displayed in the color box and in the view.

4. Repeat Step 2 on page 156 and Step 3 on page 156 to change other parts of the view.

5. Click Use these colors for all to apply your changes to all views.

Tip
If you later want to restore default colors, selecting Factory defaults for all restores MainView Explorer's original colors; selecting Default restores the colors that were last saved as the default (either user-defined or the original colors).
If you have saved color settings in a configuration and want to restore the originally distributed defaults, you must delete the configuration and save it again.

Related Information

- “Working with configurations” on page 144
Changing the background of a chart

Use the following procedures to change the gradient, contrast, or image used in chart backgrounds.

Changes to the gradient and contrast of a chart background apply to the current chart only. These changes are temporary. When you close the chart, the change is discarded.

When you specify a background image, the image applies to all charts. The image can be the default BMC image or an image that you import. The background image is persistent between sessions, but for your personal computer only. The background image overrides the color, gradient, and contrast settings for the background.

To change the gradient and contrast of a chart background

1. From any chart, perform one of the following actions:
   - On the view toolbar, click the Properties button.
   - Right-click the view tab or the blank part of the view toolbar, and select Properties.

2. On the Background tab of the Properties dialog box, select a gradient type and specify the amount of contrast that you want.

   The background is automatically changed.

To set a background image

1. From the Options menu, select Background image.

2. Select Default or Custom.

   Default displays the BMC image. Custom displays the graphic that you have imported.

3. From the Options menu, select Background image.

4. (optional) Select Apply to all charts.

   If you do not apply the image to all charts, the image is applied to the Plex displays only.

To adjust the opacity of the background image

1. From the Options menu, select Background image.
2 Select Image strength.

3 Select Full, Medium, or Light.

**To import a background image**

1 From the File menu, select Import background image from file.

2 Select a graphic file to import.

   Supported graphic files have the extension .jpg, .gif, or .png.

3 Click Open.

   You can import one graphic file only.

### Changing the type of gauge

Use the following procedure to change the type of gauge on a gauge chart.

The following gauge types are available:

<table>
<thead>
<tr>
<th>Full circle</th>
<th>Half circle</th>
<th>Histogram</th>
<th>Stoplight</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Con Time" /></td>
<td><img src="image2" alt="Con Time" /></td>
<td><img src="image3" alt="Con Time" /></td>
<td><img src="image4" alt="Con Time" /></td>
</tr>
</tbody>
</table>

**To change all gauges on a chart**

1 From a chart that displays gauges, perform one of the following actions:

   - On the toolbar, click the Properties button.
   - Right-click the view tab or the blank part of the toolbar, and select Properties.

2 On the Gauge tab of the Properties dialog, select the Full circle, Half circle, Histogram, or Stoplight radio button.
3  (optional) To display an indicator on circle gauges that shows where the highest defined threshold starts, select the **Display redline in circle gauges** check box.

**To change a single gauge**

1  Right-click the gauge and select **Gauge type**.

2  Select the gauge type that you prefer.

A chart can include any combination of gauge types. Your gauge selections remain in effect until you change them or close the chart.

**Rotating a 3D chart**

Use the following procedure to rotate a three-dimensional chart in order to see the data from a different angle.

1  In the bottom left corner of the chart view, click one of the directional rotation arrows.

   The chart rotates incrementally in the direction of the arrow that you clicked.

2  (optional) To rotate the chart continuously in the direction of the most recently selected rotation arrow, click the **Rotate** button.

   To stop continuous rotation, click the **Stop** button.

**Navigating and arranging topology charts**

Use the following procedure to navigate and arrange the topology on a topology chart.

1  Navigate and arrange topology charts by performing the following actions:

   ■  To move a chart around in the frame, click and drag the chart.

   ■  To change the size of the topology, use the Zoom slider and its controls.

   ![Zoom slider](image)

   ■  To rotate the nodes around the root of the topology, move the Rotate slider.

   ![Rotate slider](image)
To more clearly see a node and its children, click a node to move adjacent nodes aside. Click any node to reset the node’s position.

To collapse all of a node’s child nodes, click the collapse box (-) on the node. To expand all of a node’s child nodes, click the expand box (+).

To locate a node in the topology chart, type a full or partial string in the Find box and click the Find button. You can locate the next occurrence of a node with that string by clicking the Find button again.

To display the topology in a linear left-to-right arrangement, select the Linear check box. You can return to a radial layout by clearing the check box.

To center the root node, click the Reset button, reset the zoom to 100%, and reset the rotation to 0° on the topology.

To isolate a node and make it the new root, right-click a parent node (a node with child nodes) and select Make root. All other nodes disappear, and the requested node’s child nodes fan out around it.

To realign all nodes and expand all child nodes, right-click any node and select Restore all nodes.

To display the context-sensitive menu for the node, right-click the node.

To show a node’s tooltip, hover your cursor over the node. By default, the tooltip displays information from a node’s parents.

**Copying a chart to the clipboard**

Use the following procedure to copy a bitmap (.bmp) of a currently displayed chart to the clipboard. You can then paste the chart into a document.

**To copy a chart to the clipboard**

1. From an open chart, perform one of the following actions:

   - On the chart toolbar, click the Copy chart to clipboard button.
   - Right-click the chart tab or toolbar and select Copy chart to clipboard.
Saving a chart to a file

You can save a JPEG file (.jpg) of a chart in a local directory.

1. From an open chart, perform one of the following actions:
   - On the chart toolbar, click the **Save chart to file** button.
   - Right-click the chart tab or toolbar and select **Save chart to file**.

2. From the Choose a directory dialog, select a local directory in which you want to save the JPEG file and click the **Open** button.

3. With the directory open, click the **Save** button.

   The file name that is generated consists of the view name (unless you change it) and the extension .jpg.

Working with view containers

This topic explains how to work with contained views.

**Related Information**

- “Creating view containers” on page 163
- “Arranging views within a view container” on page 165
- “Detaching the view container for viewing in a separate window” on page 166
- “Removing views from a view container” on page 166
- “Refreshing data in a view container” on page 167
- “Selecting actions for views in a view container” on page 168
- “Starting cycling views and adjusting cycling intervals in view containers” on page 169
- “Exporting data from a view container” on page 170
- “Publishing a view container image” on page 170
- “Saving a view container in a configuration” on page 171
Overview of view containers

A view container is a method for displaying multiple views and charts in one tab in MainView Explorer. The view container is similar to a screen in windows mode.

You can open multiple view containers in separate tabs and add them to the stack of panes or detach them (just like regular views).

View containers have the following additional characteristics:

- By default, the views in a view container are tiled (automatically arranged and fully visible). However, if you prefer, you can cascade the views, or display them in free-form.

- When you add a view to a view container, charts travel with the associated view automatically.

- You can save view containers in a configuration, along with other views and charts (contained or not). If you export the configuration to the export/import directory, all views, charts, and view containers are also exported.

In addition to saving containers in a configuration, you can perform the following actions on view containers:

- Manually refresh all views (see Refreshing data in a view container on page 167)

- Set Auto-Refresh mode and the refresh interval for all views (see Refreshing data in a view container on page 167)

- Export all view data to the export/import directory for display in the MVE Viewer (see Exporting data from a view container on page 170)

- Cycle through the maximum view for each individual frame within the view container and regulate the amount of time each view is viewed in the cycle (see Starting cycling views and adjusting cycling intervals in view containers on page 169)

- Detach the container to display in a separate window (see Detaching the view container for viewing in a separate window on page 166)

- Re-attach all frames to move all views and charts from the container to individual tabs (see Removing views from a view container on page 166)

You can explicitly arrange multiple views (along with charts) within containers, set them all refreshing and publishing data, and then save this as a mainframe configuration in the site or user BBCDEF on the host. This provides you with the ability to reopen the configuration with the settings stored as saved.
You can also export the configuration to a shared network location, allowing users to open the configuration in the MVE Viewer.

**Note**
The File menu in MainView explorer includes an option to **Import Screen (3270)**. This option allows you to import previously saved screens from a Site or User BBSDEF on the host. When a 3270 screen is imported this way, MainView Explorer automatically builds a tiled container from the screen.

---

**Creating view containers**

Use the following procedures to create a standard view container, or to create a graphics-only view container (for displaying an array of charts from different views).

A MainView Explorer view container is similar to a screen definition in windows mode: a view container holds multiple views, charts, or both.

**To create a view container**

1. Either select **Create View Container** from the **File** menu or click in the main toolbar.

2. In the Create View Container dialog, enter a name for the container.

3. Add views to the container by using either of the following methods:

   - Right-click a view tab, select **Move to container**, and select the new view container as the destination for the move.

   - Click a view tab, drag it to the new view container’s tab, and drop it. (The cursor changes to a **Drop** cursor when on a view container tab. Dropping a view places it last in the container.)
You can drop a view anywhere within a detached view container window.

If a tabular view has a dependent chart, they are moved as a pair.

If you drop a tabular view without a chart and then open a chart for that view, the chart is positioned immediately after the view in the container.

A leading asterisk distinguishes imported views from regular views.

Any view or alternate form opened from a view in a view container also opens within that view container.

**Note**

To access toolbar tools or the Command line in a view container, right-click anywhere on a view and select from the pop-up menu.

4 When finished, save the configuration.

The view container remains as a view tab in the view frame until it is closed. If you want to retain the view container for future use, see topic on saving view containers in a configuration.

**To create a graphics-only view container**

1 Either select Create View Container from the File menu or click in the main toolbar.

2 In the Create View Container dialog, enter a name for the container.

3 Add charts to the container by completing the following actions:

   a In the product tree, right-click the view associated with the chart that you want, and select Open chart.

   b Right-click the chart that you want and select Open alternate chart.

   c To customize the chart, right-click its border, select Properties, and make the necessary changes.

   **Note**

   Clicking on data points in the chart might open the hyperlink and line actions menu, instead.

4 When finished, save the configuration.
The view container remains as a view tab in the view frame until you close it. If you want to retain the view container for future use, see topic on saving view containers in a configuration.

**Related Information**

- “Saving a view container in a configuration” on page 171

---

**Arranging views within a view container**

In a view container, you can arrange the views based on your preferences. You can resize views, move them within the container, and save the entire arrangement.

**To arrange views in a view container**

1. To change how the views are arranged, complete this step:
   - a. Right-click the view container tab and select *Arrange windows*.
   - b. Select *Tiled* (the default), *Cascade*, or *Freeform*.

2. Adjust the view frames, if needed:
   - For any view, you can resize the frame edges, location, or size.
   - To allow selection of more or fewer rows of data than are displayed in a tabular view, you can adjust the corresponding slider (applicable to all chart types except pie charts and gauges).
   - In a tiled arrangement, you can right-click inside the contained view and select *Move up* or *Move down* to reposition the frames (If the view has a dependent chart, the view and chart move together, as a pair)
   - If you use the *Freeform* arrangement, after adjusting the frames, you can click on the container tab to snap the edges of the frames together.

3. Save the view container.

   MainView Explorer preserves the relative bounds of the internal frames so that the configuration maintains this form.

**Related Information**

- “Saving a view container in a configuration” on page 171
Detaching the view container for viewing in a separate window

You can detach the view container from the stack of panes on the view frame to view the container in a separate window.

1 Right-click on the view container tab and select Detach this pane.

The view container detaches from the view frame and opens in a separate window.

---

Note

To reattach the view container's window to the view frame, from the window's toolbar click on the Re-attach this view container button.

---

Related Information

- “Detaching a view” on page 105

Removing views from a view container

Use the following procedures to remove a single view or all views from a view container.

To remove a single view from a view container

1 Right-click the view that you want to remove and select Re-attach this frame.

This view moves back to an individual tab. If the view has dependent charts, MainView removes the both the view and its charts. Similarly, if you select a chart for removal from the container, MainView also removes the chart's source view.

To remove all views from a view container

1 Perform one of the following actions:

- Right-click the view container tab and select Re-attach all frames. All views and charts move from the container to individual tabs.

- Right-click the view container tab, select Close all views, and close the view container.
You can close the view container at any time. When you close the view container, a dialog prompts you to select whether to close the container and all views or to close the container and attach the views to the stack of panes on the view frame.

**Refreshing data in a view container**

Use the following procedures to set the refresh for data views and charts in a view container.

You can set the Auto-Refresh of views and charts within the container at both the container or view level.

**To start auto-refreshing with the same interval for all views and charts in a view container**

1. Either right-click the view container tab and select **Auto-Refresh all**, or click the **Auto-Refresh** toolbar button.
   
   The toolbar button color changes from red (stopped) to green (active).

   **Note**
   
   **Auto-Refresh all** functions as a toggle. The default interval is 30 seconds.

2. (optional) To change the Auto-Refresh interval at the container level, perform the following actions:
   
   a. Right-click the view container tab and select **Set Auto-Refresh interval**.
      
      The Set Auto-Refresh interval dialog displays.
   
   b. From the dialog, set the interval from the drop-down box by selecting the interval rate you desire.
   
   c. When finished, click **OK**.

3. (optional) To change the Auto-Refresh interval at the view level, perform the following actions:
   
   a. Right-click on a view frame in the container and select **Properties**.
   
   b. From the Refresh tab, select the refresh interval from the drop-down box and then click **Start**.
To refresh data for all views and charts in a view container

1 Either right-click the view container tab and select Refresh data for all views, or click the Refresh toolbar button.

The data refreshes each time you perform this manual refresh.

To stop auto-refreshing

1 On the toolbar, click on the Auto-Refresh toolbar button.

The toolbar button color changes from green (active) to red (stopped).

Selecting actions for views in a view container

Use the following procedure to select from available actions for all views in a container or for each individual view.

1 Right-click as follows to access a menu of actions that you can perform:

   ■ For actions at the container level, right-click the container tab. For example, turning Auto-Refresh on or off for all views and publishing view data for all views in the container.

   ■ For actions at the column and view levels, right-click a view column header to see a menu of options.

   ■ For actions at the row and view levels, right-click a view row. (Selecting Properties from the row menu lets you change attributes of the view from the view properties dialog.)

Note

To preserve changes to view columns, hyperlinks, thresholds, or data formatting, you must save the changes in a customized view. The configuration of the view container does not save this type of view customization, but these changes to the view can be preserved in the view container provided that you save the view in a customized view.

Related Information

■ “Saving customized views (MainView Explorer)” on page 211
Starting cycling views and adjusting cycling intervals in view containers

You can cycle through the maximum view of each frame within a view container and control the amount of time of the cycling. Use the following procedure to start cycling views within a view container and adjust the cycling interval.

In addition to arranging the frames within the view container, you can view each frame at its maximum size and regulate the amount of time each frame is viewed. Instead of viewing all frames at once in the view container, each frame is viewed at its maximum size for a specific time interval. The views continue to cycle automatically, but you can stop the cycle at any time and move backward and forward in the order each frame is viewed.

To start cycling views within a view container

1. Right-click the view container tab and select Start cycling views or click on the Start cycling views button on the toolbar to toggle cycling views on.

   The view container displays views and charts maximized within the container. The default cycling interval is 15 seconds.

   **Tip**
   Clicking the Cycling views button stops the cycling and returns to the original container display. Clicking the Next maximized view or Previous maximized view arrow switches from automatic cycling to manual.

2. (optional) To change the cycling interval, right-click the container tab, select Set interval when cycling and click on the desired cycle time from the available options.

3. (optional) Use any of the following methods to manage cycling:

   - The center button functions as a toggle. Clicking on the button changes its color and switches the cycling mode so you can start/stop cycling and toggle between the maximum view of the individual frames and a view of all frames within the container.

   - Depending on the mode, the center button changes color and displays as either red (cycling stopped), green (cycling started) or yellow (manual cycling).
   
   To shift to the next or previous view in the container and switch to manual cycling, click the forward and back buttons on the toolbar.

   - When using manual cycling, clicking on the center button resets the view back to the container view which shows all frames within the container.
Exporting data from a view container

Use the following procedure to export data from all views in a view container.

1. Either right-click the view container tab and select **Export all views**, or click the **Export data to file** toolbar button.

A default file name is assigned to the exported data file. The file name syntax is `viewName_context`.

**Tip**

To be prompted for a different file name to use on the export/import directory, right-click on each view in the container and select **Export view data**. Once the export file names have been set, the views continue to export to those names even when export is turned off and back on at the container level. The chosen file names are stored with the container when it is saved in a configuration.

**Note**

**Export all views** functions as a toggle. You can use it to turn data export on and off for each view individually, or to maintain data export for the entire view container.

**Related Information**

- "Exporting view data on demand" on page 132

Publishing a view container image

Use the following procedure to publish view images or an entire view container image to be opened in a browser.

1. Either right-click the view container tab and select **Publish container image**, or click the **Publish view image** toolbar button.

2. From the Choose a directory to publish to dialog, select a local or network directory and click **Save**.

View and container images are saved as JPG images wrapped in HTML. This action does not export view data in `.1`, `.vdf`, or `.csv` files. Instead, publishing a view image creates an image to open in any browser that can reach the export/import directory, including a browser on a mobile device. If the publishing session is refreshing the published image, you can refresh the image in the browser to retrieve updates.
Saving a view container in a configuration

Use the following procedure to save a view container in a configuration.

To preserve a view container for reuse, it must be saved as a configuration. You can ensure preservation of the view container with each view arranged and displaying data as desired by using Mark for configuration to identify which views to save within the container.

When saving a configuration, the following conditions apply:

- Changes to a view’s columns, data formats, filters, or thresholds must be saved in a customized view in BBVDEF to be preserved. A saved configuration can include this customized view.
- View properties and chart properties are always saved with the configuration.
- View container properties (e.g. Auto-Refresh all) are always saved with the configuration.
- If the Include marked views only check box is selected, then all the desired views, charts, and containers must be marked for configuration to be included in the configuration.
- If the Include marked views only check box is cleared, then all open views, charts, and containers are included in the configuration, whether or not they are marked for configuration.

**Note**
MainView saves configurations in the User or Site BBCDEF.

**To save a container in a configuration**

1. Select tabs to include in the configuration by right-clicking each view or container tab and toggling on Mark for configuration.

   The name on the view tab is appended with an asterisk (*) when it has been marked for configuration.
Note
If you want to include all open views, charts, and containers in the configuration, don't mark any of them. Instead, skip to the following Step step on page 172 and clear the Include marked views only check box in the Save configuration dialog.

2 Click on File and select Save configuration.

The Save configuration dialog (similar to the following example) is displayed.

![Save configuration dialog](image)

3 Specify the settings that you want to use for the configuration:

a Enter a file name, and select the site or user library.

Tip
If you specify the site BBCDEF library, any user will be able to open the saved configuration.

b (optional) Enter a description of the configuration.

c (optional) Select or clear other options, as needed.

4 When finished, click Save.
Tip
The view container saves all settings of each view’s properties according to their settings. Any view that contains customized columns, data formats, thresholds, or filters must be saved first as a customized view in order to preserve those changes within the configuration.

You (or any user, if you saved in the site BBCDEF library) can now reopen the configuration. The saved configuration retains all container, view, and chart Properties as they were saved. If the configuration references a customized view, then that view opens as it was last saved in BBVDEF. Because the view definition resides in BBVDEF, the view can be customized without having to save a new copy of the configuration.

Related Information
- “Saving customized views (MainView Explorer)” on page 211

Controlling data views in windows mode

MainView products that operate in windows mode present their system performance information in a view.

You can request a view by entering the view name on the COMMAND line, or by selecting an option from a menu.
Related Information

- “MainView views and displays” on page 28
- “Forms and queries” on page 174
- “Changing the form of a view” on page 175
- “Locking and updating data in views” on page 176
- “Collapsing and expanding the fixed area of hybrid views” on page 176
- “Sorting view data (windows mode)” on page 177
- “Locating view data” on page 178
- “Refreshing view data (windows mode)” on page 179

Forms and queries

Every view comprises one query and one form. When you request a view, a query issues against the data that the MainView product collects.

A structured query extracts the data for the view and then processes the data through a form template that configures the appearance of the data in the view.

If you request multiple forms, MainView stacks them in the order requested. You can move forward or backward through the stack, return to a form, change formed data in a form, and end a query by using the commands described in Table 15 on page 174.

Tip

If you need more information about a command, enter HELP commandName on the COMMAND line (for example, HELP DATAR for information about the DATAR command).

Table 15: Commands for forms and queries in windows mode

<table>
<thead>
<tr>
<th>To perform this action</th>
<th>Use this command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle forward to the next form in the stack</td>
<td>FNEXt</td>
</tr>
<tr>
<td>Cycle back to the previous form in the stack</td>
<td>FPREV</td>
</tr>
</tbody>
</table>
### To perform this action

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return to the last form (or, if no more forms are in the stack, return to the original view)</td>
<td>END</td>
</tr>
<tr>
<td>Delete the current query and all of its forms, and return to the original view</td>
<td>ENDQuery</td>
</tr>
<tr>
<td>Change the elements of a form without refreshing data</td>
<td>PARm</td>
</tr>
<tr>
<td>This action displays only elements that meet the specified criteria <em>and</em> exceed what you consider to be a normal condition. For example, if a view shows a delay percentage, entering <code>PARM * 5</code> shows all delays greater than 5% (qualifier for positional parameters). <strong>Note:</strong> For more information about parameters for this view, see the online Help.</td>
<td></td>
</tr>
<tr>
<td>Change the elements of a form and refresh data</td>
<td>QPARm</td>
</tr>
<tr>
<td>This view displays only elements that exceed a normal condition, as shown for the PARM command, and presents new data that meets parameter criteria.</td>
<td></td>
</tr>
<tr>
<td>Display a list of the filters that are currently in effect for both the query and the form</td>
<td>SHOWFilt</td>
</tr>
<tr>
<td>Determining what filters are in effect is helpful if you entered several FORM and QPARm commands but all data is filtered out (that is, no data is displayed).</td>
<td></td>
</tr>
<tr>
<td>Refresh query data</td>
<td>DATAR</td>
</tr>
<tr>
<td>The underlying data is updated (even if the view is locked), and all subsequent forms reflect the new data.</td>
<td></td>
</tr>
</tbody>
</table>

## Changing the form of a view

Use the following procedure to change the form of a view without refreshing the data.

You can refresh the data in a view by pressing **Enter**. Alternatively, the FORM command lets you change the data’s form without refreshing the data itself.

For example, you can use FORM when you notice a potential problem in a summary view and want to check for information in a detail view without refreshing the data. You can do this yourself by following the instructions in the Tip.
Tip
To find out what alternate forms are available for a view, place your cursor on the view name in the window information line and press the Help (PF1) key; then, scroll down to the Help topic "Forms that are valid for this view".

**To change the form of a view**

1. On the COMMAND line, enter the following command:

   `FORM formName . . .`

   In the syntax, `formName` is the view form that you want to use.

**Locking and updating data in views**

In a view, the data refreshes when you press Enter. Use the following procedure to lock the view and prevent the data from being refreshed.

Locking a view enables you to look for trends by comparing data locked in a view against current, real-time data in another window of the same, unlocked view. MainView indicates a locked view by displaying `L` in the window information line at the top of the display.

**To lock the current view of data**

1. In the view that you want to lock, enter LOCK on the COMMAND line.

   Tip
   You can use the DATAR command to temporarily override the LOCK command for a view and refresh the view's data. Using the UNLOCK command removes the lock.

**Collapsing and expanding the fixed area of hybrid views**

To display more information in a hybrid view, you can scroll vertically or horizontally in the bottom portion of the view. Use the following procedures to collapse or expand the view's fixed (top) portion to accommodate scrolling in the bottom portion.
To collapse the fixed portion of a hybrid view

1 Perform one of the following actions:

- Type EXC FIXED on the COMMAND line.
- At the top-left corner of the view’s fixed portion, place the cursor on the plus sign (+) and type a minus sign (−).

To expand the fixed portion of a hybrid view

1 Perform one of the following actions:

- Type INC FIXED on the COMMAND line.
- At the top-left corner of the view’s fixed portion, place the cursor on the minus sign (−) and type +.

Sorting view data (windows mode)

In tabular and summary views, use the following procedure to sort data numerically or alphabetically, and in ascending or descending order.

By default, numeric data is sorted in descending order (high to low), and alphabetic data is sorted in ascending order (A to Z).

To sort data in a view

1 Enter the SOrt command or the Order command, using any of the following methods:

- Type the command on the COMMAND line, move your cursor to the column that contains the elements that you want to sort, and press Enter.

  Entering the command without parameters sorts numeric elements in descending order by default, and alphabetic elements in ascending order by default.

- Type the command on the COMMAND line with A for ascending order or D for descending order. Then, move your cursor to the column to be sorted and press Enter.
Type the command with the element name as a parameter on the COMMAND line:

\[\text{SORT}[\text{columnName}.A | \text{columnName}.D][A | D]\]

\textit{columnName} is the internal name of the column to be sorted. To identify the internal name of a column, move your cursor to the column label and press the \textbf{Help (PF1)} key. When you use an internal name instead of selecting a column with your cursor, you must insert a period (.) between the name and the A or D parameter.

---

\textbf{Example}

To order elements by their defaults, type \textbf{SORT} on the COMMAND line, move your cursor to the label of the column that you want to sort, and press \textbf{Enter}.

To use the \textbf{Order} command with a parameter, type \textbf{Order D} on the COMMAND line, move your cursor to the label of the column that you want to arrange in descending order, and press \textbf{Enter}.

---

\textbf{Note}

- To sort the data in a view by more than one element, you must customize the view, as described in "Customizing data display in windows mode."

- If an element has been defined with a summarization type of COUNTIF, you cannot use that element as the basis for sorting view data. The reason for this limitation is that multiple COUNTIF conditions can be defined for a single element, but the same element name is used in all cases. If you select an element with a summarization type of COUNTIF, the message \textit{INVALID SORT FIELD} appears in the ISPF short message area.

---

\textbf{Related Information}

- "Customizing data display in windows mode" on page 214

---

**Locating view data**

Use the following procedure to find specific data in a view by using the Locate command.

The Locate command searches view data until it finds the alphanumeric character string that you specified. That data is then displayed as the first row of the view. You can use the \textbf{RFind} command to find the next occurrence of your request.
To find specific data in a view

1. On the COMMAND line, type the following statement:

   \texttt{L \textit{string} [FIRST | LAST | PREV | NEXT]}

   Replace \textit{string} with the character string that you want to find. Choose FIRST, LAST, PREV, or NEXT to indicate which occurrence of the string you want to find. (For example, FIRST finds the first occurrence, and PREV finds the previous occurrence.)

\underline{Note}

In the \textit{string} value, you can use the wildcard * to represent any number of characters, and ? or + to represent a single character.

2. Place your cursor on the column that you want to search (if other than the first column, which is the default), and press \texttt{Enter}.

Refreshing view data (windows mode)

Use the following procedures to automatically refresh the data in one or more views.

To refresh the data for all views in unlocked windows

1. On the COMMAND line, enter the following statement:

   \texttt{ASU[nnn]}

   Replace \textit{nnn} with the refresh rate that you want to use, in number of seconds (from 3 to 999, unless your site defines other values).

\underline{Example}

If you specify \textit{nnn}, that value temporarily overrides the default refresh rate defined in your MainView profile. The following command requests automatic screen update (ASU) mode every 30 seconds:

\texttt{ASU 30}

For more information about this command, enter \texttt{HELP ASU} on the COMMAND line.

\underline{Note}

You can also refresh data for several views in a timed cycle.
To cancel the automatic refresh use either of the following methods:

- For SNA terminals, use the **ATTN** key.
- For non-SNA terminals, use the **PA1** key.

**Note**

On some keyboards, you must press the **RESET** key to unlock the attention interrupt key. IBM defines the attention interrupt procedure, and MainView uses the keys assigned by that procedure. TSO also uses those keys.

**Related Information**

- “Maximizing a window” on page 119

## Displaying data from multiple systems

From a single MainView terminal session, you can control local and remote systems and access different products on those systems. You can also compare and contrast data from different time periods, all from the same display, and all at the same time.

All MainView products that use windows mode provide access to the Plex Manager common service utility. With Plex Manager, you can:

- Define, administer, and access local and cross-system communications between MainView products in your sysplex or multisystem environment
- See multiple MainView products running across several system images in a single view, and work with the information in a single system image (SSI) context

**Note**

You can name any combination of targets as an SSI context, or use the predefined SSI context **ALL**.

- See data provided by a single MainView product running in one or more systems, and work with the information as a single entity, called a **target context**

## Displaying target systems

Use the following procedure within Plex Manager to display different target systems in your view.
Tip

The fastest way to access Plex Manager is to use the CONtext command.

To access Plex manager

1. Perform one of the following actions:

   - From the MainView Selection menu, select the Plex Manager common service utility.
   - To display specific target data within an SSI context, enter the SCOpe command on the command line.
   - To display a particular target system, enter the CONtext command on the command line.

   CONtext provides access to:

   - Multiple occurrences of a product that is monitoring an SSI context
   - A product monitoring a target
   - The same product monitoring a different target
   - A different product monitoring the same target
   - A different product monitoring a different target

   - As an alternative to the CONtext command, you can use the SET or SETD command. These commands display a dialog where you can change products, contexts, and targets by changing field values in the dialog as shown in the following figure:

     ![SET WINDOW CONTEXT, PRODUCT, SERVER, SCOPE AND VIEW](image)

     SETD changes the default settings of new windows but does not affect the context of the current window. SET is similar to the CONtext and SCOpe commands; it changes what is displayed in the current window.

     For more information about CONtext and SCOpe, enter `HELP CON` or `HELP SCO` on the `COMMAND` line.
To display target systems

This procedure shows a common example of how to access target systems.

1 On the COMMAND line, enter the following statement:

**CON * PLEXMGR**

The * represents the default target system where Plex Manager is running. This command displays the Plex Manager EZPLEX Easy menu:

```
>W1 =EZPLEX============SJSEC610=*========ddmmmyyyy==hh:mm:ss====PLEXMGR==D====1
```

EZPLEX is a good starting point for using Plex Manager. EZPLEX provides a function-oriented, hierarchical menu of Plex Manager services. EZPLEX helps you accomplish the following tasks:

- Access information that is common to all MainView products
- Access MainView Logger definitions, log files, and logged messages
- Define security and perform other general Plex Manager functions

From the EZPLEX Easy menu, you can access the major categories of Plex Manager views.

2 Place the cursor on **Sum by System/Prod** and press Enter.
The PLEXOVER view is displayed:

```
W1 =PLEXOVER=========SYSB=====*=======ddmmmyyyy==15:46:13====PLEXMGR==D====8
```

PLEXOVER summarizes the status of local and remote MainView products and lets you select active products. When more than one copy of a MainView product runs on a single system, PLEXOVER summarizes the status of all copies in one row.

3. Enter the following command to list all available systems and products:

```
CON * PLEXMGR;PLEX
```

The * represents the default target system where Plex Manager is running. This command displays the PLEX view:

```
>W1 =PLEX==============MVSA=====*========ddmmmyyyy==hh:mm:ss====PLEXMGR==D===19
```

You can use the PLEX view to verify that a product or system is available before you try to request a product view. Variations of the PLEX view are as follows:

<table>
<thead>
<tr>
<th>PLEX variations</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLEXAREA</td>
<td>A summary view grouped by area that shows the total number of MainView products that are defined for each area</td>
</tr>
</tbody>
</table>
### Displaying data from multiple systems

<table>
<thead>
<tr>
<th>PLEX variations</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLEXPROD</td>
<td>A summary view grouped by area that shows the number of instances of a particular product on any connected system</td>
</tr>
</tbody>
</table>

**Note**
You can select an active product from any of the PLEX views (PLEX, PLEXOVER, PLEXAREA, or PLEXPROD). Place your cursor on the product that you want and press **Enter** to display the Easy menu (or MAIN view) for that product.

---

### Displaying SSI context views in Plex Manager

Plex Manager provides views that show active targets in each SSI context. For MainView products that are defined within an SSI context, you can use these views to determine the status of the targets that those products are monitoring.

Table 16 on page 184 identifies and describes the views that are available in Plex Manager.

#### Table 16: SSI context views

<table>
<thead>
<tr>
<th>Views</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONACTZ</td>
<td>Summarizes all SSI contexts known to Plex Manager, and shows the target status of each product by number of targets and number active</td>
</tr>
<tr>
<td>CONACTP</td>
<td>Summarizes all SSI contexts known to Plex Manager, and shows the overall status of each product or group of products of the same type</td>
</tr>
<tr>
<td>CONACT</td>
<td>Lists all SSI contexts known to Plex Manager, showing the name of the SSI context, the targets in that context, and the target status</td>
</tr>
<tr>
<td>CONACTD</td>
<td>Displays the status of a single MainView product that is monitoring a target in an SSI context known to Plex Manager</td>
</tr>
</tbody>
</table>

**Note**
You can select another SSI context view, CONASEL, as a context hyperlink from a MainView product's Easy menu. CONASEL provides the same function as CONACTZ but for a specific MainView product instead of Plex Manager. CONASEL summarizes all SSI contexts known to that product.
Displaying CONACTZ

CONACTZ lists all SSI contexts known to the current Plex Manager and shows the SSI context status summary for all targets. Use the following procedure to view CONACTZ.

1 Perform one of the following actions:

   ■ From the Plex Manager EZPLEX menu, select **Sum by Context** under **SSI Context Activity**.

   ■ On the COMMAND line, enter either **CONACTZ** if using Plex Manager, or **CON * PLEXMGR;CONACTZ** if not using Plex Manager.

      The asterisk (*) represents the default target system where Plex Manager is running.

The CONACTZ view displays the following counts:

■ Number of products by product type

■ Number of products that are active within each product group

2 (optional) If you want to obtain specific status information for a product group that is defined to a context, place your cursor on that product group in the **SSI Context** column and press **Enter**.

The CONACT view for that context is displayed.

Displaying CONACT

CONACT shows the status of SSI context targets that are being monitored by MainView products. Use the following procedure to view CONACT.

1 Perform one of the following actions:

   ■ In the Plex Manager CONACTZ view, select a product from the **SSI Context** column and press **Enter**.

   ■ From the Plex Manager EZPLEX menu, select **SSI Context Activity**.

   ■ On the COMMAND line, enter either **CONACT** if using Plex Manager, or **CON * PLEXMGR;CONACT** if not using Plex Manager.

      The asterisk (*) represents the default target system where Plex Manager is running.
2  *(optional)* For more information about an SSI context, select a name in the **SSI Context** column and press **Enter**.

The CONACTD view for that context is displayed.

**Displaying CONACTD**

CONACTD shows the SSI context status for a single target. Use the following procedure to detail all activity for a specific product that is monitoring a single target in an SSI context.

1  From the SSI Context column in the Plex Manager CONACTZ or CONACT view, select a product with your cursor and press **Enter**.
Customizing views

This chapter explains how to customize the display of data in MainView Explorer and in windows mode.

Customizing data display in MainView Explorer

Mainview’s customization settings let you customize the way your data appears in views (for example, by adjusting the precision of numerical data). This topic provides procedures for completing a variety of customizations.

With view customization, you can change a distributed view and save the changes as needed. Customized views are displayed in the Product tree, in either the Cust User folder or the Cust Site folder.

You can customize views at the column or field level. For example, you can right-click a column header button (in tabular views) or a field (in detail views) and choose options such as editing the current filter, duplicating the field, or excluding the field. You can also customize how columns and fields are displayed, how data is displayed in columns and fields, what data is included in columns and fields, and where hyperlinks go to.
Changing column headers and field names

Use the following procedure to change column headers and field names.

1. Right-click the header name or field name and select **Format data** from the pop-up menu.
2 In the Format dialog, enter a new name in the **Header 1** and **Header 2** fields.

You can use up to two lines to name the column header. The name can be entered in the top line (**Header 1**) or bottom line (**Header 2**). You can use both lines based on your preferences and needs. For example, you could name the header Pending Jobs and have it appear on the top line or you can have Pending on the top line and Jobs on the bottom line.

---

**Note**

If you enter a name that is longer than the value defined in the **Width** field, the name is truncated when displayed in the view.

---

**Tip**

Use curly braces ({}) to indicate that a numeric heading should include periods between the numbers in order to fill the column. This convention is commonly used for repeated fields that show numeric data graphically. For example, enter `0{100}` if you want the column header to display `0........100`.

---

3 *(optional)* Click **Apply** to view the changes to the field without exiting the dialog.

4 When finished, click **OK**.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

---

**Related Information**

- ”Saving customized views (MainView Explorer)” on page 211

---

**Adjusting the precision of numeric data**

Use the following procedure to adjust the precision of numeric data in a column or field.

1 Right-click the column’s header or the field and choose **Format data** from the pop-up menu.

2 In the **Precision** field of the Format dialog, specify the precision that you want.

Use the **Precision** field to specify the:

- Number of decimal places to display for numeric data
Number of significant digits to display for hexadecimal data

**Note**
This value is ignored for fields that display other data types.

The number of decimal places that are displayed for numeric data is affected by the value in the **Width** field. A decimal value is rounded to accommodate the width of a field. Insignificant decimal values are truncated to show as much useful data as possible.

**Example**
In a numeric field that has a **Width** value of six spaces and a **Precision** value of five digits, the following example shows how numbers would be formatted:

<table>
<thead>
<tr>
<th>Number</th>
<th>Format</th>
<th>Value note</th>
</tr>
</thead>
<tbody>
<tr>
<td>123.45</td>
<td>123.45</td>
<td></td>
</tr>
<tr>
<td>.123456</td>
<td>.12346</td>
<td>(value is rounded)</td>
</tr>
<tr>
<td>12345.6</td>
<td>12345.</td>
<td>(value is truncated)</td>
</tr>
<tr>
<td>123456.1</td>
<td>123456.</td>
<td>(value is truncated)</td>
</tr>
<tr>
<td>1234567.</td>
<td>#######</td>
<td>(value is too big for the width)</td>
</tr>
</tbody>
</table>

3 (optional) Click **Apply** to view the changes to the field without exiting the dialog.

4 When finished, click **OK**.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

**Related Information**

- “Saving customized views (MainView Explorer)” on page 211

---

**Showing zero**

Use the following procedure to specify whether a zero in a numeric column or field should be displayed as 0 or as a blank space.

1 Right-click the column’s header or the field and select **Format data** from the pop-up menu.
2 Select the **Show Zero** check box.

In the field, the data view changes to show zero instead of a blank space. You can select and clear the show zero check box to toggle between views and determine which view you prefer.

3 When finished, click **OK**.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

### Related Information

- “Saving customized views (MainView Explorer)” on page 211

---

### Specifying a display mode

Use the following procedure to specify the display mode for a column or field.

1 Right-click the column’s header or the field and choose **Format data** from the pop-up menu.

2 In the Format dialog, select a display mode by selecting the appropriate radio button:

<table>
<thead>
<tr>
<th>Radio button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>as is</td>
<td>Displays data in the format indicated by its data type</td>
</tr>
</tbody>
</table>
| as graph     | *(numeric data types only)* Displays the data as a bar graph  
For this display mode, you can specify a **Graph upper limit** value. The upper limit determines the range of the bar graph for a field.  
**Note:** This field also sets the upper limit for all gauge charts. |
| as hex       | Displays the data in hexadecimal format  
Any data type can be displayed in hexadecimal; however, any field that has a default format of hexadecimal cannot be changed to another data format. |
After you make your selection, the data view in the field changes to the new view. You can select and clear the radio buttons to toggle between views to determine which view you prefer.

Tip

You might need to adjust the Width value to allow room in your view for bar graph data or hexadecimal data.

3 When finished, click OK.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

Related Information

■ “Saving customized views (MainView Explorer)” on page 211

Specifying a summarization type

Use the following procedure to specify how data in a field is formatted in a summary view.

A summary view is one in which at least one column has been added to the Groupby list, as described in "Adding fields to the Groupby list".

Note

The Summarization type setting is ignored if the view is not a summary view.

To specify a summarization type

1 Right-click the column’s header or the field and choose Format data from the pop-up menu.

2 In the Format dialog, use the Summarization type radio buttons to specify a format type.

The following table lists the summarization types and describes their calculations:

<table>
<thead>
<tr>
<th>Character</th>
<th>Calculation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Average</td>
<td>Average adds every value in a summarized numeric data field and shows the average.</td>
</tr>
<tr>
<td>Character</td>
<td>Calculation</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>S</td>
<td>Sum</td>
<td>Sum adds every value in a summarized numeric data field and shows the total.</td>
</tr>
<tr>
<td>M</td>
<td>Minimum</td>
<td>Minimum shows the smallest value in a summarized numeric or character data field.</td>
</tr>
<tr>
<td>X</td>
<td>Maximum</td>
<td>Maximum shows the largest value in a summarized numeric or character data field.</td>
</tr>
<tr>
<td>C</td>
<td>Count</td>
<td>Count counts the occurrences of a grouped value, which is either character or numeric, within a summarized data field.</td>
</tr>
</tbody>
</table>
| L         | Any         | Any summarizes on any characters in common. This summarization displays identical characters or numbers that repeat in the field data and indicates all other characters with an *.  
**Example**: In a summarized view of a list of jobs, you might have a row of data for PR**** jobs and another one for P***** jobs (jobs that start with P, but not with PR). |
| P         | Percentage  | Percent adds the values in a summarized numeric field and shows the total as a percentage in relation to the total of all values for all data fields. |

After you make your selection, the data view in the field changes to the new view. You can select and clear the radio buttons to toggle between views and determine which one you prefer.

When **Summarization type** is set to **count**, you can optionally specify a condition in the **Condition** field; use this field to count only rows that meet the specified condition, or to exclude certain rows from summarization (such as any fields having a zero value).

A condition might be regarded as:

- A relational operator (>, >=, <, <=, or =) and a value
- A range that uses the BETWEEN operator and a value  
  The format of the BETWEEN operator is \texttt{<value1, value2>}.  

The rules for the value must conform to the following guidelines:

- The value can be numeric or alphanumeric.
The value can use the * and ? wildcard characters. The * indicates one or more characters, and ? indicates a single character. The * can be used alone and is the default.

The value cannot be the column ID of another field.

Example

To define a condition of any value in the current field, specify *=.

To define a condition of all values exceeding 25 in the current field, specify >25.

To define a condition that is a range of values for the current field that are greater than or equal to the low value (5) and are less than or equal to the high value (25), specify >=[5,25]. (This example illustrates the BETWEEN operator.)

3 When finished, click OK.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

Related Information

- “Adding fields to the Groupby list” on page 206
- “Saving customized views (MainView Explorer)” on page 211

Specifying thresholds

Use the following procedures to assign thresholds to data fields, and to set alarms or visual changes to indicate that a field’s threshold has been met.

To add or change thresholds for data fields

1 Right-click the relevant column header (in tabular views) or field (in detail views) and select Edit thresholds.

   The Threshold dialog shows the column or field's currently assigned thresholds (if any).

2 Add a new threshold condition:
   a Click the Insert button.
The new threshold will be inserted after the currently selected row, or in the first row if no row is selected.

b Either copy threshold settings from another field by clicking the **Inherit from** check box and selecting that field, or select **Condition** and create a new condition.

c *(optional)* Use the **Attr** field to assign a color to a condition by specifying a numeric value from the list.

**Note**
To change colors globally, use the **Colors** tab of the Properties dialog box.

d *(optional)* Specify an output character or character string that you want to substitute for field values that meet the specified threshold condition.

For example, you might want the word CRITICAL to appear instead of actual data when the threshold condition is met.

3 *(optional)* Use the **Move up** and **Move down** buttons to rearrange the positions of the thresholds, or the **Remove** button to delete thresholds that you no longer need.

Thresholds are evaluated in the order in which they appear.

When you save your customized view, you can specify a location where you want your threshold conditions to be saved. The threshold can then be available to all instances of the same element in other views, or only for the view where the threshold is defined.

4 *(optional)* Click **Apply** to view the changes to the field without exiting the dialog.

5 When finished, click **OK**.

**To set an alarm for thresholds**

1 On the view toolbar, click the **Properties** button.

2 In the Properties dialog, click the **Refresh** tab.

3 Set a refresh rate and start automatic refresh.

4 Select **Sound alarm if highest threshold met**.

5 Select an alarm sound by using one of the following methods:
   - Select **Use custom sound** (see “To import a custom sound” on page 196”).
Choose a sound from the **Alarm sound list** field.

An alarm is set for all thresholds that are associated with this view.

**To import a custom sound**

*Note*
You can import one sound file only.

1. From the **File** menu, select **Import custom sound from file**.
2. Select a sound file to import.
   *Note*
   Supported sound files have the extension .wav, .au, or .midi.
3. Click **Open**.

The sound file is imported and saved in the alarm sound list.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

**Related Information**

- “Specifying a condition” on page 206
- “Refreshing view data (MainView Explorer)” on page 128
- “Saving customized views (MainView Explorer)” on page 211

**Customizing hyperlinks**

A hyperlink is one or more commands that are associated with a particular field and the conditions under which those commands are issued. When you activate a hyperlink, the underlying command is issued against the resource where the cursor is positioned.

Any number of fields in a view can be defined with hyperlinks. Any number of hyperlinks can be defined per field.
You can customize different commands to be issued under varying data conditions that occur in a field. That is, a hyperlink's action can vary, depending on the resource's state. When a hyperlink is activated, the conditions are evaluated from top to bottom, and the command that is associated with the first true condition is issued.

**Creating hyperlinks**

Use the following procedures to create, change, or delete hyperlinks.

A hyperlink usually connects a field in a source view (the view where the hyperlink is activated) to a target view (the view that is displayed after the hyperlink is activated). Both the source view and the target view commonly share similar types of information, such as job name or service class. In the views that are distributed with your product, hyperlink fields are defined to display more detailed information or to filter the data in the existing view.

**To create a new hyperlink**

1. Right-click a column header button (in tabular views) or a field (in detail views) and select **Edit hyperlinks** from the pop-up menu.

2. From the Hyperlink dialog, complete the following steps to create a new hyperlink:
   a. Click the **Insert** button.
      The new hyperlink will be inserted after the currently selected row, or in the first row if no row is selected.
   b. Specify the condition and a hyperlink command.
      You can customize different commands to be issued under varying data conditions occurring in a field. Depending on the state of a resource, the action that is taken could be different.

   **Note**
   When you establish a hyperlink between views, you can pass a keyword parameter from the source view to the target view. This parameter acts as a filter for the data that is displayed in the target view.

3. *(optional)* Use the **Move up** and **Move down** buttons to rearrange the positions of the hyperlinks.

   When a hyperlink is activated, the conditions are evaluated from top to bottom, and the action that is associated with the first true condition is executed.
4 When finished, click OK.

**To edit an existing hyperlink**

1 Right-click a column header button (in tabular views) or a field (in detail views) and select Edit hyperlinks from the pop-up menu.

2 From the Hyperlink dialog, select the hyperlink that you want to change, and enter the new condition and hyperlink command.

3 When finished, click OK.

**To delete a hyperlink**

1 Right-click a column header button (in tabular views) or a field (in detail views) and select Edit hyperlinks from the pop-up menu.

2 From the Hyperlink dialog, select the hyperlink that you want to delete, and click Remove.

3 When finished, click OK.

The view is now customized. When you close the view, MainView will prompt you to save your changes. If you decline, the customizations will not be retained.

**Related Information**

- “Saving customized views (MainView Explorer)” on page 211

**Guidelines for creating hyperlink commands**

A hyperlink command can consist of a view name, actions, or an EXPAND command.

Specifically, a hyperlink command can be:

- A view name with optional keyword parameters
- A valid action, or multiple actions separated by semicolons
- The EXPAND command for a summarized field

Before you can pass parameters from a source view to a target view, you must:
Determine the element value that you want to pass from the source view

Ensure that the target view contains an element of similar data (for example, job name)

Ensure that the element to be passed is defined as a parameter to the target view

**Example**

- To display JDELAY when a hyperlink is activated, specify JDELAY for the hyperlink command.

- To pass the parameter ASGNAME to column A of the JDELAY view, specify JDELAY ASGNAME(A).

- To display the JOVER form of JDELAY and pass the parameter ASGASCT to column Q, specify FORM JOVER ASGASCT(Q).

- To display the JOVER form of JDELAY, pass the parameter ASGASCT to column Q, and then sort the data in column C in ascending order, specify FORM JOVER ASGASCT(Q);SO C.A.

**Related Information**

- “Sorting view data (MainView Explorer)” on page 129

**Setting keyword parameters in a hyperlink**

Use the following procedure to set a keyword parameter in a hyperlink.

A keyword parameter consists of the element name of a field followed by a value in parentheses. Any value other than a column ID can be placed in single quotation marks.

Typically, you would pass the key field from the source view to the target view, as this field usually identifies a resource uniquely.

**Before you begin**

If the field that you want to pass is not defined as a keyword parameter, use the Edit Filter option to make it a keyword parameter.
To set a keyword parameter in a hyperlink

1. Right-click a column header button (in tabular views) or a field (in detail views) and select Edit hyperlinks from the pop-up menu.

2. In the **Condition** field of the Hyperlink dialog, specify the condition that must be met before the hyperlink command is issued.

3. In the **Hyperlink** field, specify the target view, the element name of the field in the target view, and the column ID of the field in the source view.

**Note**
Columns and fields have internal IDs assigned to them. To determine the ID of a column or field, move your cursor over the column or field; you should see the ID displayed in the status line at the bottom left of the MainView Explorer console.

**Example**
Assume that your source view is JFLOW. The command \texttt{JDELAY ASGNAME(A)} indicates that the information from column A in JFLOW is sent to the ASGNAME column in JDELAY.

4. To save your new hyperlink, use the **Save customized view** option.

Filtering data in a view in MainView Explorer

In a tabular view, you can use filters to display only the data that meets your criteria.

For example, in a view of job data, you might want to display only those jobs that have names beginning with CICS, that have a status of INACTIVE, or both.

To see the current filters for a view, right-click the view tab or the blank part of the view toolbar and select **Show header info => Show form filters**.

You can filter the data in a view in the following ways:

- Using filter masks
- Setting filter properties
- Setting WHERE or QWHERE properties
- Editing a column filter
Related Information

- "Filtering data by using filter masks (MainView Explorer)" on page 201
- "Filtering data by setting filter properties (MainView Explorer)" on page 203
- "Filtering data by using QWHERE or WHERE (MainView Explorer)" on page 204
- "Filtering data by editing a column filter (MainView Explorer)" on page 205

Filtering data by using filter masks (MainView Explorer)

You can use filter masks to enter a filter for every column in a view.

By clicking the Filter mask button, you can toggle the filter mask line on and off.

Filtering data using filter masks is temporary: closing the view discards the filters. Also, keep in mind that the current data is only filtered; no data is updated.

The following graphic is an example of the filter mask line toggled on:

<table>
<thead>
<tr>
<th>Jobname</th>
<th>JES Job Number</th>
<th>T</th>
<th>SrvClass</th>
<th>Step Data</th>
<th>MBO</th>
<th>Total Dly%</th>
<th>Total Use%</th>
<th>%Dly Idle</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCVSSWBC</td>
<td>STC07053</td>
<td>S</td>
<td>STCNRM</td>
<td>NO</td>
<td>No</td>
<td>2.38</td>
<td>97.62</td>
<td>&gt;90</td>
<td></td>
</tr>
<tr>
<td>BCVSS61W</td>
<td>STC07445</td>
<td>S</td>
<td>STCNRM</td>
<td>NO</td>
<td>No</td>
<td>2.38</td>
<td>97.62</td>
<td>&gt;90</td>
<td></td>
</tr>
<tr>
<td>BCVDCASC</td>
<td>STC03248</td>
<td>S</td>
<td>STCNRM</td>
<td>NO</td>
<td>No</td>
<td>2.38</td>
<td>97.62</td>
<td>&gt;90</td>
<td></td>
</tr>
</tbody>
</table>

Working with the filter mask line (Mainview Explorer)

Use the following procedures to display, hide, and change filter masks.

**Before you begin**

Observe the following rules for entering conditions for filter masks:

- Use these rules when entering a filter condition for a character-based column:
  - The equals operator (=) is assumed and need not be entered.
  - A trailing asterisk is assumed and need not be entered.
The following additional operators are valid:

Table 17: Rules for entering filter conditions for a character-based column

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>***</td>
<td>Not equal</td>
</tr>
<tr>
<td>==</td>
<td>Exactly equal; specifies an exact match and is case sensitive</td>
</tr>
<tr>
<td>IN</td>
<td>An either/or condition For example, in(mv*, sys*) would be true for any character string starting with MV or SYS.</td>
</tr>
</tbody>
</table>

Use these rules when entering a filter condition for a numeric column:

— A valid operator followed by a number is required.

— The following operators are valid:

Table 18: Rules for entering filter conditions for a numeric column

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>=</td>
<td>Exactly equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>****</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&gt;&lt;</td>
<td>Shortcut for greater than x and less than or equal to y For example, &gt;&lt;(5, 10) would be true for a number greater than 5 and less than or equal to 10.</td>
</tr>
</tbody>
</table>

To display or hide the filter masks

1. Perform one of the following actions:
   - On the view toolbar, click the Filter mask button.
   - Right-click the view tab or the blank part of the view toolbar, and select Show filter masks.

To change the filter masks

1. Type a filter condition in the box under the column heading.
Type as many conditions as you want. The AND operator is used with all of the specified conditions.

For information about entering a condition, see Table 17 on page 202, Table 18 on page 202 and “Specifying a condition”.

2 Press Enter.

A new WHERE statement is generated for the view, and the new results are displayed.

Related Information

■ “Specifying a condition” on page 206

Filtering data by setting filter properties (MainView Explorer)

Use the following procedure to specify filters for the columns used for the view’s query.

Filtering data using filter properties is temporary. Closing the views discards the filters. The current data is only filtered; no data is updated.

To set filter properties for a view

1 Perform one of the following actions:

■ On the view toolbar, click the Properties button.

■ Right-click the view tab or the blank part of the view toolbar, and select Properties.

2 In the Filters tab of the Properties dialog, specify a filter value for one or more element names (column headings).

The filter value must be valid for the field. If the field accepts character data, the value can include one of the following wildcard characters:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Represents any number of characters, including zero. The asterisk must be the last or only character in the value (such as JOBNAME=CICS* or JOBNAME=*).</td>
</tr>
<tr>
<td>Wildcard</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| ?        | Represents a single character  
           A question mark can appear in one or more positions in the value (such as JOBNAME=CICS??).

3 To display the filtered data in the view, click **Apply**.

---

**Note**

If the Filters tab does not list the element name that you want to use as a filter, you can enter the WHERE command on the view’s **Command** line.

---

**Related Information**

- “QWHERE and WHERE commands” on page 237
- “Executing MainView commands” on page 111

---

**Filtering data by using QWHERE or WHERE (MainView Explorer)**

Use the following procedure to specify complex filter conditions with QWHERE and WHERE clauses.

You can specify QWHERE and WHERE as clauses in the Properties dialog.

Filtering data by using QWHERE or WHERE can be permanent or temporary. When you close the view, you are prompted to save the changes as a customized view, which makes the filter permanent.

**To use WHERE or QWHERE to create complex filters**

1. From any view, perform one of the following actions:

   - On the view toolbar, click the **Properties** button.
   - Right-click the view tab or the blank part of the view toolbar, and select **Properties**.

2. On the WHERE tab of the Properties dialog, specify one or more conditions in the **WHERE** or **QWHERE** fields.

3. To apply the WHERE or QWHERE conditions to the current view, click the **Apply** button.
To clear the filter conditions from the WHERE and QWHERE fields, click the Clear button.

**Related Information**

- “QWHERE and WHERE commands” on page 237
- “WHERE and QWHERE syntax” on page 238
- “Saving customized views (MainView Explorer)” on page 211

**Filtering data by editing a column filter (MainView Explorer)**

Use the following procedure to filter up to eight fields in a view via the Filter dialog.

Filtering data by editing a column filter can be permanent or temporary. When you close the view, you are prompted to save the changes as a customized view.

**Note**

If you save a complex filter condition by using a WHERE clause, the complex filter overrides any simple filter that is set for the field.

**To define a filter condition**

1. Right-click a column header (in tabular views) or a field (in detail views) and select Edit filter.

2. Specify a relational operator and a value.

   **Note**
   
   Any field in a view that has a filter condition defined for it can be used as:
   
   - A positional parameter, if you add it to the parameter list
   - A keyword parameter

**Related Information**

- “WHERE and QWHERE syntax” on page 238
- “Specifying a condition” on page 206
Specifying a condition

Use the following procedure to specify conditions for use in thresholds, hyperlinks, filters, and the count summarization type.

A condition consists of the following pieces:

- The element name of the column for which you want to set a condition
- A relational operator (> , >=, <, <=, <> , or =)
- A value (numeric, alphanumeric, or an element name for a different element)

**Note**
The value can use the * and ? wildcard characters: * indicates one or more characters, and ? indicates a single character. You can use * (the default) alone.

To specify a condition that always evaluates to true

1. Specify the following value:
   - For character fields, specify **elementName=**.
   - For numeric fields, specify **elementName>=0**.

**Example**

- To define a condition of any value in column A, specify A=*.
- To define a condition of all values in column G that exceed 25, specify G>25.
- To define a condition of all values in column I that are greater than or equal to the corresponding value in column K, specify I>=K.
- To define a condition of any value in column A that begins with SYS, specify A=SYS*.

Adding fields to the Groupby list

You can select up to four fields as summary fields for creating a summary view. Use the following procedure to add fields to the Groupby list.
Tip
To see the fields that are currently selected, right-click the view tab or the blank part of the view toolbar and choose **Show header info => Show fields grouped by**. Field headers indicate current selection status in the Groupby list by displaying Gn under the header name, where n is any number from 1 through 4.

**To add a field to the Groupby list**

1. Right-click a column header button (in tabular views) or a field (in detail views) and choose **Add to Groupby list** from the pop-up menu.

2. (optional) Specify conditions for the summary view.

   For example, you might want to exclude some fields, change the format of others, and modify titles:

   ■ Use the **Format data** option (by right-clicking the column header button) to specify a summarization type, or to change the title of any field in a summary view.

   ■ Use the **Exclude field** option (by right-clicking the column header button) to exclude fields that are made meaningless by summarization.

**Note**
After a field has been added to the Groupby list, **Add to Groupby list** on the pop-up menu changes to **Remove from Groupby**.

**Related Information**

- “Customizing data display in MainView Explorer” on page 187
- “Excluding and including fields” on page 210

**Adding fields to the Sort list**

Using the Sort list, you can select up to four fields of a tabular or summary view to specify the sort order for data. Use the following procedure to add fields to the Sort list.

The data in a field can be sorted in either ascending or descending order. By default, all numeric fields are sorted in descending order, and all other data types are sorted in ascending order.
When you specify the sort order for multiple fields, priority is given to the field that is in the highest position in the sort list. Lower-level sort orders are used to further sort fields when identical values exist.

**Tip**
To see fields that are currently selected, right-click the view tab or the blank part of the view toolbar and select *Show header info => Show fields sorted by.* Field headers indicate current selection status in the Sort list by displaying $S_n$, where $n$ is a number from 1 through 4.

**To add a field to the Sort list**

1. Right-click a column header button and select *Add to Sort list* from the pop-up menu.

**Note**
After a field has been added to the Sort list, *Add to Sort list* on the pop-up menu changes to *Remove from Sort.*

**Tip**
If you click a column header button, that column becomes the primary sort field.

### Adding to the Parameter list

Use the following procedure to add to the parameter list.

If you used *Edit filter* to provide a filter for a field, you can set that field as a positional parameter.

**Tip**
To see the fields that are currently selected, right-click the view tab or the blank part of the view toolbar and choose *Show header info => Show positional parameters.* Field headers indicate current selection status in the Parameter list by displaying $P_n$, where $n$ represents the Parameter list's numeric identifier.

**To add to the Parameter list**

1. Right-click the column header button (in tabular views) or the field (in detail views) and select *Add to Parameter list* from the pop-up menu.
Setting chart items (X or Y axis)

Use the following procedure to select one X-axis item and up to eight Y-axis items to display in a chart.

**Tip**
To see all fields that are currently selected for a chart, you can right-click the view tab or the blank part of the view toolbar and choose Show header info => Show fields for charting. Field headers indicate current selection status as X or Yn, where n is a number from 1 through 8.

1. To select the X axis, right-click a column header button (in tabular views) or a field (in detail views) and choose Set as X-axis Chart item from the pop-up menu.

   After setting the X-axis to a specific column, the column header displays an X.

   The X-axis appears at the left or bottom of a graph. On a pie or gauge chart, the X-axis value is used as a title.

   Each Y-axis value is plotted against the X-axis value. In a pie or gauge chart, the Y-axis values are charted as segments of the pie or dials for the gauge, and the X-axis is used as a label.

2. To select a Y axis, right-click a column header button (in tabular views) or a field (in detail views) and choose Add to Y-axis Chart items list.

   After adding a column to the Y-axis Chart Items list, the column header displays Yn, where n is a number from 1 through 8.

   **Note**
   After you add a field to the Y-axis Chart items list, the Add to Y-axis Chart items list command on the pop-up menu toggles to Remove from Y-axis Chart items.

3. *(optional)* Add additional Y axis values (up to a maximum of eight), as needed.
Duplicating fields

Use the following procedure to duplicate a field. For example, you might duplicate a field to add a graphical representation of numeric data to a view, or to create a Count field in a summary view.

To duplicate a field

1. Right-click a column header button (in tabular views) or a field (in detail views) and choose Duplicate field from the pop-up menu.

2. (optional) Use the Format data option to customize the field:
   - If you added a graphical field, use the Width and Graph upper limit fields of the Format data dialog to adjust the appearance of the new field.
   - If the new field should display a count of a number of objects in a summary view, use Format data to assign a summarization type of count to the new field.

Tip
Clicking a column header button makes that column the primary sort field.

Excluding and including fields

Use the following procedure to show or hide excluded fields. Excluded fields are those fields that belong to a view definition but are not displayed.

To exclude and include fields

1. To see fields that have been excluded, right-click the view tab or the blank part of the view toolbar, and choose Show excluded fields from the pop-up menu.

2. To hide a field from the view, right-click a column header button (in tabular views) or a field (in detail views) and choose Exclude field.

Although the excluded field does not appear in the view, the field's associated filters are used as selection criteria for other data that is displayed in the view.
After a field has been excluded from a view, **Exclude field** changes to **Include field** in the pop-up menu.

**Saving customized views (MainView Explorer)**

Use the following procedure to save customized views in common data sets on the mainframe for access by a MainView Explorer or TSO session.

The customized views are displayed in either the **Cust User** or **Cust Site** folder in the Product tree of the navigation frame.

**Note**

After you save a customized view, the view that was distributed with the product remains available in its original location in the product folder.

**To save a customized view**

1. In the customized view, right-click any column header and select **Save customized view** or click on the Save customized view toolbar button on the toolbar buttons for views.

The Save view definition dialog is displayed as shown in the following figure:

![Save view definition dialog](image)

2. Complete the relevant fields for your view based on the descriptions in the following table:
## Save view definition field

<table>
<thead>
<tr>
<th>Save view definition field</th>
<th>Description</th>
</tr>
</thead>
</table>
| View name                  | Accept the current name or enter a different name (from one to eight characters long).  
**Note:** Saving your changed view under its original name does not change the view that is distributed with MainView Explorer. However, you can access only the customized version of the view. If you subsequently delete the customized view, the original view is available for access again. |
| Description                | Enter a description of the view (up to 30 alphanumeric characters) to be displayed in the Product tree. |
| Summary view name          | *(tabular views only)* Specify a summary view (an alternate form for the tabular view). |
| Library                    | Specify where to save the customized view:  
- Select **site** to save the customized view in the site library (SBBVDEF).  
- Select **user** to save the view in your user library (BBVDEF).  
**Tip:** You can create a summary view by using the **Add to Groupby** list, as described in “Adding fields to the Groupby list” |
<table>
<thead>
<tr>
<th>Save view definition field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Save dynamic fields       | *(optional)* Clear the **Save dynamic fields** check box if you do not want to save dynamic fields that are associated with the customized view. This check box is selected by default, which saves the following dynamic fields that MainView data management components create on demand:  
  - Interval date  
  - Interval time  
  - Interval hour  
  - SSI target  
  - SSI system  
  Saving these fields with a customized view allows them to be included or excluded from the display, or to be used as hyperlinks. |
| Make changed thresholds global | *(optional)* Select the **Make changed thresholds global** check box if you changed thresholds in this customized view and want to make them available for all views and users. Leaving this check box cleared (the default) saves the threshold changes only in the BBVDEF library, for use only by the customized view. In contrast, selecting this check box saves the changed thresholds in the PAS parameter library, BBPARM. The same threshold and display attributes that are specified for the changed field will apply to all instances of the same field element in other views.  
**Tip:** If you want to use the same thresholds on multiple PASs, you can copy these members to the PAS parameter libraries, provided the PASs are the same release. Restart each PAS to activate the thresholds. If the PASs are not the same release, you must log onto each PAS and define the thresholds by using the CUSTom command. |
| Replace member           | *(optional)* Clear the **Replace member** check box if you want to create a new member under which to save your customized view. Leaving the check box selected (the default) replaces the existing member |
3 When finished, click **Save**.

---

**Related Information**

- “Adding fields to the Groupby list” on page 206

---

## Customizing data display in windows mode

You can create your own assortment of views to troubleshoot performance problems that are unique to your site. Views are created by customizing the views that are included with MainView products.

The site administrator can customize the site view library (*hlq.SBBVDEF*), and individual users can customize their own view library (*userid.BBVDEF*). The USER view shows all of the user-defined views in a *userid.BBVDEF* library.

A user can customize any site-wide view and save it to their user library. The system administrator can move customized views from a user library to the site library, making the customized view site-wide for all views.

---

**Note**

Views are displayed based on a hierarchy of the following view libraries: distributed library, site-wide library, and user library. When a user requests a view, MainView first looks for the view in the user library, then the site-wide library, and finally the distributed library.

---

On the window information line, the letter *U* identifies a customized view. *D* identifies a view that was distributed with a MainView product.
Creating and saving customized views (windows mode)

Use the following procedure to create a customized view from the available options on the View Customization dialog.

**Before you begin**

If you want to create customized views for your own use, allocate a standard partitioned data set named `userid.BBVDEF`, where `userid` is your TSO ID.

If you are a site administrator creating site-wide customized views, use the `hlq.SBBVDEF` data set.

**To create and save a customized view**

1. Display the view that you want to customize by using either of the following methods:
   - Use the VIEWS command to select the view from a list of views.
   - Type the name of the view on the **COMMAND** line and press **Enter**.

2. On the view's **COMMAND** line, type **CUST** and press **Enter**.
A dialog displays the view customization options at the top. At the bottom of the
dialog, a series of columns displays a working copy of the view. The view assigns
a unique letter to each column. You can use the unique letters to select the
columns that you want to change with one of the customization options.

**Tip**
The online Help describes each customization option. You can see these
descriptions by typing HELP CUST on the COMMAND line (or HELP if you are
already in view customization).

3 Specify a customization option:
   a In the Option field, type the option letter (such as F to customize format).
   b If the option requires a target column, either type the corresponding column
      letter in the OPTION field, or place your cursor on that column’s letter.
   c Press Enter.

4 Customize the view as needed.

5 When you finish customizing the view, press the END (PF3) key.

6 When prompted to save your changes, type YES in the Save changes field.

7 When prompted to specify information about the new view, complete each field
   based on the following table, and then press Enter.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View name</td>
<td>Name of the view&lt;br&gt; If you are creating a new customized view, you can save it under its existing view name or under a new, unique name. If you specify the same view name as the original, the customized version is displayed whenever the view is accessed by your TSO user ID. The view that is distributed with your product is not altered, but only the modified version of the view is accessible to your user ID.&lt;br&gt; If you are making changes to an existing customized view, specify the name of that view.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Replace</td>
<td>Whether to replace the existing view file</td>
</tr>
<tr>
<td></td>
<td>If you are making changes to an existing customized view, specify <strong>YES</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you specify <strong>NO</strong>, the existing customized view is not replaced and the</td>
</tr>
<tr>
<td></td>
<td>save is canceled.</td>
</tr>
<tr>
<td></td>
<td>If you are creating a new customized view, specify <strong>NO</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td><em>(optional)</em> A brief description of the view</td>
</tr>
<tr>
<td>Dynamic fields</td>
<td>Whether the view has dynamic fields that you want to include</td>
</tr>
<tr>
<td></td>
<td>For more information about dynamic fields, see the online Help.</td>
</tr>
<tr>
<td>Summary View</td>
<td>Name of a summary view to associate with a tabular view</td>
</tr>
<tr>
<td></td>
<td>For more information about summary views, see the online Help.</td>
</tr>
<tr>
<td>Threshold Location</td>
<td>Whether threshold changes that you made should apply only to the customized</td>
</tr>
<tr>
<td></td>
<td>view or to all views:</td>
</tr>
<tr>
<td></td>
<td>- <strong>VIEW</strong> <em>(the default)</em> saves the threshold changes only with the</td>
</tr>
<tr>
<td></td>
<td>customized view in your BBVDEF library.</td>
</tr>
<tr>
<td></td>
<td>- <strong>CENTRAL</strong> saves the threshold changes in the PAS parameter library,</td>
</tr>
<tr>
<td></td>
<td>BBPARM. The threshold and display attributes that you specified for the</td>
</tr>
<tr>
<td></td>
<td>changed field will apply to all instances of this field in other views.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong>: To use the same thresholds on multiple PASs, you can copy these</td>
</tr>
<tr>
<td></td>
<td>members to the PAS parameter libraries <em>if</em> the PASs are the same</td>
</tr>
<tr>
<td></td>
<td>release; restarting each PAS activates the thresholds. If the PASs are not</td>
</tr>
<tr>
<td></td>
<td>the same release, you must logon to each PAS and use the CUSTOM command to</td>
</tr>
<tr>
<td></td>
<td>define the thresholds.</td>
</tr>
</tbody>
</table>

After saving your customized view, you can access it again by typing its name on the **COMMAND** line, or by using the **USER** command and selecting the view from the list of user-defined views.
Including additional elements

To provide you with more flexibility, some views have more elements than are displayed. Use the following procedure to include additional elements that are excluded from your present customization settings.

With this customization, you can see all view elements and include or exclude them based on your preferences.

To include additional elements in a view

1 On the view's COMMAND line, type CUST and press Enter.

2 In the OPTION field, type E and press Enter to see any excluded elements.

   In this view, the E option displays the excluded elements by highlighting the column and its assigned letter. Views can have several excluded elements. If you want to see any other excluded elements, scroll to the right.

3 To include any of the excluded elements in your new view, type I in the OPTION field, place the cursor on the excluded element that you want to include, and press Enter.

4 When finished, press the END (PF3) key.

5 In the Save changes field, type YES.

6 When prompted for the following information about the new view, complete each field and press Enter:

   - View name
   - Replace
   - Description
   - Dynamic fields
   - Summary view
   - Threshold Location

   For descriptions of these fields, see the online Help and topic on creating and saving customized views.
Tip
The customized view now includes the previously excluded element. If you later decide to exclude the element again, you can do so by using the E (Exclude) option.

Related Information
- “Creating and saving customized views (windows mode)” on page 215

Setting hyperlinks between views

Use the following procedure to create or change a hyperlink between views.

Elements that are highlighted in views have hyperlinks. Each hyperlink has a command associated with it. Positioning your cursor on a hyperlink and pressing Enter executes the associated command. You can customize how hyperlink element names are displayed, the associated command, and the conditions against which the command is issued.

Before you begin

Plan the conditions and commands to be issued for your hyperlinks, based on your specific needs and preferences. Up to 8 commands and condition criteria for each command can be customized to a single field. Consequently, you can customize different commands to be issued under varying data conditions that might occur in a field.

For more information about conditions and commands, see the online Help.

To create or change a hyperlink

1. On the view’s COMMAND line, type CUST and press Enter.

2. Perform the following actions:
   a. In the OPTION field, type H.
   b. Place your cursor on the field where you want to create or change a hyperlink and press Enter.

3. Specify the criteria that the data must meet in the Condition field, and specify the hyperlink to activate in the Command field.

Use relational operators and numeric values to establish a filtering condition. For additional information, see the hyperlink information in the online Help.
4 When finished, press the END (PF3) key.

5 In the Save changes field, type YES.

6 When prompted for the following information about the new view, complete each field and press Enter:

- View name
- Replace
- Description
- Dynamic fields
- Summary view
- Threshold Location

For descriptions of these fields, see the online Help or topic on creating and saving customized views.

---

**Related Information**

- "Creating and saving customized views (windows mode)" on page 215

---

**Changing the headings of data fields**

Views contain data fields, which show individual elements of information about a resource in your enterprise. Use the following procedure to rename a data field's heading.

**To change a field's heading**

1 On the view's COMMAND line, type CUST and press Enter.

2 Perform the following actions:
   a In the OPTION field, type F.
   b Place your cursor on the field that you want to change and press Enter.

3 Use the Heading1 and Heading2 fields to rename the heading of the selected field.
You can use up to two lines to name the column header. The name can be entered in the top line (Header 1) or bottom line (Header 2). You can use both lines based on your preferences and needs. For example, you could name the header Pending Jobs and have it appear on the top line or you can have Pending on the top line and Jobs on the bottom line.

**Note**

You can also change the way the data element is displayed. For additional information, see the formatting information in the online Help.

4 When finished, press the **END (PF3)** key.

5 In the **Save changes** field, type **YES**.

6 When prompted for the following information about the new view, complete each field and press **Enter**:

- **View name**
- **Replace**
- **Description**
- **Dynamic fields**
- **Summary view**
- **Threshold Location**

For descriptions of these fields, see the online Help or topic on creating and saving customized views.

**Related Information**

- “Creating and saving customized views (windows mode)” on page 215

---

**Setting thresholds and assigning colors**

If a threshold condition is set for a data field, the field is highlighted in color when the condition is met. Use the following procedures to set a threshold condition for a field and choose the highlight color, and to change the colors that are available.

**Note**

If your monitor does not support colors, high and low intensity are used for highlighting.
To set a threshold and assign a color for it

1 On the view's COMMAND line, type CUST and press Enter.

2 Perform the following actions:
   a In the OPTION field, type T.
   b Place your cursor on the field that you want to change and press Enter.

3 Use the Condition and Attr fields to specify the condition and attributes for the field:
   a Use the Condition fields to set as many as eight threshold conditions.
     To define a condition, use the internal letter of the field (shown in the working copy of the view), a relational operator, and a value. For a list of the valid operators and values, see the threshold information in the online Help.
     b For each condition, specify a color by entering the color's numeric code in the Attr field.

   Tip
   You can find the numeric code of the color that you want by selecting it from the color code list on the far right of the dialog.

4 When finished, press the END (PF3) key.

5 In the Save changes field, type YES.

6 When prompted for the following information about the new view, complete each field and press Enter:
   a View name
   b Replace
   c Description
   d Dynamic fields
   e Summary view
   f Threshold Location

   For descriptions of these fields, see the online Help or topic on creating and saving customized views.
To make different colors available

1. From the View Customization dialog, enter **MVParms** on the **COMMAND** line.

2. Select the **ATTRIBUTES** option.

3. Make changes to the colors on the Display Attributes dialog:
   - a. Change values by typing over the existing values.
      
      When entering an attribute, only the first letter is required. To reset a field to its default value, leave the field empty. For more information, see the online Help.
   
   - b. Press **Enter** to apply the changes.

4. When finished, press the **END (PF3)** key until you return to the View Customization dialog.

Related Information

- “Creating and saving customized views (windows mode)” on page 215

---

Summarizing data in a view

Use the following procedure to create a summary of data in a view.

MainView creates a summary view by summarizing numerous rows of data from a tabular view into a single row based on the values in a selected column. Statistical information can then be calculated from another column of the view.

The column on which you base the summary view should contain a limited number of possible values, not just random data. In other words, multiple rows should be expected to contain one of the possible values for that column.

Use the following procedure as an example of how to create a summary view from a tabular view of data set information. The view that is used in this example comes from the MainView SRM VTOC Scan Facility. The goal of this summary view is to determine how much DASD data sets use, based on their catalog status.

To summarize the data in a view

1. On the view’s **COMMAND** line, type **CUST** and press **Enter**.
2 In the **OPTION** field, type **Z** followed by the letter of the column to be summarized and press **Enter**.

For this example, use **D** for the **Cat** (catalog status) column:

```
CMD Data Set   Name
--- ----  "--- Name  "--- Name
CMD Cat Data Set   Name
--- ----  "--- Name  "--- Name
```

The dialog shown in the following example is displayed:

```
CMD Data Set   Name
--- ----  "--- Name  "--- Name
CMD Cat Data Set   Name
--- ----  "--- Name  "--- Name
```

Notice that the **Cat** column is moved to the first position, column A. The column on which a summary view is based is always moved to the first position for easy identification.

Also notice that the view has been reduced to three lines, with category letters designated as follows:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>For data sets that are cataloged</td>
</tr>
</tbody>
</table>
For data sets that are incorrectly cataloged (that is, a data set resides on a volume but the catalog points to a data set of the same name on a different volume)

For data sets that are not cataloged

For data sets that have unknown catalog status

3 In the OPTION field, type F followed by the letter of the column whose data you want to calculate and press Enter.

For this example, use L for the Tracks Allocated column. The dialog shown in the example is displayed:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>For data sets that are incorrectly cataloged (that is, a data set resides on a volume but the catalog points to a data set of the same name on a different volume)</td>
</tr>
<tr>
<td>N</td>
<td>For data sets that are not cataloged</td>
</tr>
<tr>
<td>U (not shown in the example)</td>
<td>For data sets that have unknown catalog status</td>
</tr>
</tbody>
</table>

The summarized view now shows the formatting and calculation (Summarization type) options that can be performed on the selected column.

4 In the Summarization type field, specify the type of calculation to be performed by entering one of these characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Calculation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Average</td>
<td>Average adds every value in a summarized numeric data field and shows the average.</td>
</tr>
<tr>
<td>S</td>
<td>Sum</td>
<td>Sum adds every value in a summarized numeric data field and shows the total.</td>
</tr>
<tr>
<td>M</td>
<td>Minimum</td>
<td>Minimum shows the smallest value in a summarized numeric or character data field.</td>
</tr>
<tr>
<td>X</td>
<td>Maximum</td>
<td>Maximum shows the largest value in a summarized numeric or character data field.</td>
</tr>
</tbody>
</table>
### Character | Calculation | Description
--- | --- | ---
C | Count | Count does a count of all the number occurrences of a grouped value, which is either character or numeric, within a summarized data field.

L | Any | Any displays a duplicate character value or any one of the numeric values encountered in a summarized data field.

P | Percentage | Percent adds just the values in a summarized numeric field and shows the total as a percentage in relation to the total of all the values for all the data fields.

For this example, specify **S** to calculate the sum, or total amount, of tracks allocated, and then press **Enter**.

The result of the calculation is displayed:

```
------------------------ VIEW CUSTOMIZATION - WBVTOCD -------------------------
OPTION ===> f                     SCROLL ===> PAGE
Options: (that require column selection) Other options:
F - Format    M - Move       I - Include       G - Graph    S - Save view
O - Order     R - Repeat     X - Exclude       P - Parameters E - Show excluded
L - Filter    T - Threshold  H - Hyperlink     Z - Summarize  K - Show template

-------------< Format - column: L element: W21TRKSA >---------------------
Data type: Numeric           Display Mode => 1 (1 as is 2 as graph 3 as hex)
Width    => 9                Graph range (for 2): Low => 0    High => 0
Decimals => 0   (for numeric data)     Display zero values => Y (Yes/No)
Heading1 => Tracks                     Summarization type  => S (A/S/M/X/C/L/P)
Heading2 => Allocated                  Condition (for C)   =>

<table>
<thead>
<tr>
<th>CMD</th>
<th>Cat</th>
<th>Block</th>
<th>Percent</th>
<th>Blks</th>
<th>Exts</th>
<th>Size</th>
<th>Eff</th>
<th>/Trk</th>
<th>Size</th>
<th>Tracks</th>
<th>Tracks</th>
<th>Tracks</th>
<th>Percent</th>
<th>CA</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0</td>
<td>81.4</td>
<td>0</td>
<td>1</td>
<td>781</td>
<td>2106</td>
<td>4</td>
<td>10</td>
<td>35.8</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>31.4</td>
<td>0</td>
<td>1</td>
<td>830</td>
<td>45</td>
<td>1</td>
<td>14</td>
<td>4.4</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>0</td>
<td>38.3</td>
<td>0</td>
<td>1</td>
<td>1372</td>
<td>8976</td>
<td>2</td>
<td>25</td>
<td>14.2</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The **Tracks Allocated** column now shows the total amounts for the data sets based on their catalog status (column A).

5. When finished, press the **END** (PF3) key.

6. In the **Save changes** field, type **YES**.

7. When prompted for the following information about the new view, complete each field and press **Enter**:
   - **View name**
   - **Replace**
Using hyperlinks and menus to access views

In addition to entering view names on the COMMAND line, you can use hyperlinks and menus to access views. The following topics explain how to access views through hyperlinks and menus.

Using hyperlinks

MainView products make it easy for you to display views via predefined hyperlinks. Use the following procedures to hyperlink between MainView products, views, or services.

**Note**

Although MainView provides predefined hyperlinks, you can add your own hyperlinks to views as described in "Setting hyperlinks between views".

To hyperlink to other MainView products

1. On the COMMAND line, enter `CON * PLEXMGR;PLEX`.

   This command displays all MainView products that are installed at your site, their associated targets, and their statuses.

   **Tip**

   For more information about the CONtext command, enter `HELP CON` on the COMMAND line.

2. Select a product to hyperlink to a menu for that product.
To hyperlink between views

Hyperlinks to related views are displayed in different colors (or highlighted if you have a monochrome monitor). These hyperlinks provide more information about the element that you selected.

1 Place your cursor on a hyperlink and press Enter.

MainView displays the view that corresponds to this hyperlink.

**Tip**

You can use the S line command to activate a hyperlink if the following conditions exist:

- The S line command is not defined to perform any other action for the view.
- The first column of the view is defined as a hyperlink.

**Related Information**

- “Setting hyperlinks between views” on page 219

Overview of menus

You can access views from convenient menus that provide a list of selectable options.

You can use several types of menus to help perform the following actions:

- Get anywhere quickly from a single place by using “Primary Easy menus” on page 229.
- Find information related to a specific resource, job, or workload by using “Object Easy menus” on page 229.
- Select a group of views, by function, with “Product MAIN views” on page 230.
Primary Easy menus

Primary Easy menus provide easy access to views by listing options that have descriptive names. When you request a primary Easy menu, either by name or from a view list, a view similar to the following example is displayed:

```
COMMAND ===>  SCROLL ===>  PAGE
CURR WIN ===>  ALT WIN ===>  
W1 =EZMxxx============$YSB====*========ddmmmyyyy==hh:mm:ss==MVMVS==D======1

menu title
```

The symbols next to an item have the following designations:

- A period (.) indicates that the item hyperlinks to view data.
- A greater-than symbol (>) indicates that the item hyperlinks to a pop-up window or another menu.
- An asterisk (*) indicates that the item is not an available option.

Menu options are represented by `item` in the preceding example. You can change this menu view to suit your site’s needs.

Object Easy menus

An object Easy menu lets you hyperlink from a view object (such as a job, resource, or workload) to a view similar to the following example:

```
COMMAND ===>  SCROLL ===>  PAGE
CURR WIN ===>  1  ALT WIN ===>  
W1 =EZMxxx============$YSB====*========ddmmmyyyy==hh:mm:ss==MVMVS==D======1

menu title
```

Selections specific to the object (represented by items 1 through 5 in the preceding example) are grouped on the left side of the menu. Selections related to the object as
a whole (represented by items 6 through 9 in the preceding example) are grouped on the right side of the menu. You can modify the view of this menu to suit your needs.

**Product MAIN views**

All products have MAIN views that list groups of views by function. The following example shows a MAIN view for the MainView VistaPoint product:

```
COMMAND ===> SCROLL ===> HALF
CURREN WIN ===> 1   ALT WIN ===> W1 =MAIN=============(ALL======*=======)ddmmmyyyy==hh:mm:ss====MVVP==D=======7
CMD View Name Description
--------- ------------------------------
ADMIN Administrative Views
CLUSTER Trend Application views
EZVISTA VistaPoint Easy Menu
INTERVAL Interval Application views
REALTIME Realtime Application views
SESSION Session Application views
TRANSACT CICS, DB2, IMS Monitor Summary
```

**Related Information**

- "Creating and saving customized views (windows mode)" on page 215

**Accessing Easy menus**

Use the following procedure to access Easy menus.

Easy menus are named EZpName, where p identifies the product family and Name represents the unique part of the menu name, as shown in Table 19 on page 230.

**Table 19: Easy menu names**

<table>
<thead>
<tr>
<th>Menu name</th>
<th>Product family</th>
</tr>
</thead>
<tbody>
<tr>
<td>EZAName</td>
<td>MainView Alarm Management</td>
</tr>
<tr>
<td>EZCName</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td>EZDName</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>EZIName</td>
<td>MainView for IMSOnline</td>
</tr>
<tr>
<td>EZDName</td>
<td>MainView for DBCTL</td>
</tr>
<tr>
<td>EZIPName</td>
<td>MainView for IP</td>
</tr>
<tr>
<td>EZLName</td>
<td>MainView for Linux - Servers</td>
</tr>
<tr>
<td>EZMName</td>
<td>CMF MONITOR and MainView for z/OS</td>
</tr>
<tr>
<td>EZQName</td>
<td>MainView for WebSphere MQ</td>
</tr>
<tr>
<td>Menu name</td>
<td>Product family</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>EZTName</td>
<td>MainView Transaction Analyzer</td>
</tr>
<tr>
<td>EZUName</td>
<td>MainView for UNIX System Services</td>
</tr>
<tr>
<td>EZVName</td>
<td>MainView VistaPoint</td>
</tr>
<tr>
<td>EZVTAMName</td>
<td>MainView for VTAM</td>
</tr>
<tr>
<td>EZWEBName</td>
<td>MainView for WebSphere Application Server</td>
</tr>
<tr>
<td>EZpSSI</td>
<td>MainView product menu for viewing multiple targets (Single System Image context)</td>
</tr>
<tr>
<td>EZPLEX</td>
<td>Plex Manager</td>
</tr>
</tbody>
</table>

**To access Easy menus**

1. Use one of the following methods to access an Easy menu:

   - Display a list of views with the VIEWS command, select an Easy menu from the list, and press Enter.

   - Enter the name of the Easy menu on the COMMAND line.

   You can select an option from an Easy menu by placing your cursor on the option and pressing Enter.

**Note**

Some primary Easy menus are displayed as MAIN menu options when a product initializes in a window.

**Using the MAIN view for a product**

All products have MAIN views that list groups of views by function. Use the following procedure to access views from the MAIN view of a product.

1. From the MAIN view, select a view category by performing one of the following methods:

   - Place your cursor on the category that you want to view and press Enter.

   - Enter the name of the category on the COMMAND line.

   A list of choices for the selected category is displayed.
Tip

The MAIN view for all products categorizes product views by function. You can always return to this view by typing **MAIN** on the **COMMAND** line.

2 (optional) For a description of the actions and commands for this view, place your cursor on the MAIN view name in the window information line and press the **Help (PF1)** key.

## Filtering data in a view in windows mode

You can establish conditions to show only the view data that meets your criteria. You define these conditions by setting data filters.

A filter condition is one or more SQL-like expressions that define criteria for the data elements in one or more fields:

- **Simple filters** define a condition for one element in a view column.
- **Complex filters** can apply multiple conditions against multiple data elements in a view.

You can use any of the following procedures to set data filters:

- Setting a simple filter for a data element in a view column on page 232
- Setting a complex filter (using the View Customization dialog) on page 235
- Setting a complex filter (using the COMMAND line) on page 240

**Note**

Specifying a filter for an element replaces any previously specified filter for that element.

### Setting a simple filter for a data element in a view column

Use the following procedure to limit the data shown in a view column by setting simple filter conditions.

The filter will contain the following elements:

- The internal letter assigned to the column (column ID)
- An operator
A numeric or mask value

The view of the column changes according to the application of the filter criteria to the data elements. For example, the following procedure sets the conditions necessary to see a specific installation status in the Plex Manager TGTDEF view.

**To set a simple filter**

1. On the view’s **COMMAND** line, type **CUST** and press **Enter**.

2. In the **OPTION** field, type **L** followed by the letter of the column to be filtered and press **Enter**.

For this example, use **E** for the **Install Status** column:

```
------------------------ VIEW CUSTOMIZATION - TGTDEF --------------------------
OPTION ===> l e                                               SCROLL ===> HALF
Options: (that require column selection)       Other options:
F - Format M - Move I - Include G - Graph S - Save view
D - Order R - Repeat X - Exclude P - Parameters E - Show excluded
L - Filter T - Threshold H - Hyperlink Z - Summarize K - Show template
---------------------< Filter - column: E   element: TGTSTAT        >------
Filter condition =>
Parameter position =>   (optional: 1 to 8; blank means not used positionally)
A condition consists of the column id, an operator, and a value. This value can be overridden by requesting this view with a keyword parameter (using the element name as keyword) or a positional parameter (if you assign a position).
-------------------------------------------------------------------------------
```

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CMD</td>
<td>CAS</td>
<td>Target</td>
<td>Product</td>
</tr>
<tr>
<td>---</td>
<td>---------</td>
<td>------------</td>
<td>----------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>SYSA</td>
<td>DB2P</td>
<td>BBCS TEST DB2 V3</td>
<td>MVVP</td>
</tr>
<tr>
<td></td>
<td>SYSA</td>
<td>ETCIC4</td>
<td>MVVICS SPECIALIZED SOFTWARE V</td>
<td>MVCICS</td>
</tr>
<tr>
<td></td>
<td>SYSA</td>
<td>SSICICS</td>
<td>GUPCIC4 GUPTA CICS V4.10</td>
<td>MVCICS</td>
</tr>
<tr>
<td></td>
<td>SYSA</td>
<td>PUBCIC3</td>
<td>BBCS PUBLIC CICS V2.12</td>
<td>MVCICS</td>
</tr>
<tr>
<td></td>
<td>SYSA</td>
<td>PUBCIC3</td>
<td>BBCS PUBLIC CICS V2.12</td>
<td>MVCICS</td>
</tr>
<tr>
<td></td>
<td>SYSA</td>
<td>ETCIC4</td>
<td>MVVP EMPRISE TECH CICS V3.3</td>
<td>MVCICS</td>
</tr>
</tbody>
</table>

**Tip**

For additional information about using the **L** option, see the filtering information in the online Help.

3. In the **Filter condition** field, type **E = N*** and press **Enter**.
This filter requests only targets that have a status of Not Installed, as shown in this example:

```
----------------------- VIEW CUSTOMIZATION - TGTDEF --------------------------
OPTION ===> L                                                SCROLL ===> HALF
Options: (that require column selection)       Other options:
F - Format    M - Move       I - Include       G - Graph       S - Save view
O - Order     R - Repeat     X - Exclude       P - Parameters E - Show excluded
L - Filter    T - Threshold  H - Hyperlink     Z - Summarize  K - Show template
---------------------< Filter  -   column: E   element: TGTDSTAT        >------
Filter condition   => E = N*
Parameter position => (optional: 1 to 8; blank means not used positionally)
A condition consists of the column id, an operator, and a value. This value
can be overridden by requesting this view with a keyword parameter (using the
element name as keyword) or a positional parameter (if you assign a position).
-------------------------------------------------------------------------------
   A        B        C        D                                E
--- Name---- Name---- -------- -------------------              Install
SYSA     ETCCIC4  MVCICS   EMPRISE TECH CICS V4.1           Not Installed
SYSA     ETCCIC4  MVVP     EMPRISE TECH CICS V4.1           Not Installed
SYSA     TERXCICS MVCICS   TENERA                           Not Installed
SYSA     ETCOLSOT MVCICS EMPIRE TECH CICS V3.3           Not Installed
SYSA     GUPCIC4  MVCICS   GUPTA CICS V4.10                 Not Installed
SYSA     ETCOLSOT MVVP EMPIRE TECH CICS V3.3           Not Installed
SYSA     GUPCIC4  MVVP     GUPTA CICS V4.10                 Not Installed
SYSA     IMSCTL   MVVP     IMS                              Not Installed
```

4. When finished, press the **END** (PF3) key.

5. In the **Save changes** field, type **YES**.

6. When prompted for the following information about the new view, complete each field and press **Enter**:
   
   - View name
   - Replace
   - Description
   - Dynamic fields
   - Summary view
   - Threshold Location

For descriptions of these fields, see the online Help or topic on creating and saving customized views.

**Related Information**

- “Creating and saving customized views (windows mode)” on page 215
Setting a complex filter (using the View Customization dialog)

Use the following procedure to limit the data shown in a view by setting complex filter conditions.

**Note**
Using the View Customization dialog, this procedure lets you apply one or more conditions against one or more data elements in a view. This method shows the positional parameters that are in effect and provides QWHERE and WHERE commands for you to populate. If you prefer to create this type of filter by entering QWHERE and WHERE commands on the view's COMMAND line, see Setting a complex filter (using the COMMAND line) on page 240.

The new filter will replace any previously specified filter.

**To set a complex filter**

1. Specify an element that you want to filter:
   a. On the COMMAND line of the view that you want to filter, type WHATis.
   b. Place your cursor on the field for the element to be filtered and press Enter.

      The Field Information window displays the internal name of the element that is associated with this field.

      **Example**
      Assume that you entered WHATis from the Plex Manager TGTDEF view and selected the Product field with your cursor. The Field Information window displays the element name as TGTDPROD.

   c. Note the name of the element as shown in the Field Information window, then press PF3 to exit.

      **Note**
      For the remainder of this procedure, examples assume that you are using the TGTDEF view to filter data to only products with names that start with MVI or MVV.

2. On the view's COMMAND line, type CUST and press Enter.

3. In the OPTION field, type P and press Enter.
The customization dialog is displayed:

```
------------------------ VIEW CUSTOMIZATION - TGTDEF --------------------------
OPTION ===> p  SCROLL ===> HALF
Options: (that require column selection)  Other options:
F - Format  M - Move  I - Include  G - Graph  S - Save view
O - Order  R - Repeat  X - Exclude  P - Parameters  E - Show excluded
L - Filter  T - Threshold  H - Hyperlink  Z - Summarize  K - Show template

--------------------< Positional Parameters for TGTDEF   >---------------------
# Col Element      Filter               # Col Element      Filter
1                  5
2                  6
3                  7
4                  8

This data displays filters, when QWHERE and/or WHERE commands were issued.
QWHERE

WHERE

A        B        C        D                                E
CMD CAS      Target   Product  Description                      Install
--- Name---- Name---- -------- ------------                     Status--
SYSA     IMSM     MVIMS    IMS                              Installed
SYSA     DB2P     MVVP     BBCS TEST DB2 V3                 Installed
SYSA     DB2X     MVVP     BBCS PROD DB2 V3                 Installed
SYSA     IMSM     MVVP     IMS                              Installed
SYSA     ETCCIC4  MVVP     EMPIRE TECH CICS V4.1           Not Installed
```

4 After **QWHERE** or **WHERE**, enter a filter condition.

**Example**

After **WHERE**, enter the following string to show only products with names that start with MVI or MVV:

```
(TGTDPROD = MVI*) OR (TGTDPROD = MVV*)
```

Conditional expressions must be enclosed in parentheses. For additional information about using QWHERE and WHERE with the **P** option, see the filtering information in the online Help or topic on QWHERE and WHERE commands.

5 Scroll down and press **Enter** to see the filtering results.

The WHERE command has applied the filter conditions against the data, and the view is updated as follows:

```
ddmmmyyyy hh:mm:ss -------- MAINVIEW WINDOW INTERFACE (Vv.r.mm) --------
COMMAND ===>                  SCROLL ===> HALF
CURR WIN ===> 1        ALT WIN ===>
>W1 =TGTDEF=============SYSB=====*========(99 BROWSE        )====PLEXMGR==U===22
CMD CAS      Target   Product  Description                      Install
--- Name---- Name---- -------- ------------                     Status--
SYSA     IMSM     MVIMS    IMS                              Installed
SYSA     DB2P     MVVP     BBCS TEST DB2 V3                 Installed
SYSA     DB2X     MVVP     BBCS PROD DB2 V3                 Installed
SYSA     IMSM     MVVP     IMS                              Installed
SYSA     ETCCIC4  MVVP     EMPIRE TECH CICS V4.1           Not Installed
```

6 (**optional**) Enter additional filtering conditions for additional elements, if needed.

7 When finished, press the **END (PF3)** key.
8 In the **Save changes** field, type **YES**.

9 When prompted for the following information about the new view, complete each field and press **Enter**:

- View name
- Replace
- Description
- Dynamic fields
- Summary view
- Threshold Location

For descriptions of these fields, see the online Help or topic on creating and saving customized views.

---

**Related Information**

- “Setting a complex filter (using the COMMAND line)” on page 240
- “QWHERE and WHERE commands” on page 237

---

### QWHERE and WHERE commands

QWHERE and WHERE are filtering mechanisms for data queries that pass through the MainView Infrastructure. Views and alarms use data queries to obtain the data that MainView monitoring products collect.

Use QWHERE and WHERE when performance or overhead is a concern due to large amounts of data being generated by a single query or by multiple repetitive queries.

<table>
<thead>
<tr>
<th>Clause</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QWHERE</td>
<td>Retrieves data from a MainView product and filters the data before the data is returned to the requester (view, alarm or API call) Use QWHERE when a query is being driven repetitively (such as with MainView Alarm Management) and appropriate filters will reduce the overhead of delivering the data required to satisfy the requirement.</td>
</tr>
</tbody>
</table>
WHERE

Retrieves data from the data returned by QWHERE and adds additional filters to the data before the data is returned to the requester (view, alarm or API call).

The advantage of using WHERE is to allow multiple filters to be applied against a query set without the overhead of having to issue the query again, and without refreshing the data already in memory.

Use WHERE when various filters need to be applied against a single query (such as online views that reformat data displayed to assist with problem resolution) without reissuing and refreshing the query.

**Example**

A view such as DEVSTAT (from MainView for z/OS) displays every I/O device defined in the system. This view could require a very large query set and could result in unnecessary overhead. Using QWHERE DXGTYPC = 3390 limits the query set to only 3390 devices and significantly reduces the amount of data to be processed by the display manager.

After the results of the QWHERE are stored in memory, you can use WHERE to filter the stored data, without having to perform the query again. For example, issuing the WHERE commands would not refresh the data. The data would be pulled from the existing results, saving the overhead of requesting the data again each time.

- WHERE DXGSER = PROD* limits the display to 3390 devices having VOLSERs prefixed with *PROD*.
- WHERE DXGSER = DEVL* limits the display to 3390 devices having VOLSERs prefixed with *DEVL*.

**WHERE and QWHERE syntax**

This topic describes the syntax to use for the WHERE and QWHERE commands.

A WHERE or QWHERE clause consists of one or more filter conditions, which are defined as an element name, operator, and value. The following table describes valid syntax for each type of operator:
### Type of operator

<table>
<thead>
<tr>
<th>Character fields</th>
<th>Valid syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character fields use the following operators:</td>
<td></td>
</tr>
<tr>
<td>■ = equals (not case sensitive)</td>
<td></td>
</tr>
<tr>
<td>■ &lt;&gt; not equal</td>
<td></td>
</tr>
<tr>
<td>■ == exactly equals (case sensitive); used to specify an exact match</td>
<td></td>
</tr>
<tr>
<td>■ IN to specify an either/or condition</td>
<td></td>
</tr>
<tr>
<td>For example, in (mv*,sys*) would be satisfied by any value starting with MV or SYS.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Numeric data</th>
<th>Valid syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric data requires an operator (such as &gt;, &gt;=, &lt;, &lt;=, &lt; &gt;, BETWEEN) followed by a number. The BETWEEN will be satisfied by numbers between two numbers. For example, BETWEEN 5 AND 10 would be satisfied by any numeric value &gt; 5 and &lt; 10.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Complex conditions</th>
<th>Valid syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex conditions require an operator such as:</td>
<td></td>
</tr>
<tr>
<td>■ OR (either condition)</td>
<td></td>
</tr>
<tr>
<td>■ AND (both conditions)</td>
<td></td>
</tr>
<tr>
<td>■ AVG (average of a group of values)</td>
<td></td>
</tr>
</tbody>
</table>

The following syntax rules apply when you use filter expressions to define filter conditions with WHERE or QWHERE:

- You can use NOT before any clause to make the opposite condition true.

- You can use wildcard characters ? and * within a pattern. The character ? is satisfied by any single character in that position. The character * is satisfied by any string of characters in that position.

- You can use a pattern only with the operators =, <>, IN, and NOT IN.

- Multiple constants or patterns used with IN or NOT IN must be separated by commas (,).

- Enclose complex conditions involving OR and AND operators in parentheses, including nested parentheses.
You can use an ampersand (&) for the AND operator, and a vertical bar (|) for the OR operator.

**Example**

- To display only values beginning with J or M in the field that has element name ASGNAME:
  \[ \text{ASGNAME IN (j*,m*)} \]

- To display only values that do not begin with J or M in the field that has element name ASGNAME:
  \[ \text{ASGNAME NOT IN (j*,m*)} \]

- To display only values between 5.0 and 60.5 in the field that has element name ASIDLYP:
  \[ \text{ASIDLYP BETWEEN 5.0 AND 60.5} \]

- To display only values that have T in the field that has element name ASREYFLC and values between 2 and 25 in the field that has element name ASGDMN, or values that start with SYS*, enter the following statements:
  \[ (\text{ASREYFLC = T* AND ASGDMN BETWEEN 2 AND 25}) \text{ OR (ASGNAME = SYS*)}(\text{ASREYFLC = T* & ASGDMN BETWEEN 2 AND 25}) \text{ | (ASGNAME = SYS*)} \]

- To display values with an average greater than 60 in the field that has element name ASIDLYP:
  \[ \text{ASIDLYP:AVG > 60} \]
  The average operator works only in summarized views.

---

**Setting a complex filter (using the COMMAND line)**

Use the following procedure to limit the data shown in a view by setting complex filter conditions on the **COMMAND** line.

**Note**

This procedure lets you create a complex data filter by entering QWHERE and WHERE commands on a view's **COMMAND** line. If you prefer to create this type of filter by using the View Customization dialog, see Setting a complex filter (using the View Customization dialog) on page 235. For a description of QWHERE and WHERE, see topic on QWHERE and WHERE commands. The new filter will replace any previously specified filter.
To set a complex filter

1 Specify an element that you want to filter:
   a On the COMMAND line of the view that you want to filter, type WHATis.
   b Place your cursor on the field for the element to be filtered and press Enter.

      The Field Information window displays the internal name of the element that is associated with this field.

      Example
      Assume that you entered WHATis from the Plex Manager TGTDEF view and selected the Product field with your cursor. The Field Information window displays the element name as TGTDPROD.

      c Note the name of the element as shown in the Field Information window.

      For the remainder of this procedure, examples assume that you are using the TGTDEF view to filter data to only products with names that start with MVI or MVV.

2 Place your cursor on the field for the element to be filtered and press Enter.

   Tip
   Make note of the name of the element so you do not have to repeat this step.

   The remainder of this example uses the TGTDEF view to filter data to only those products with names that start with MVI or MVV.

   Example
   By entering WHATis from the Plex Manager TGTDEF view and selecting the Product field with your cursor, a Field Information window displays with an Element Name of TGTDPROD for Product data elements.

3 On the COMMAND line of the view you want to filter, type QWHERE or WHERE and press Enter.
The dialog is displayed for the **WHERE** command and a similar one is displayed for the **QWHERE** command:

```
COMMAND ===>  
Where Condition:

Type END to update the form filter  
CANcel to quit without updating
```

### 4 Enter your filter conditions as shown below:

```
COMMAND ===>  
Where Condition:  
(TGTDPROD = MVI*) OR (TGTDPROD = MVV*)

Type END to update the form filter  
CANcel to quit without updating
```

For this example, under **Where Condition**, enter the string to construct a WHERE command:

**(TGTDPROD = MVI*) OR (TGTDPROD = MVV*)**

**TGTDPROD** is the element name for the **Product** data field. The condition is to show only those products with names that start with MVI or MVV. Conditional expressions must be enclosed in parentheses.

### 5 On the **COMMAND** line, type **END** and press **Enter** to see the results of the complex filter that you set:

The **WHERE** command has applied the filter conditions against the data and the view is updated with data that meets the filter conditions as shown in the following dialog:

```
COMMAND ===>  
CURR WIN ===> 1  ALTERNATE WIN ===>  >W1 =TGTDEF============SYSB=====*========(99 BROWSE)====PLEXMGU==U===22
CMD CAS Target Product Description Install
--- Name---- Name---- -------- --------------- Status--
SYSA IMSM MVIMS IMS Installed
SYSA DB2P MVVP BBCS TEST DB2 V3 Installed
SYSA DB2X MVVP BBCS PROD DB2 V3 Installed
SYSA IMSM MVVP IMS Installed
SYSA ETCCIC4 MVVP EMPRISE TECH CICS V4.1 Not Installed
```

---

**Note**

Any previously specified filter is replaced with the new filter.
If you want to save the view with the new filters, enter view customization with the CUSTom command and use the S option to save the view.

**Related Information**

- “Setting a complex filter (using the View Customization dialog)” on page 235
- “QWHERE and WHERE commands” on page 237

**Working with filter masks in windows mode**

In tabular views, you can use filters to display only the data that meets your criteria. Use the following procedure to change the filter masks for individual columns in a view.

The following Figure 26 on page 243 shows a view with the filter-mask row displayed below the column headers. (You can show or hide this row, as explained in the procedure.)

**Figure 26: Example of view with filter masks**

If the box below a header is blank, no filter mask is applied to that column. Initially, all of the boxes are blank because the view reflects the WHERE statement from the view definition.

**To filter the data in a view column**

1. If the filter-mask row is hidden, display it by entering INclude MASk on the Command line.

   **Tip**

   Entering INclude MASk ALL displays the filter-mask row in all views. EXClude MASk exits filter-mask mode and hides the filter-mask row.

2. For the relevant columns, type one or more filter conditions in the box below the column header.
You can add filter conditions to multiple columns as you require and apply them to the view all at the same time. You can also include wildcard characters and operators. The AND operator applies to all of the specified conditions.

3 Press **Enter**.

The column now displays only the data that matches your criteria. A message shows the WHERE statement for the currently displayed view. Keep in mind that the data has merely been filtered; no data updates have occurred.

4 To save this customized view, see topic on creating and saving customized views.

**WARNING**

If you save the view, the newly generated WHERE statement will replace the WHERE statement in the view definition. If the view normally requires a complex WHERE statement (with OR operators, nested conditions, or both), saving is *not* recommended because it would overwrite the complex WHERE statement. Also, note that changing the WHERE statement by using the Where primary command will not be reflected in the WHERE statement that is associated with the view or in the filter masks.

---

**Related Information**

- “Creating and saving customized views (windows mode)” on page 215
- “Filtering data in a view in windows mode” on page 232
- “Wildcard characters in requests” on page 279
- “QWHERE and WHERE commands” on page 237

---

**Deleting a customized view**

Use the following procedure to delete a customized view.

You can delete any view that was created with View Customization. Only site administrators can delete site-wide customized views.

**To delete a customized view**

1 On the **COMMAND** line, type **USER** and press **Enter**.

A list of user-defined views is displayed.
2 In the **line command** field, type D next to the view that you want to delete and press **Enter**.

---

**Note**

You can delete any user-defined view, but you cannot delete a view that was distributed with the product. User-defined views are identified by **U** on the window information line; distributed views are identified by **D**.
Working with historical data

This chapter contains topics for understanding how to work with historical data. You can access and view historical data as well as set up, generate, and manage historical batch reports.

Displaying historical data

If your system data from the past is stored in historical data sets, you can view it online. Use the following procedure to view historical data for any time increment (for example, for an hour ago, yesterday, or last month).

Before you begin

If you want to confirm that data has been recorded to historical data sets before proceeding, enter **DSLIST** or **VIEW DLIST** on the **COMMAND** line. A list of currently allocated historical data sets is displayed.

Note

**DSLIST** shows when the data was recorded. If a time period that you want is not shown, the data for that period might have been archived, overwritten, or never collected. Consult your system administrator if you need access to that data.

To display historical data

1. On the **COMMAND** line, enter the **TIME** command.

   The SET TIME FRAME window is displayed. The prompts in this window can help you complete the **TIME** command, which uses the following syntax:

   \[
   \text{TIME } date\ time\ [\{duration | NEXT | PREV\} \ dowMask \ todMask]\n   \]

2. In the SET TIME FRAME window, enter one of the following values for the date parameter (the ending date of the data that you want to see):
<table>
<thead>
<tr>
<th>Date value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ddmmyyyy$</td>
<td>Date in the same format as the current date, which always appears in the upper left corner of the screen (such as 15APR2012)</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> You can change the format of the date by entering <code>MVParms</code> on the <code>COMMAND</code> line and selecting the date option.</td>
</tr>
<tr>
<td><code>*</code></td>
<td>Current date</td>
</tr>
<tr>
<td><code>*-nnn</code></td>
<td>Number of days prior to today, up to 365 days</td>
</tr>
<tr>
<td><code>=</code></td>
<td>Date specified with a preceding TIME request</td>
</tr>
<tr>
<td><code>TODAY</code></td>
<td>Today’s date (same as specifying <code>*</code>)</td>
</tr>
<tr>
<td><code>TDAY</code></td>
<td></td>
</tr>
<tr>
<td><code>YESTERDAY</code></td>
<td>Yesterday’s date</td>
</tr>
<tr>
<td><code>YDAY</code></td>
<td></td>
</tr>
<tr>
<td><code>LASTdow</code></td>
<td>Date corresponding to the most recent occurrence of the specified day of the week</td>
</tr>
<tr>
<td><code>LabbreviatedDow</code></td>
<td>Replace <code>dow</code> with the full name of the day that you want to use (for example, LASTSUNDAY or LASTWEDNESDAY)</td>
</tr>
<tr>
<td></td>
<td>Replace <code>abbreviatedDow</code> with the first three characters of the name (for example, LSUN or LWED).</td>
</tr>
<tr>
<td><code>ENDOFMONTH</code></td>
<td>Last day of the previous month</td>
</tr>
<tr>
<td><code>EOM</code></td>
<td></td>
</tr>
<tr>
<td><code>ENDOFYEAR</code></td>
<td>Last day of the previous year</td>
</tr>
<tr>
<td><code>EOY</code></td>
<td></td>
</tr>
<tr>
<td><code>FIRSTOFWEEK</code></td>
<td>First day of the current week (Monday)</td>
</tr>
<tr>
<td><code>FOW</code></td>
<td></td>
</tr>
<tr>
<td><code>FIRSTOFMONTH</code></td>
<td>First day of the current month</td>
</tr>
<tr>
<td><code>FOM</code></td>
<td></td>
</tr>
<tr>
<td><code>FIRSTOFYEAR</code></td>
<td>First day of the current year</td>
</tr>
<tr>
<td><code>FOY</code></td>
<td></td>
</tr>
<tr>
<td><code>LASTWEEKDAY</code></td>
<td>Most recent weekday prior to today</td>
</tr>
<tr>
<td><code>LWKD</code></td>
<td></td>
</tr>
<tr>
<td><code>LASTWEEKENNDAY</code></td>
<td>Most recent weekend day prior to today (Sunday)</td>
</tr>
<tr>
<td><code>LWKED</code></td>
<td></td>
</tr>
</tbody>
</table>
3 For the time parameter, enter one of the following values:

<table>
<thead>
<tr>
<th>Time value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hh:mm</td>
<td>Ending time of the data that you want to see, where hh represents the hour and mm represents minutes</td>
</tr>
<tr>
<td>*</td>
<td>Current time</td>
</tr>
<tr>
<td>=</td>
<td>Time specified with a preceding TIME request</td>
</tr>
</tbody>
</table>

4 (optional) To set the time period over which you want your data summarized, specify one of the following items:

- Enter the duration parameter (specifying any value from the table that follows).
- Enter NEXT to use the duration value currently in effect to cycle forward by that duration amount.
- Enter PREV to use the duration value currently in effect to cycle backward by that duration amount.

**Note**
The TIME command lets you display data as it existed at the end of one interval (usually 15 or 30 minutes) unless you specify a longer duration here. When you request historical data with the TIME command, data from the most recent interval specified and preceding intervals is presented in a view. A detail view displays only the last interval in the time frame.

If you choose to enter the duration parameter, use one of the following values:

<table>
<thead>
<tr>
<th>Duration value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>nnnnH</td>
<td>Number of hours in the duration, where nnn is any number up to 9999</td>
</tr>
<tr>
<td>nnnnM</td>
<td>Number of minutes in the duration, where nnnn is any number up to 9999</td>
</tr>
<tr>
<td>Duration value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>$nnnn$</td>
<td>Number of recording intervals in the duration, where $nnnn$ is any number up to 9999</td>
</tr>
<tr>
<td>$nnnD$</td>
<td>Number of days in the duration, where $nnn$ is any number up to 416</td>
</tr>
<tr>
<td>$nnW$</td>
<td>Number of weeks in the duration, where $nn$ is any number up to 59</td>
</tr>
<tr>
<td>*</td>
<td>One recording interval</td>
</tr>
<tr>
<td>=</td>
<td>Duration specified with a preceding TIME request</td>
</tr>
<tr>
<td>TODAY</td>
<td>Today’s intervals back to midnight</td>
</tr>
<tr>
<td>TDAY</td>
<td>You can use this value only if you specified TODAY for the date parameter.</td>
</tr>
<tr>
<td>MONTH</td>
<td>One month back from the end date</td>
</tr>
</tbody>
</table>

5 (optional) If you want to limit the selected interval further, specify the dowmask parameter, the todmask parameter, or both:

- Use dowmask (day-of-week mask) to limit the selected intervals within the specified time to those that end on specific days of the week. If you specify dowmask, you must also specify todmask. To use this option, specify one of the following values:
  
  — = (retains the current day-of-week mask)
  
  — *, EVeryday, or EVday
  
  — Mondays or Mons
  
  — TUesdays or TUes
  
  — WEDnesdays or WEDs
  
  — THursdays or THus
  
  — Fridays or Fris
  
  — SAturdays or SAts
  
  — SUndays or SUns
  
  — WEEKDays or WKDays
—WEEKEnds or WKEnds

Alternatively, you can specify multiple days by providing a seven-character string of Y or N (Yes or No) indicators. In this string, the first character represents Sunday, the second Monday, the third Tuesday, and so on. Y indicates the day is selected. N indicates the day is not selected.

**Example**
The string `NYNYNYN` specifies Mondays, Wednesdays, and Fridays.

- Use `todmask` (time-of-day mask) to limit the selected intervals within the specified time to those that end within a time-of-day range. To use this option, specify one of the following values:
  - `=` (retains the current time-of-day mask)
  - `*`, `Allday`, or `Ad` (all hours of the day)
  - `Primeshift` or `Ps` (08:01 through 16:00)
  - `Swingshift` or `Ss` (16:01 through 00:00)
  - `Graveyardshift` or `Gs` (00:01 through 08:00)

  Alternately, you can specify an eleven-character string consisting of the start and end times in 24-hour clock notation separated by a dash.

  **Example**
The string `10:01-14:00` specifies intervals ending between 10:01 A.M. and 2:00 P.M.

6 Press **Enter** to display the historical data based on the parameters that you set.

**Related Information**

- “Examples of common TIME command requests” on page 251
- “Comparing historical system performance with current performance” on page 253
- “Viewing date and time fields for historical data” on page 254

### Examples of common TIME command requests

The TIME command examples in this topic demonstrate how to request historical data for various time intervals.
Table 20: TIME command examples

<table>
<thead>
<tr>
<th>Time interval request</th>
<th>Command string</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve data from one week ago</td>
<td>TIME 08APR2012 09:25</td>
<td>Displays data from the previous week at the end of the interval that contains 9:25 (that is, the interval between 9:15 and 9:30)</td>
</tr>
<tr>
<td>Display data from the next interval</td>
<td>TIME = = NEXT</td>
<td>Requests the next interval (the default) from the date and time last specified. Using the previous example, data from April 8, during the interval from 9:30 to 9:45, is displayed.</td>
</tr>
<tr>
<td>Display data for a specific time period</td>
<td>TIME 15APR2012 12:00 3H</td>
<td>Displays data from the three-hour period ending on April 15, 2012 at 12 noon</td>
</tr>
<tr>
<td>Display data from the next day</td>
<td>TIME 16APR2012 = =</td>
<td>Displays data from the next day during the same time period. The equal signs request the last specified time and duration. Using the previous example, these values would be 12:00 and 3H.</td>
</tr>
<tr>
<td>Display data for a specific time period</td>
<td>TIME 15APR2012 08:00 30M</td>
<td>Displays data for the 30 minutes ending at 8:00 on April 15</td>
</tr>
<tr>
<td>Display data for a specific time</td>
<td>TIME * 9:00</td>
<td>Displays data from today at 9:00. The asterisk indicates the current date.</td>
</tr>
<tr>
<td>Reestablish the current time</td>
<td>TIME * * *</td>
<td>Reestablishes the current time</td>
</tr>
</tbody>
</table>

**Note**

If the returned window information does not look as you expected, the probable cause is that data was not available during one or more of the intervals that you requested. For example, if you entered TIME * 11:00 4I, you would expect the following line:

```
======SYSB=======*======15APR2012===11:00====60M=MVMVP====2
```

If you receive the following line instead, data was not recorded between 10:45 and 11:00, so the time field says 10:45:

```
======SYSB=======*======15APR2012===10:45====45M=MVMVP====2
```
Comparing historical system performance with current performance

Use this procedure to create a second window for historical data in order to compare current and past system performance.

**To compare historical and current system performance**

1. Request the view that you want.

2. Create a second window:
   a. Enter the **HSplit** or **VSplit** command.
   b. Move the cursor to where you want the new window to begin.
   c. Press **Enter**.

   The CURR WIN field shows a 2, indicating that the second window is now active.

3. Use the **TIME** command to set the time for window 2.

   For example, if today’s date were April 15, 2012, and you wanted to set window 2 to yesterday’s date at 4:00 P.M., you would enter **TIME 14APR2012 16:00**.

4. Request the same view for window 2, which is still active.

   For example, assume you were using a MainView VistaPoint view requested via hyperlinks from the MVVP element in the Product column of the Plex Manager PLEX view. Your screen would resemble the following example:

```
>W1 -APOVERC-----------SYSB-----*--------ddmmmyyyy--hh:mm:ss----MVVP--D-------9
CMD Appl       Realtime %Obj  Interval %Obj  Session %Obj  Total
--- --------       0....50...100       0....50...100       0....50...100 Wklds
APBATCH ---- 138.5 ************+ 142.0 ************+ 142.0 ************+ 1
APPROD ---- 69.0 *********     105.5 ************+ 105.5 ************+ 1
BBPHONE 155.5 ************+ 26.5 ***            27.0 ***    1
GL 75.0 ************+ 87.5 ************+ 92.5 ************+ 1
LAURAAP1 ---- 87.0 ************+ 103.5 ************+ 1
OLTPWOK ---- ---- 103.5 ************+ 1
PAYROLL 116.5 ************+ 19.5 ***            20.0 ***    1
SAMPLE 108.0 ************+ 66.0 ************ 76.0 ************+ 1
TEST0620 ---- 43.5 ***            46.0 ***    1

>H2 -APOVERC-----------SYSB=====*========ddmmmyyyy==hh:mm:ss====MVVP==D=======9
CMD Appl       Realtime %Obj  Interval %Obj  Session %Obj  Total
--- --------       0....50...100       0....50...100       0....50...100 Wklds
APBATCH 155.5 ************+ 136.5 ************+ 134.0 ************+ 1
APPROD ---- 68.0 *********     114.5 ************+ 1
BBPHONE 155.5 ************+ 23.5 ***            34.5 ***    1
GL 150.0 ************+ 90.0 ************+ 92.5 ************+ 1
LAURAAP1 77.5 *********     99.0 ************ 89.5 ************+ 1
```
You can now compare today's system performance with yesterday's.

**Note**
The window status indicator for the second window shows H2. The *H* stands for historical data.

---

**Viewing date and time fields for historical data**

Use the following procedure to enable the display of the date and time fields for historical data.

Completing this procedure tells MainView to display the **Date** and **Time** fields that provide the following historical data:

- **Interval Date** shows the date that the data was collected.
- **Intvl Time** shows the ending time of the interval during which the data was collected.
- **Hr** shows the hour of day that the data was collected (for example, 8 for data collected at 8:30).

**To enable display of date and time fields**

1. On the **COMMAND** line, enter **MVParms**.
2. Select the **display** option.
3. In the Information Display Parameters dialog, enter **Y** in the **Show Time** and **Show Date** fields.

**Tip**
For quick access, you can issue the INCLUDE TIME and INCLUDE DATE commands to temporarily display the time and date information.

---

**Working with historical batch reports**

The following topic explains how to work with batch reports.
Overview of historical batch reports

MainView creates historical performance reports through the submission of batch jobs. The MainView Batch Reports panel assists you in generating JCL to produce the reports that you want.

You might want to submit a job each day to report on some of the key elements of performance for the previous day. The TIME command has several parameters that enable you to specify time frames relative to the current day. With the TIME command, you can submit the same job on a periodic basis without having to change the JCL.

To produce a report, you enter commands in a dialog, much as you would if you were in an online session. The resulting data is temporarily kept in virtual storage in the PAS. The tabular or detail report that you requested is then directed to a data set or SYSOUT. The report's format resembles the online tabular and detail displays; however, it displays all rows from the query and as many columns as your data set allows.

Note
Because the historical data is passed through the PAS before being written to a data set, you should be selective about the data that you request. You can use the QWHERE and WHERE commands to filter data in a query.
Accessing the MainView Batch Reports panel

You can initiate and manage the batch environment by using the following procedure to access the MainView Batch Reports panel. From this panel, you can set up the MainView batch environment and generate, edit, and browse MainView batch reports.

The MainView Batch Reports panel generates the JCL for reports that you want to run periodically. You can also use the panel to keep track of previously generated report JCL members. Each report can have up to 16 queries.

To access the MainView Batch Reports panel

1. From the MainViewSelection Menu, select U (Utilities, Tools and Messages).
2. Select 2 (MVBATCH).

The MainView Batch Reports panel lists the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>The MainView Batch Environment Setup panel displays so you can specify information for all reports.</td>
</tr>
<tr>
<td>Generate</td>
<td>The Generate MainView Batch Reports JCL panel displays so you can specify information specific to each report. From this panel, you can also submit the JCL to create reports.</td>
</tr>
<tr>
<td>Edit/Submit</td>
<td>The MainView Batch JCL Member List panel displays which details the members containing the generated JCL. From this panel, you can browse, delete, edit and submit the stored members.</td>
</tr>
<tr>
<td>Browse</td>
<td>The MainView Batch Reports list displays which details the batch reports that have been created. The list shows the location of a report -- either in a sequential data set or in a member of a partitioned data set (PDS). From this panel, you can browse these reports.</td>
</tr>
</tbody>
</table>
Setting up the MainView batch environment

Use the following procedure to set up the MainView batch environment so that you can create batch reports. After you specify the initial setup information, only minor adjustments will be needed for specific reports.

1. From the MainView Batch Reports panel, select 0 (Setup).

2. Specify the job and report information as follows:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Statement Information</td>
<td>Job card that conforms to your installation standards</td>
</tr>
<tr>
<td>Report Title</td>
<td>Title that you want to print at the top of your reports</td>
</tr>
<tr>
<td>MainView Clist Library</td>
<td>Name of the library containing the MainView CLIST</td>
</tr>
<tr>
<td>MainView Clist Name</td>
<td>Name of the MainView CLIST</td>
</tr>
<tr>
<td>MainView BBLINK Library</td>
<td>Name of the MainView BBLINK library</td>
</tr>
<tr>
<td>CAS SSID</td>
<td>Four-character CAS subsystem ID</td>
</tr>
<tr>
<td>Library to save JCL</td>
<td>ISPF library name for the saved JCL</td>
</tr>
<tr>
<td>Temporary Workfile Unit</td>
<td>Unit name for the temporary data sets</td>
</tr>
</tbody>
</table>

3. Press End to save your changes and return to the MainView Batch Environment Setup panel.

Related Information
Next Task to Perform:

- "Generating batch report JCL" on page 258
Generating batch report JCL

Use the following procedure to generate the MainView batch report JCL for individual reports and submit the batch report job.

Before you begin

Before creating batch reports, set up the MainView batch environment. The batch environment is used by all of the jobs that create batch reports. All jobs that create batch reports must use the batch environment.

**Note**
The generated JCL executes the MainView CLIST. The CAS and PAS must be started before the JCL is executed. For more information see, Setting up the MainView batch environment on page 257.

To generate batch report JCL

1. From the MainView Batch Reports panel, select 1 (Generate).

2. Specify the input information, output information, and queries that you need for your report, as follows:

<table>
<thead>
<tr>
<th>Command name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JCL Member Name</td>
<td>Name of the member in which the JCL will be sorted.</td>
</tr>
<tr>
<td>JCL Member Description</td>
<td>Description of the report created by the JCL.</td>
</tr>
<tr>
<td>Report Format</td>
<td>ASIS or CSV format:</td>
</tr>
<tr>
<td></td>
<td>- ASIS creates reports that look like the screens.</td>
</tr>
<tr>
<td></td>
<td>- CSV creates reports that consist of comma-separated fields so that you can download the report to a spreadsheet program.</td>
</tr>
<tr>
<td>Lines/Pages</td>
<td>The number of lines of data that should appear on each page</td>
</tr>
<tr>
<td></td>
<td>For ASIS reports, the heading is printed on each page by default. To print the heading for a continuous report on the first page only, specify 0.</td>
</tr>
<tr>
<td>Command name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Sysout Class      | **SYSOUT class** for the created report  
You must specify either a Sysout Class or an Output data set.  
When you specify a value here, it overrides the data set specification in **Output data set**. |
| Output data set   | Sequential data set or a partitioned data set with a member name for report output; if the data set is not catalogued, supply the volser.  
You must specify either an Output data set or a Sysout Class.  
If you specified a value in **SYSOUT Class**, it overrides the data set specification. |
| Product           | MainView product for which you want to generate batch reports  
To select from a list of products, press **PF4**. |
| Queries           | The data contained in the report  
Each line represents a different report to be created in the output data set.  
Enter queries exactly as you would on the **COMMAND** line in an online session.  
- **JOVER** creates the JOVER view.  
- **JOVER;FORM JSRM** creates JOVER using the JSRM FORM.  
- **JOVER** on the first line followed by **FORM JSRM** on the second line creates the JOVER report, followed by the JOVER report using the JSRM FORM.  
You can stack commands by separating them with a semicolon just as you would online. For example, to establish a time frame and duration different from the current time, combine that different time frame and duration with the first command, as follows:  
**TIME LASTWEEKDAY 23:59 1D;JOVER** |

3 Press the **End (PF3)** key to save changes and generate the JCL.  
The JCL is presented in an edit session. Generally, you will not need to make changes.  

4 Enter **SUB** on the **COMMAND** line to submit the job.
Managing batch report JCL members

Use the following procedure to manage the MainView batch report JCL members.

To display the MainView Batch JCL Member List

1. From the MainView Batch Reports panel, select 2 (Edit/Submit).

The MainView Batch JCL Member List shows a table of stored JCL members.

**Figure 27: MainView Batch JCL Member List**

<table>
<thead>
<tr>
<th>Command</th>
<th>MAINVIEW Batch JCL Member List</th>
<th>Scroll</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Commands: B - Browse JCL  DEL - Delete JCL E - Edit JCL SUB - Submit JCL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Press END to return to main menu</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LC</th>
<th>Member</th>
<th>Description</th>
<th>Time</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>WCPU</td>
<td>Weekly CPU Report</td>
<td>hh:mm:ss</td>
<td>yyyy/mm/dd</td>
<td></td>
</tr>
<tr>
<td>DCPU</td>
<td>Daily CPU Report</td>
<td>hh:mm:ss</td>
<td>yyyy/mm/dd</td>
<td></td>
</tr>
<tr>
<td>WDEVICE</td>
<td>Weekly Device Report</td>
<td>hh:mm:ss</td>
<td>yyyy/mm/dd</td>
<td></td>
</tr>
<tr>
<td>DDEVICE</td>
<td>Daily Device Report</td>
<td>hh:mm:ss</td>
<td>yyyy/mm/dd</td>
<td></td>
</tr>
</tbody>
</table>

**Tip**
The table is two panels wide. The directional arrows (>>> or <<<), above the list and on the right, indicate that additional JCL member information is available. Use the right scroll key to see information on the right, and use the left scroll key to return to the information on the left.

2. Select from the following line commands to perform these actions:

- E to edit a member
B to browse the JCL

DEL to delete a member

SUB to submit the job

**WARNING**

When a specific JCL member is deleted, the corresponding report data set or member is also deleted.

---

**Related Information**

**Next Task to Perform:**

- “Browsing batch reports for viewing online” on page 261

---

### Browsing batch reports for viewing online

Use the following procedure to browse a list of MainView batch reports and select a member for viewing online.

**To browse the Batch Report List and select a member for viewing**

1. From the MainView Batch Reports panel, select option 3 (Browse).

   The MainView Batch Report List shows the generated batch members that you can view online.

2. From the displayed MainView Batch Report List, locate the LC column to the left of the report list members, and type S next to the report that you want to view.

3. Press Enter.

### Viewing historical data in MainView Explorer

Use the following procedure to see system data from the past that is stored in historical data sets on the host. You can access the system data in any time increment, such as an hour ago, yesterday, or last month.
**Note**
If you are unsure whether data has been recorded in historical data sets, use the DLIST view. DLIST displays the historical data sets and shows the date and time that the data was recorded. If DLIST does not show the time period that you want, the data might have been archived, overwritten, or never collected.

**To display historical data in a view**

1. From any view, perform one of the following actions:
   - On the view toolbar, click the **Properties** button, then select the **Time** tab.
   - Right-click the view tab or the blank part of the view toolbar, and select **Properties**, then click on the **Time** tab.

2. In the **Time** tab, set **Time ending** by performing one of the following actions:
   - If you want to examine data from the past until the present moment, select the **Current** check box, then skip to Step 4 on page 262.
   - If you want to examine data from a particular time period of the past, clear the **Current** check box.

3. Using the time (**Hour Min**) and date (**Month Day**) pull-down lists, specify the end point of the time period you want to examine.

   **Example**
   If you want to examine data from 2 days ago until 5:00 pm, set the date back 2 days and the time to 17 00.

   **Tip**
   If you know the date for **Time ending**, but do not know the time of day to set, select the day using the **Month Day** pull-down list and for the hour and minutes set the latest time possible on that day (23 55).

4. Using the pull-down box and radio buttons, set the **Duration** of the time period you want to examine.

   Based on the end point of time that you have set, the duration controls which data from the past to collect and display in the historical data view. You can specify the duration as a number of intervals, minutes, hours, days, or weeks from the selected end point of time. The default duration is one interval; the interval is specified in the host product and is 15 minutes by default.
**Example**

If you select a duration of three intervals for the current time, you get three rows for each object, each one representing a 15-minute interval back from the current time.

5 *(optional)* To limit the intervals within the specified time period to those that end on a certain day or days of the week, select a value from the **Select days** list.

6 *(optional)* To limit the intervals within the specified time period to those that end within the selected time-of-day range, select a value from the **Select shift** list.

You can select any of the following shifts:

<table>
<thead>
<tr>
<th>Shifts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allday</td>
<td>All hours of the day</td>
</tr>
<tr>
<td>Primeshift</td>
<td>08:01 through 16:00</td>
</tr>
<tr>
<td>Swingshift</td>
<td>16:01 through 00:00</td>
</tr>
<tr>
<td>Graveyard</td>
<td>00:01 through 08:00</td>
</tr>
</tbody>
</table>

7 To display the historical data in the view, click the **Apply** button.

The status bar in the view frame indicates the specified time frame. If no historical data exists, the current time is displayed. This time period remains in effect until you reset it or close the view. All views that are opened by hyperlinking from this window also use the same time frame.

**Note**

A tabular view presents data from the most recent interval specified and preceding intervals. A detail view presents only the last interval in the time frame.
Working with full-screen mode displays

MainView products that operate in full-screen mode present their system performance information in standard ISPF displays.

Working with the Primary Option Menu

The following topic explains how to work with the Primary Option menu.

Primary Option Menu

The Primary Option Menu provides general services options and a selection of specific product options for whichever product you want to access.

MainView products that operate in full-screen mode present their system performance information in standard ISPF displays. Each MainView product that operates in full-screen mode has a Primary Option Menu. This menu is displayed when you access a product from a product area menu. Figure 28 on page 265 shows an example of a Primary Option Menu.

Figure 28: Primary Option Menu - Network Management Solutions

<table>
<thead>
<tr>
<th>OPTION</th>
<th>Network Management Solutions</th>
<th>DATE</th>
<th>TIME</th>
<th>USERID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MAINVIEW for IP</td>
<td></td>
<td></td>
<td>tsoid</td>
</tr>
<tr>
<td>1 MVIP</td>
<td>MAINVIEW for VTAM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 MVVTAM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E ALERTS</td>
<td>Alert Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M MESSAGES</td>
<td>Messages and Codes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P PARMS</td>
<td>Parameters and Options</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The first group of selections from a Primary Option Menu consists of specific product options that help you manage performance. These options vary greatly from product to product. See your individual product manuals for more specific information.

The general services options are available from the Primary Option Menu of each MainView product that runs in full-screen mode. These options provide the ability to:

- Display refreshed applications in a continuous timed cycle
- Display MainView service messages and monitor warnings, terminal session commands, and target system messages
- Display descriptions of messages generated by MainView products that run in full-screen mode
- Display supported terminals and PF key assignments
- Display online Help
- Terminate the product session

**Related Information**

- “Working with general services” on page 282
- “Program function (PF) key definitions” on page 270

---

**Performance data display**

The performance data display provides input and output data about the performance of a MainView product.

**Figure 29 on page 266** shows the header fields for a sample data display when running a full-screen mode product.

**Figure 29: Sample performance data display**

```
<table>
<thead>
<tr>
<th>DB2 SYSTEM STATUS</th>
<th>PERFORMANCE MGMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERV =&gt; DB2ST</td>
<td>INPUT hh:mm:ss</td>
</tr>
<tr>
<td></td>
<td>INTVL=&gt; 5 LOG=&gt; N</td>
</tr>
<tr>
<td></td>
<td>TGT=&gt; DB2G</td>
</tr>
<tr>
<td>PARM =&gt;</td>
<td>ROW 1 OF 26 SCROLL=&gt; CSR</td>
</tr>
<tr>
<td>EXPAND:</td>
<td>DB2EX, DBTS, USERS, CICSC, LOCKU, LKOUT, MON(ALL), EDMPL, BFRPL, ZPARM</td>
</tr>
</tbody>
</table>
```

This sample shows both input and output fields, which are available with most MainView products that run in full-screen mode. When the SERV and PARM fields...
are available (instead of the `COMMAND` line), you can use this display to request other display services.

The input fields are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERV</td>
<td>(MainView for DB2, MainView for DBCTL, and MainView for IMS Online only) Service select code (two to five characters long) for an analyzer display service, as described in the product manuals</td>
</tr>
<tr>
<td></td>
<td>- Application or product transfer command, as described in Transferring between applications in full-screen mode on page 304.</td>
</tr>
<tr>
<td>PARMS</td>
<td>(MainView for DB2, MainView for DBCTL, and MainView for IMS Online only) Optional parameters of up to 55 characters, as described in the product manuals</td>
</tr>
<tr>
<td>INTVL</td>
<td>Screen refresh interval</td>
</tr>
<tr>
<td></td>
<td>The default is 3 seconds.</td>
</tr>
<tr>
<td>LOG</td>
<td>Logging option to log the display to the terminal session Image log (Y or N)</td>
</tr>
<tr>
<td>TGT or CICS</td>
<td>Target system or subsystem (CICS, IMS, or DB2), as described in &quot;Specifying the target system&quot;</td>
</tr>
<tr>
<td>SCROLL</td>
<td>Amount to scroll for scrollable services</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also enter this value in the <code>SERV</code> field. If the display cannot be scrolled, N/A appears in this field.</td>
</tr>
</tbody>
</table>

The output fields are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT/RUNNING</td>
<td>Screen mode, either input or refresh (PF6)</td>
</tr>
<tr>
<td></td>
<td>INPUT indicates that input is accepted. RUNNING indicates that the screen is in refresh mode, and input is not accepted. You can exit refresh mode by pressing <code>ATTN</code> or <code>PA1</code>.</td>
</tr>
<tr>
<td><code>hh:mm:ss</code> or TIME</td>
<td>Time stamp</td>
</tr>
<tr>
<td>service title</td>
<td>The name of the service (up to 24 characters)</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXPAND</td>
<td>Displays that you can access from the current screen to view more information (see EXPAND line indicators on page 281)</td>
</tr>
<tr>
<td>lines 5 - nn</td>
<td>Number of lines of data</td>
</tr>
<tr>
<td>Note:</td>
<td>Scrollable services adapt to the terminal size.</td>
</tr>
</tbody>
</table>

#### Related Information

- “Transferring between applications in full-screen mode” on page 304
- “Specifying the target system” on page 269
- “EXPAND line indicators” on page 281

---

## Returning to the Primary Option Menu

Use the following procedure to return to the Primary Option Menu from any full-screen display.

1. Perform one of the following actions:

   - On the COMMAND line, enter the RETURN command.
     
     If you make the request from a product application, the display returns to the Primary Option Menu of the current product line; all intermediate panels are bypassed. If you make the request on the Primary Option Menu within a nested product line transfer, the display returns to the application from which the transfer was requested.

   - On the COMMAND line, enter the INITIAL command.
     
     The display returns to the first menu that was displayed when you either invoked the terminal session or transferred to it from windows mode.

*Note*

You can also assign the RETURN and INITIAL commands to function keys.

#### Related Information

- “Changing PF key assignments” on page 273
Specifying the target system

Full-screen mode requires that you specify a target system by name in order to direct all commands to that system. Use the following procedure to specify the target system.

The name of a system or subsystem (CICS, IMS, or DB2) appears in either the **TGT** or **CICS** field in the upper right corner of the application panel. This identifier is the target system for all commands that are entered in the application. A default target system for your terminal session is set by the TARGET parameter in the BBITSP00 member of the BBPROF data set.

You can change the target system for a session to direct commands to another system. The change remains in effect until changed again. This situation is also true for each window in split-screen mode; thus, you can maintain a different target system on each side of the split.

**To specify the target system**

1. Perform one of the following actions:

   - Enter the new name over the old name in the **TGT** or **CICS** field.
     A valid entry is the subsystem ID of the target DB2 or IMS subsystem, the region name of the target CICS region, or the name of the target system.

     **Note**
     The system name must be defined in the job name table in BBPARM member BBIJNT00.

   - Use the CYCLE SETUP option on the Primary Option Menu.
     Up to 30 different services from 30 different target systems can be displayed simultaneously by using the CYCLE service. Data is refreshed at specified time intervals. For more information, see *Setting up a service refresh cycle (full-screen mode)* on page 290

   - Use the SYSTEM command to change the name of the target system from the **COMMAND** line.
     To use the SYSTEM command, enter `SYSTEM name` on the **COMMAND** line.

     **Example**
     To change the name of the current target system to FIFT00, specify `SYSTEM FIFT00`. 
Working with program function (PF) keys

The following topic explains how to work with program function (PF) keys.

Program function (PF) key definitions

A set of program function (PF) key definitions is maintained for each MainView product family and the General Services LOG application. These definitions make PF key usage unique to each product.

Note

PF keys are also referred to as function keys or F keys.

The key definitions are maintained as members of a site or a user's BBPROF data set. The member name is xxxx PFK, where xxxx can be any of the following values:

- CICS, DB2, AO, or IMS for the product applications
- BBI for PF key defaults if no product application PF key members exist
- LOG for log display defaults

Table 21 on page 270 describes the default PF key definitions.

<table>
<thead>
<tr>
<th>PF key</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PF1 PF13</td>
<td>HELP</td>
<td>Displays online Help and tutorial information about the current application</td>
</tr>
<tr>
<td>PF2 PF14</td>
<td>SPLIT</td>
<td>Splits the screen at the cursor into two logical screens</td>
</tr>
<tr>
<td>PF key</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PF3 PF15</td>
<td>END</td>
<td>Returns to the previous application</td>
</tr>
<tr>
<td>PF4 PF16</td>
<td>PRINT (SCREEN COPY)</td>
<td>Copies the current screen to the BBISPRNT data set, which can be printed later</td>
</tr>
<tr>
<td>PF5 PF17</td>
<td>LOG DISPLAY or EXPAND</td>
<td>(MainView AutoOPERATOR, MainView for DB2, MainView for DBCTL, and MainView for IMS Online) Transfers to the Log Display general service (MainView for CICS) Expands to another service display to provide more information about the selected resource</td>
</tr>
<tr>
<td>PF6 PF18</td>
<td>GO</td>
<td>Refreshes an automatic service display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displayed application data is refreshed dynamically at the user-defined interval that is specified in the INTVL field of the application display. To stop the refresh cycle, use the attention interrupt key.</td>
</tr>
<tr>
<td>PF7 PF19</td>
<td>UP</td>
<td>Scrolls up (backward) the number of lines specified on the COMMAND line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: The default value varies with each application.</td>
</tr>
<tr>
<td>PF8 PF20</td>
<td>DOWN</td>
<td>Scrolls down (forward) the number of lines specified on the COMMAND line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: The default value varies with each application.</td>
</tr>
<tr>
<td>PF9 PF21</td>
<td>SWAP</td>
<td>Switches between the logical screens created with PF2/14</td>
</tr>
<tr>
<td>PF10 PF22</td>
<td>LEFT</td>
<td>Scrolls to the left</td>
</tr>
<tr>
<td>PF11 PF23</td>
<td>RIGHT</td>
<td>Scrolls to the right</td>
</tr>
<tr>
<td>PF12 PF24</td>
<td>RETRIEVE</td>
<td>Retrieves the last command entered on the COMMAND line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can reissue the retrieved command without changes, or you can change it and then reissue it.</td>
</tr>
</tbody>
</table>
Displaying the PF key definitions

On the Program Function Keys panel, you can view which commands are assigned to the function keys. Use the following procedure to see the current key definitions.

1. Use either of the following actions to display the Program Function Keys panel:
   - On the COMMAND line, enter the KEYS command.
   - If available from the Primary Option Menu, use the General Services KEYS option.

   **Note**

   If you specify KEYS, the definitions in xxxxPFK are displayed.

If a PF key member has not been created for the product application, the BBIPFK definitions are displayed.

**Figure 30: Program Function Keys**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PROGRAM FUNCTION KEYS</th>
<th>GENERAL SERVICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEYS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The current PF key assignments for BBI are as follows:

PF1 ===> HELP
PF2 ===> SPLIT
PF3 ===> END
PF4 ===> PRINT
PF5 ===> LOG
PF6 ===> GO

To save changes into profile, enter SAVE on the command line.
Changing PF key assignments

Use the following procedure to change the commands or labels assigned to the program function (PF) keys. The changes apply to your current session, but you can also save them in your profile for use in future sessions.

To change PF key assignments

1. Enter KEYS on the COMMAND line, or enter K (KEYS option) on the Primary Option Menu.

The Program Function keys panel displays current definitions for the primary PF keys (PF1 through PF12). Pressing Enter toggles the display between the primary keys and the alternate keys (PF13 through PF24).

2. To change the command assigned to a PF key, select the key and perform one of the following actions:

- Enter a new value over the displayed value.
  You can enter any valid system or MainView product command. You can also enter any value that is valid in the first input field of a display (such as the COMMAND, OPTION, or SERV field).

- Assign NOP to disable the PF key.

- Blank out the current value to restore the default definition. See Program function (PF) key definitions on page 270.

3. If you want to change a key's label, enter one of the following values in that key's LABEL field at the bottom of the panel:

Note

The BBIPFK member might contain the MASTER keyword for a shared BBPROF. If the MASTER keyword is specified, online PF key changes are temporary. They cannot be saved in your BBPROF data set.
Enter the label that you prefer.

- Enter **NOSHOW** to suppress showing this PF key on panels.

  **Note**
The ISPF PF$SHOW$ command tells ISPF to display the PF keys on panels. Setting a key’s label to NOSHOW prevents only that key from being displayed.

- Enter **BLANK** to display the key name (such as PF1) on panels but not the key’s label.

  **Note**
If no label is assigned to a key, the label becomes the first eight characters of the key’s assigned command.

4  *(optional)* If you want to save your changes for future sessions, enter the SAVE command on the **COMMAND** line.

The PF key definition is stored as a member of your BB$PROF$ data set.

  **Note**
An exception exists if the BB$IPFK$ member contains the MASTER keyword for a shared BB$PROF$. In that case, you cannot save your changes.

5  Press the **END (PF3)** key to exit.

Any changes that you made will take effect immediately.

**Related Information**

- “Program function (PF) key definitions” on page 270

---

**Controlling screens and displays in full-screen mode**

The following topic explains how to control screens and displays in full-screen mode.
Splitting the screen

Use the following procedure to split the screen into two application screens.

The placement of the cursor determines the position of the split. Splitting a screen puts the current application at the top of the split. The product’s Primary Option Menu (or ISPF Primary Option Menu if you invoked the product under ISPF) is below the split.

To split the screen

1. Position the cursor and press the SPLIT PF2/14 key.

   The active screen is indicated by the location of the cursor.

   **Tip**

   You can switch between screens by pressing the SWAP PF9/21 key. To return to a view of a single screen, activate the screen you want to close and press the END (PF3/15) key.

   **Note**

   In services with a SERV field, using SWAP erases the SERV value in the active display. You can use the RETRIEVE command to obtain the SERV value.

Exiting a display

Use the following procedure to exit the current display in full-screen mode.

1. Press END (PF3/15) or enter END at the command line.

   Full-screen mode exits from the display that you are currently viewing and returns to the previous menu. You can press END (PF3/15) multiple times until you reach the Primary Option Menu.

   **Note**

   After you specify a product line or application transfer, you can press this key to return to the original application or product line from which you made the transfer request. For more information, see Transferring between applications in full-screen mode on page 304.
Printing a screen

Use the following procedure to print a screen in full-screen mode.

1. On the command line, enter PRINT or press the PF4/16 key.

This action copies the current screen display to BBISPRNT, a special data set allocated to the terminal session. You can print the contents of BBISPRNT at any time. You can specify the terminal session CLIST parameter PRINT (YES) to create and allocate the print data set.

Note

To use this feature, you must have a BBISPRNT DD statement in the terminal session JCL. For more information, refer to the sample JCL in BBSAMP member SLOGJCL.

Refreshing a single display

Use the following procedures to control the refresh settings for a single display.

To refresh a single current service display

1. Perform one of the following actions:
   - Press GO (F6/18)
   - Type GO on the COMMAND line and press Enter.

2. (optional) Set the refresh interval.

You can change the default INTERVAL parameter in BBPROF member BBITSP00 by using one of the following methods:

   - Specify a new value in the INTV field.
   - If your screen does not have the INTV field, enter GO xx on the Command line, where xx specifies the new refresh interval.
To cancel the refresh settings

1 Use the **attention interrupt** procedure as defined by IBM.

Some keyboards require pressing the **RESET** key to unlock the attention interrupt key. The attention interrupt key also depends on your terminal:

- For SNA terminals, use the **ATTN** key.
- For non-SNA terminals, use the **PA1** key.

**Note**

The **Enter** key is not supported as a method for exiting screen refresh mode; however, some terminal types can use this method to cancel screen refresh. To enable several services to refresh cyclically, use the CYCLE SETUP option on the Primary Option Menu. Refer to “Using service refresh cycles” for details.

**Related Information**

- “Using service refresh cycles” on page 283

## Scrolling a display

The scroll function is available in full-screen mode for certain applications. Because the **SCROLL** field is always displayed, non-scrollable displays contain N/A in the **SCROLL** field.

Scrollable applications and their functionality are as follows:

<table>
<thead>
<tr>
<th>Scrollable application</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists</td>
<td>Scroll up or down</td>
</tr>
<tr>
<td>Service displays with CSR in the <strong>SCROLL</strong> field</td>
<td>Scroll up or down, or (if &lt;&lt; or &gt;&gt; is shown) scroll left or right</td>
</tr>
<tr>
<td>The options LOG DISPLAY and MESSAGES in General Services</td>
<td>Scroll up or down, and left or right.</td>
</tr>
</tbody>
</table>

The following function keys (also referred to as **PF keys**) control the scrolling function:
To scroll a specific amount

1. Perform one of the following actions:

   - For the list applications, enter a value for the scroll amount on the COMMAND line.
   - For the scrollable service displays, enter a value for the scroll amount in the SCROLL field or the SERV field.

You can use any of the following values for the scroll amount:

<table>
<thead>
<tr>
<th>SCROLL field value</th>
<th>Amount of scroll</th>
</tr>
</thead>
<tbody>
<tr>
<td>M or MAX</td>
<td>Scrolls to the bottom or top of a list</td>
</tr>
<tr>
<td>1 through 32,765</td>
<td>Scrolls to the corresponding number of lines</td>
</tr>
<tr>
<td>H or HALF</td>
<td>Scrolls half of a display screen amount</td>
</tr>
<tr>
<td>P or PAGE</td>
<td>Scrolls a full-page display screen amount</td>
</tr>
<tr>
<td>CSR</td>
<td>Scrolls to the cursor position</td>
</tr>
</tbody>
</table>

The following line signals the end of the scrollable data:

********** END OF DATA **********

Note

Image logging of a scrollable display logs all collected data, not just one screen. A MainView AutoOPERATOR IMFEXEC subcommand, IMFC, supports SCROLL=YES. Reissuing an IMFC analyzer display with SCROLL=YES retrieves additional screens until the END OF DATA line is reached. Each request retrieves
40 data lines.
**Wildcard characters in requests**

You can use plus signs (+) or asterisks (*) as wildcard characters to generate requests for multiple resources or workloads that have similar names.

You can use wildcards with:

- Parameters for various analyzer and trace services
- Selection criteria keywords for workload monitor and summary trace data collection services

You can use the wildcard characters (+) and (*) based on the following rules:

<table>
<thead>
<tr>
<th>Wildcard character</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
</table>
| +                  | The effect of the plus sign varies, based on where you place it in a string: | ■ On the Database and Table Space Status panel, entering `S XYZ+` displays all database names that begin with XYZ.  
■ Entering `S A++D` displays all names that consist of the letter A, followed by two characters, followed by D. |
|                    | ■ At the end of a string, the plus sign represents any characters that might follow. |                                                                         |
|                    | ■ At the beginning of the string or within the string, the plus sign represents a single character; that is, to represent exactly two characters in the middle of a string, you would enter two plus signs. |                                                                         |
| *                  | The asterisk always represents any number of characters (zero, one, or multiple characters), regardless of its position in the string. | ■ On the DB2 Trace Entries (LTRAC) display, entering `PLAN=DSNTI*` displays trace entries for all PLAN names that begin with DSNTI (for example, DSNTI, DSNTIW, and DSNTIZV5).  
■ Entering `PLAN=DSNT*I` displays trace entries for PLAN names DSNTI, DSNT3I, and DSNTAPOI). |
Expanding displays

From many full-screen services, you can easily expand a display to see additional, related displays that provide more information.

The method to expand a display depends on the MainView product you are running:

- Use the EXPAND line for the following products:
  - MainView for DB2 (all analyzer and trace displays)
  - MainView for DBCTL and MainView for IMS Online (some analyzer and trace displays)
  - MainView for CICS (most trace displays)

- Use the field expand function for MainView for CICS

Related Information

- “Expanding a MainView for CICS display” on page 280
- “EXPAND line indicators” on page 281

Expanding a MainView for CICS display

Use the following procedure to expand a field display in MainView for CICS. Expanding the display enables you to view additional statistics for a field or a displayed line of information.

1. From MainView for CICS, position the cursor on the field or line that you want to expand and press Enter.

2. *(optional)* In the expanded display, press Enter again to see additional information, if available.

3. To return to the original display, press END (PF3/15).

Related Information

- “EXPAND line indicators” on page 281
**EXPAND line indicators**

On many analyzer and trace displays, the EXPAND line indicates additional displays that you can access from the current screen to view more information.

Figure 31 on page 281 shows a sample EXPAND line.

**Figure 31: Sample EXPAND line**

```
SAMPLE SERVICE  --------PERFORMANCE MGMT
SERV ==>     TGT==> XXXXXXXX
PARM ==>     SCROLL==> CSR
EXPAND:  MON(USER), USERS, LINESEL(MSG)
```

This sample EXPAND line indicates that you can access the following items:

<table>
<thead>
<tr>
<th>EXPAND line indicator</th>
<th>Expands to</th>
</tr>
</thead>
<tbody>
<tr>
<td>MON(USER)</td>
<td>Selectable list of all active user activity monitors</td>
</tr>
<tr>
<td>USERS</td>
<td>USERS analyzer display</td>
</tr>
<tr>
<td>LINESEL(MSG)</td>
<td>Detailed description of any message displayed on the current screen</td>
</tr>
</tbody>
</table>

**Related Information**

- “Expanding a MainView for CICS display” on page 280
- “Selecting from the EXPAND line” on page 281
- “Using LINSEL” on page 282

**Selecting from the EXPAND line**

Use the following procedures to select and view the additional displays that are available from the EXPAND line.

1. Use the Tab key to highlight a selection in the EXPAND line and press Enter.

For each type of selection, use the following actions to access the information that is available from the expanded view:

- **MON(xxxx)**
  
  Displays a list of all active monitors related to area xxxx on the Active Timer Requests panel. Select any listed monitor to view a PLOT of the historical monitor values by typing the line command S and pressing Enter.
  
  To view a detailed display of the monitor's current values or activities, type a slash (/) as the first character in the PARM field.
xxxxx

Invokes the selected analyzer service or a display in another installed product, such as RxD2.

**Note**

These selections are inactive when the product is not available.

**LINESEL(xxxx)**

Accesses more detailed information about any line in the current display. This action has the same result as moving the cursor to a row of the display and pressing **Enter**.

### Using LINSEL

If LINESEL is listed in the EXPAND line in full-screen mode, use the following procedure to access the expanded view.

1. Use the **Tab** key to move to any row of the current display and press **Enter**.

   As you expand from one display to another, the previous display is saved in a stack.

2. *(optional)* Use any of the following actions to move between the stacked displays:
   - To return to the previous display, press the **END (F3)** key.
   - To return to the initial display when you are several levels deep in the stack, use the following methods:
     - From an analyzer service, type **CLEAR** in the **SERV** field and press **Enter**.
     - If you have selected one or more active monitor lists along your navigation path, press **END (F3)** until you reach an analyzer service.

---

### Working with general services

General services assist you in setting up service refresh cycles, displaying logs of product messages, checking function-key assignments, and using online Help. You can access the general services options from the Primary Option Menu of all MainView products that run in full-screen mode.
Note

- Not all options are available for all MainView products.
- The messages and log display options are available to all MainView products from the Utilities, Tools, and Messages option of the MainView Selection Menu.
- You must have a userID.BBPROF data set (your user profile data set) in order to use many of these functions.

You can complete the following main tasks from the Primary Option Menu:

- Using service refresh cycles on page 283
- Displaying logs on page 296

From the menu, you can also access the following general services options:

- Messages (see Using the Messages and Codes display on page 124)
- Keys (see Program function (PF) key definitions on page 270)
- Tutorial (see Accessing the online Help tutorial on page 34)

Related Information

- “Using the Messages and Codes display” on page 124
- “Accessing the online Help tutorial” on page 34
- “Program function (PF) key definitions” on page 270

Using service refresh cycles

Through the CYCLE SETUP option on your product’s Primary Option Menu, you can set up and run a timed, cyclic refresh for up to 30 display services. You can also invoke a saved refresh cycle that you predefined in a BBPROF data set member (your user profile data set).

To identify services for a refresh cycle, you must provide each service’s select code and product line type. Use Table 22 on page 284 as your reference when completing the following tasks:
Table 22: Select codes and product line types for service refresh cycles

<table>
<thead>
<tr>
<th>Service select code</th>
<th>Application description</th>
<th>Product line (Type)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BBI (General) applications</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JOU</td>
<td>JOURNAL</td>
<td>LOG Display</td>
</tr>
<tr>
<td>LOG</td>
<td>LOG Display</td>
<td></td>
</tr>
<tr>
<td><strong>CICS Operator Workstation (MAINVIEW AutoOPERATOR) applications</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STA</td>
<td>STATUS</td>
<td>CICS System Status</td>
</tr>
<tr>
<td><strong>IMS Operator Workstation (MainView AutoOPERATOR) applications</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EX</td>
<td>Status/Exception</td>
<td>IAO</td>
</tr>
<tr>
<td>REG</td>
<td>REGION</td>
<td>IMS Regions</td>
</tr>
<tr>
<td>STA</td>
<td>STATUS</td>
<td>Status/Exception</td>
</tr>
<tr>
<td><strong>MVS Operator Workstation (MainView AutoOPERATOR) applications</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DA</td>
<td>Address Spaces</td>
<td>MAO</td>
</tr>
<tr>
<td>DISP</td>
<td>DISPLAY</td>
<td>Address Spaces</td>
</tr>
<tr>
<td>ENQ</td>
<td>ENQUEUEUES</td>
<td>Enqueue/Reserve</td>
</tr>
<tr>
<td>OPER</td>
<td>OPERATOR</td>
<td>Operator Requests</td>
</tr>
<tr>
<td>OR</td>
<td>Operator Requests</td>
<td>MAO</td>
</tr>
<tr>
<td>REQ</td>
<td>REQUESTS</td>
<td>Operator Requests</td>
</tr>
<tr>
<td>RES</td>
<td>RESERVES</td>
<td>Enqueue/Reserve</td>
</tr>
<tr>
<td>STA</td>
<td>STATUS</td>
<td>System Status</td>
</tr>
<tr>
<td><strong>MainView AutoOPERATOR base applications</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALE</td>
<td>ALERTS</td>
<td>ALERTS Overview</td>
</tr>
<tr>
<td>EMA</td>
<td>EXEC Management</td>
<td>AO</td>
</tr>
<tr>
<td>EXEC</td>
<td>EXEC Management</td>
<td>AO</td>
</tr>
<tr>
<td>RUL</td>
<td>RULES</td>
<td>Automation Control</td>
</tr>
<tr>
<td>XAL</td>
<td>XALRTS</td>
<td>Alert Detail</td>
</tr>
<tr>
<td><strong>MainView for CICS applications</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AB</td>
<td>ABEND</td>
<td>ABEND Display</td>
</tr>
<tr>
<td>AI</td>
<td>AID</td>
<td>AID Display</td>
</tr>
<tr>
<td>AL</td>
<td>ALIAS</td>
<td>ALIAS Display</td>
</tr>
<tr>
<td>Service select code</td>
<td>Application description</td>
<td>Product line (Type)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>CLA</td>
<td>CLASSES</td>
<td>CLASSES Display</td>
</tr>
<tr>
<td>C</td>
<td>CONNECT</td>
<td>CONNECT Display</td>
</tr>
<tr>
<td>CONNX</td>
<td>CONNXPND</td>
<td>CONNXPND Display</td>
</tr>
<tr>
<td>CONNXPN2</td>
<td></td>
<td>CONNXPN2 Display</td>
</tr>
<tr>
<td>CONS</td>
<td>CONSOLES</td>
<td>CONSOLES Display</td>
</tr>
<tr>
<td>CST</td>
<td>CSTATUS</td>
<td>CSTATUS Display</td>
</tr>
<tr>
<td>DA</td>
<td>DATATABL</td>
<td>DATATABL Display</td>
</tr>
<tr>
<td>DB2S</td>
<td>DB2SYSP</td>
<td>DB2SYSP Display</td>
</tr>
<tr>
<td>DB2T</td>
<td>DB2TASK</td>
<td>DB2TASK Display</td>
</tr>
<tr>
<td>DBC</td>
<td>DBCTL</td>
<td>DBCTL Display</td>
</tr>
<tr>
<td>DBCTA</td>
<td>DBCTASK</td>
<td>DBCTASK Display</td>
</tr>
<tr>
<td>DBCTT</td>
<td>DBCTTASK</td>
<td>DBCTTASK Display</td>
</tr>
<tr>
<td>DD</td>
<td>DDIR</td>
<td>DDIR Display</td>
</tr>
<tr>
<td>DDIRXPN2</td>
<td>DDIRXPN2 Display</td>
<td>CICS</td>
</tr>
<tr>
<td>DDIRXPN2</td>
<td></td>
<td>DDIRXPN2 Display</td>
</tr>
<tr>
<td>DE</td>
<td>DEST</td>
<td>DEST Display</td>
</tr>
<tr>
<td>DL</td>
<td>DL/I</td>
<td>DL/I Display</td>
</tr>
<tr>
<td>DSA</td>
<td>DSAS</td>
<td>DSAS Display</td>
</tr>
<tr>
<td>DS</td>
<td>DSNAMES</td>
<td>DSNAMES Display</td>
</tr>
<tr>
<td>EN</td>
<td>ENQUEUE</td>
<td>ENQUEUE Display</td>
</tr>
<tr>
<td>EXI</td>
<td>EXITS</td>
<td>EXITS Display</td>
</tr>
<tr>
<td>F</td>
<td>FILE</td>
<td>FILE Display</td>
</tr>
<tr>
<td>FILEX</td>
<td>FILEXPND</td>
<td>FILEXPND Display</td>
</tr>
<tr>
<td>FILEXPND2</td>
<td>FILEXPND Display</td>
<td>CICS</td>
</tr>
<tr>
<td>G</td>
<td>GRAPH</td>
<td>GRAPH Display</td>
</tr>
<tr>
<td>I</td>
<td>ICE</td>
<td>ICE Display</td>
</tr>
<tr>
<td>J</td>
<td>JOURNAL</td>
<td>JOURNAL Display</td>
</tr>
<tr>
<td>LP</td>
<td>LPAS</td>
<td>LPAS Display</td>
</tr>
<tr>
<td>M</td>
<td>MONITOR</td>
<td>MONITOR Display</td>
</tr>
<tr>
<td>NUC</td>
<td>NUCLEUS</td>
<td>NUCLEUS Display</td>
</tr>
<tr>
<td>PL</td>
<td>PLAN</td>
<td>PLAN Display</td>
</tr>
<tr>
<td>PLANX</td>
<td>PLANXPND</td>
<td>PLANXPND Display</td>
</tr>
</tbody>
</table>

Chapter 8  Working with full-screen mode displays  285
<table>
<thead>
<tr>
<th>Service select code</th>
<th>Application description</th>
<th>Product line (Type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPST</td>
<td>PPST Display</td>
<td>CICS</td>
</tr>
<tr>
<td>P</td>
<td>PROBLEM</td>
<td>PROBLEM Display</td>
</tr>
<tr>
<td>PR</td>
<td>PROGRAM</td>
<td>PROGRAM Display</td>
</tr>
<tr>
<td>PSB</td>
<td>PSBNAME</td>
<td>PSBNAME Display</td>
</tr>
<tr>
<td>REG</td>
<td>REGIONS</td>
<td>REGIONS Display</td>
</tr>
<tr>
<td>REM</td>
<td>REMOTES</td>
<td>REMOTES Display</td>
</tr>
<tr>
<td>REV</td>
<td>REVIEW</td>
<td>REVIEW Display</td>
</tr>
<tr>
<td>SE</td>
<td>SESSIONS</td>
<td>SESSIONS Display</td>
</tr>
<tr>
<td>SH</td>
<td>SHARE</td>
<td>SHARE Display</td>
</tr>
<tr>
<td>ST</td>
<td>STATUS</td>
<td>STATUS Display</td>
</tr>
<tr>
<td>S</td>
<td>SUBPOOL</td>
<td>SUBPOOL Display</td>
</tr>
<tr>
<td>SUF</td>
<td>SUFFIXES</td>
<td>SUFFIXES Display</td>
</tr>
<tr>
<td>SUM</td>
<td>SUMMARY</td>
<td>SUMMARY Display</td>
</tr>
<tr>
<td>T</td>
<td>TASK</td>
<td>TASK Display</td>
</tr>
<tr>
<td>TC</td>
<td>TCBS</td>
<td>TCBS Display</td>
</tr>
<tr>
<td>TEMP</td>
<td>TEMPSTRG</td>
<td>TEMPSTRG Display</td>
</tr>
<tr>
<td>TEMPX</td>
<td>TEMPXPNDS</td>
<td>TEMPXPNDS Display</td>
</tr>
<tr>
<td>TE</td>
<td>TERMINAL</td>
<td>TERMINAL Display</td>
</tr>
<tr>
<td>TERMX</td>
<td>TERMXPND</td>
<td>TERMXPND Display</td>
</tr>
<tr>
<td>TI</td>
<td>TIOT</td>
<td>TIOT Display</td>
</tr>
<tr>
<td>TR</td>
<td>TRAN</td>
<td>TRAN Display</td>
</tr>
<tr>
<td>TRANX</td>
<td>TRANXPND</td>
<td>TRANXPND Display</td>
</tr>
<tr>
<td>TS</td>
<td>TSUT</td>
<td>TSUT Display</td>
</tr>
<tr>
<td>VT</td>
<td>VTAM</td>
<td>VTAM Display</td>
</tr>
</tbody>
</table>

**MainView for DB2 applications**

<table>
<thead>
<tr>
<th>Service select code</th>
<th>Application description</th>
<th>Product line (Type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BFRPL</td>
<td>Buffer Pool Status</td>
<td>DB2</td>
</tr>
<tr>
<td>CICSC</td>
<td>CICS DB2 Connections</td>
<td>DB2</td>
</tr>
<tr>
<td>CICSE</td>
<td>CICS DB2 RCT Entry</td>
<td>DB2</td>
</tr>
<tr>
<td>CICSR</td>
<td>CICS DB2 RCT Summary</td>
<td>DB2</td>
</tr>
<tr>
<td>CLAIM</td>
<td>Claims and Drains for Table Space Partitions</td>
<td>DB2</td>
</tr>
<tr>
<td>Service select code</td>
<td>Application description</td>
<td>Product line (Type)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>DBIO</td>
<td>I/O Analysis by Database/Table Space (DB/TS)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOA</td>
<td>I/O Analysis by Authorization ID (AUTHID)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOB</td>
<td>I/O Analysis -- BPOOL (Realtime)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOC</td>
<td>I/O Analysis by Connection Name (CONNECT)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOD</td>
<td>I/O Analysis -- Dataset (Realtime)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOF</td>
<td>I/O Analysis by Buffer Pool (BPOOL)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOK</td>
<td>I/O Analysis by Package/Program (PKG/PGM)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOL</td>
<td>I/O Analysis by Location (LOCATION)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOP</td>
<td>I/O Analysis by Plan (PLAN)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOR</td>
<td>I/O Analysis -- DB/TS (Realtime)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOS</td>
<td>I/O Analysis by SQL Statement (SQL STMT)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOT</td>
<td>I/O Analysis by Time (INTERVAL START)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBIOV</td>
<td>I/O Analysis -- Volume (Realtime)</td>
<td>DB2</td>
</tr>
<tr>
<td>DBTS</td>
<td>DB/TS Status</td>
<td>DB2</td>
</tr>
<tr>
<td>DB2EX</td>
<td>DB2 Exceptions</td>
<td>DB2</td>
</tr>
<tr>
<td>DB2ST</td>
<td>DB2 System Status</td>
<td>DB2</td>
</tr>
<tr>
<td>DDFCV</td>
<td>DDF Conversations</td>
<td>DB2</td>
</tr>
<tr>
<td>DDFDT</td>
<td>DDF Statistics Detail</td>
<td>DB2</td>
</tr>
<tr>
<td>DDFSM</td>
<td>DDF Statistics Summary</td>
<td>DB2</td>
</tr>
<tr>
<td>DDFVT</td>
<td>DDF VTAM Status</td>
<td>DB2</td>
</tr>
<tr>
<td>DLOGS</td>
<td>DB2 LOG Status</td>
<td>DB2</td>
</tr>
<tr>
<td>DMON</td>
<td>Monitor Summary</td>
<td>DB2</td>
</tr>
<tr>
<td>DTRAC</td>
<td>Detail Trace Entry</td>
<td>DB2</td>
</tr>
<tr>
<td>DUSER</td>
<td>Detail User Status</td>
<td>DB2</td>
</tr>
<tr>
<td>DWARN</td>
<td>Warning Summary</td>
<td>DB2</td>
</tr>
<tr>
<td>EDMPL</td>
<td>EDM Pool Status</td>
<td>DB2</td>
</tr>
<tr>
<td>LKOUT</td>
<td>Lockout History</td>
<td>DB2</td>
</tr>
<tr>
<td>Service select code</td>
<td>Application description</td>
<td>Product line (Type)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>LOCKD</td>
<td>Lock Contention by DB/TS</td>
<td>DB2</td>
</tr>
<tr>
<td>LOCKE</td>
<td>Lock Contention, User Detail</td>
<td>DB2</td>
</tr>
<tr>
<td>LOCKU</td>
<td>Lock Contention by User</td>
<td>DB2</td>
</tr>
<tr>
<td>LTRAC</td>
<td>DB2 Trace Entries</td>
<td>DB2</td>
</tr>
<tr>
<td>PLOT</td>
<td>Monitor History</td>
<td>DB2</td>
</tr>
<tr>
<td>RIDPL</td>
<td>RID Pool Status</td>
<td>DB2</td>
</tr>
<tr>
<td>STRAC</td>
<td>Summary Trace Entry</td>
<td>DB2</td>
</tr>
<tr>
<td>TSTAT</td>
<td>Trace Statistics</td>
<td>DB2</td>
</tr>
<tr>
<td>TSUMA</td>
<td>Trace Summary by AUTHID</td>
<td>DB2</td>
</tr>
<tr>
<td>TSUMC</td>
<td>Trace Summary by CONNECT</td>
<td>DB2</td>
</tr>
<tr>
<td>TSUML</td>
<td>Trace Summary by LOCATION</td>
<td>DB2</td>
</tr>
<tr>
<td>TSUMP</td>
<td>Trace Summary by PLAN</td>
<td>DB2</td>
</tr>
<tr>
<td>TSUMT</td>
<td>Trace Summary by TIME</td>
<td>DB2</td>
</tr>
<tr>
<td>USERS</td>
<td>User Summary</td>
<td>DB2</td>
</tr>
<tr>
<td>UTRAC</td>
<td>User Detail Trace</td>
<td>DB2</td>
</tr>
<tr>
<td>ZPARM</td>
<td>DB2 System Parameters</td>
<td>DB2</td>
</tr>
</tbody>
</table>

**MainView for IMS Online and MainView for DBCTL applications**

Unless indicated otherwise, the following applications are provided by both MainView for IMS Online and MainView for DBCTL.

<table>
<thead>
<tr>
<th>Service select code</th>
<th>Application description</th>
<th>Product line (Type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPCA (MVIMS only)</td>
<td>APPC Activity Summary</td>
<td>IMS</td>
</tr>
<tr>
<td>APPCL (MVIMS only)</td>
<td>APPC LU Status</td>
<td>IMS</td>
</tr>
<tr>
<td>BALGQ (MVIMS only)</td>
<td>BALG Queuing</td>
<td>IMS</td>
</tr>
<tr>
<td>CLASQ (MVIMS only)</td>
<td>Class Queuing</td>
<td>IMS</td>
</tr>
<tr>
<td>DAPPC (MVIMS only)</td>
<td>Inbound</td>
<td>Outbound Allocation</td>
</tr>
<tr>
<td>DBST</td>
<td>ISAM/OSAM Pools</td>
<td>IMS</td>
</tr>
<tr>
<td>DLIST</td>
<td>DL/I Call Status</td>
<td>IMS</td>
</tr>
<tr>
<td>DLTCH</td>
<td>Latch Detail</td>
<td>IMS</td>
</tr>
<tr>
<td>DMBUT</td>
<td>DMB Pool Utilization</td>
<td>IMS</td>
</tr>
<tr>
<td>DMON</td>
<td>Monitor Summary</td>
<td>IMS</td>
</tr>
<tr>
<td>DPOOL</td>
<td>Detail Pool</td>
<td>IMS</td>
</tr>
<tr>
<td>DREGN</td>
<td>Region Detail</td>
<td>IMS</td>
</tr>
<tr>
<td>DSPST</td>
<td>Dispatcher Statistics</td>
<td>IMS</td>
</tr>
</tbody>
</table>

288  MainView User Guide
<table>
<thead>
<tr>
<th>Service select code</th>
<th>Application description</th>
<th>Product line (Type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTRAC</td>
<td>Display Workload Trace</td>
<td>IMS</td>
</tr>
<tr>
<td>DWAIT</td>
<td>Display Workload Wait</td>
<td>IMS</td>
</tr>
<tr>
<td>DWARN</td>
<td>Warning Summary</td>
<td>IMS</td>
</tr>
<tr>
<td>FPBST</td>
<td>Fast Path Buffer Pool</td>
<td>IMS</td>
</tr>
<tr>
<td>IRLM</td>
<td>IRLM IMS Status</td>
<td>IMS</td>
</tr>
<tr>
<td>IRLMG</td>
<td>IRLM Global Status</td>
<td>IMS</td>
</tr>
<tr>
<td>ISTAT</td>
<td>Terminal Input Status</td>
<td>IMS</td>
</tr>
<tr>
<td>LATCH</td>
<td>Latch Summary</td>
<td>IMS</td>
</tr>
<tr>
<td>LCRES</td>
<td>IRLM Lock Contention by Resource</td>
<td>IMS</td>
</tr>
<tr>
<td>LCUSR</td>
<td>IRLM Lock Contention by User</td>
<td>IMS</td>
</tr>
<tr>
<td>LHRES</td>
<td>IRLM Locks Held by Resources</td>
<td>IMS</td>
</tr>
<tr>
<td>LHUSR</td>
<td>IRLM Locks Held by User</td>
<td>IMS</td>
</tr>
<tr>
<td>LOGST</td>
<td>Log Statistics</td>
<td>IMS</td>
</tr>
<tr>
<td>LUSRD</td>
<td>IRLM Lock User Detail</td>
<td>IMS</td>
</tr>
<tr>
<td>LTRAC</td>
<td>List of Trace Entries</td>
<td>IMS</td>
</tr>
<tr>
<td>MFSST (MVIMS only)</td>
<td>MFS Statistics</td>
<td>IMS</td>
</tr>
<tr>
<td>MFSUT (MVIMS only)</td>
<td>MFS Pool Utilization</td>
<td>IMS</td>
</tr>
<tr>
<td>OSTAT (MVIMS only)</td>
<td>Terminal Output Status</td>
<td>IMS</td>
</tr>
<tr>
<td>QUEST (MVIMS only)</td>
<td>Queue Statistics</td>
<td>IMS</td>
</tr>
<tr>
<td>PI</td>
<td>Program Isolation</td>
<td>IMS</td>
</tr>
<tr>
<td>PLOT</td>
<td>Monitor History</td>
<td>IMS</td>
</tr>
<tr>
<td>POOLC</td>
<td>Pool Summary (CBT)</td>
<td>IMS</td>
</tr>
<tr>
<td>POOLS</td>
<td>Pool Summary (non-CBT)</td>
<td>IMS</td>
</tr>
<tr>
<td>PSBUT</td>
<td>PSB Pool Utilization</td>
<td>IMS</td>
</tr>
<tr>
<td>REGNS</td>
<td>IMS Regions</td>
<td>IMS</td>
</tr>
<tr>
<td>REGND</td>
<td>Region Detail</td>
<td>IMS</td>
</tr>
<tr>
<td>RS</td>
<td>ESA Real Storage</td>
<td>IMS</td>
</tr>
<tr>
<td>SCHED (MVIMS only)</td>
<td>Scheduling Statistics</td>
<td>IMS</td>
</tr>
<tr>
<td>STAT / STATR</td>
<td>System Status</td>
<td>IMS</td>
</tr>
<tr>
<td>STRAC</td>
<td>Summary Trace Entry</td>
<td>IMS</td>
</tr>
<tr>
<td>TRANQ</td>
<td>Transaction Queue Status</td>
<td>IMS</td>
</tr>
</tbody>
</table>
Setting up a service refresh cycle (full-screen mode)

In full-screen mode, use the following procedure to set up a timed, cyclic refresh of up to 30 display services.

**Tip**
Alternatively, you can predefined a service refresh cycle by using keywords in a BBPROF data set member. Either method lets you save the refresh cycle in BBPROF for future use.

To set up a service refresh cycle

1. From the Primary Option Menu, select C (Cycle Setup).

The Service Refresh Cycle input panel is displayed.

**Figure 32: Example of the Service Refresh Cycle input panel**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>SERVICE</th>
<th>PARMS</th>
<th>TARGET</th>
<th>TYPE</th>
<th>DTIME</th>
<th>LOG</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MFSUT</td>
<td></td>
<td>IMSPROD</td>
<td>IMS</td>
<td>3</td>
<td></td>
<td>MFS POOL UTILIZATION</td>
</tr>
<tr>
<td></td>
<td>DB2ST</td>
<td></td>
<td>DB2A</td>
<td>DB2</td>
<td>3</td>
<td></td>
<td>DB2 SYSTEM STATUS</td>
</tr>
<tr>
<td></td>
<td>DA</td>
<td></td>
<td>SYSA</td>
<td>MVS</td>
<td>3</td>
<td></td>
<td>DISPLAY ACTIVE</td>
</tr>
<tr>
<td></td>
<td>FILE</td>
<td></td>
<td>CICSPROD</td>
<td>CICS</td>
<td>5</td>
<td></td>
<td>FILE DISPLAY</td>
</tr>
<tr>
<td></td>
<td>CAOSTAT</td>
<td></td>
<td>CICSP</td>
<td>CICS</td>
<td>3</td>
<td></td>
<td>SYSTEM STATUS</td>
</tr>
</tbody>
</table>

2. For each service that you want to define for this refresh cycle, complete the following fields:

   a. In the **SERVICE** field, enter the select code for the service (Table 22 on page 284).

   b. In the **PARMS** field, enter the applicable parameters for the selected service.

   c. In the **TARGET** field, enter a one- to eight-character target identifier.
Note
If you leave both TARGET and TYPE blank, the target displayed in the TGT field is used. If you leave TARGET blank but specify an entry for TYPE, the current target for the specified product line is used.

d In the TYPE field, enter the type of product line to process the requested service (Table 22 on page 284).

Note
You do not have to enter a product line type if only one product line is installed. If you do not specify a product line, the active product line is used. When multiple product lines are installed, you must specify a product line type if the service to be requested does not belong to the active product line.

e In the DTIME field, enter the number of seconds to show a service display before replacing it with the next display in the stack.

Note
If you leave this field blank, the default specified by the INTERVAL parameter in the BBPROF data set member BBITSP00 is used. The original default (distributed by BMC) is 3 seconds. If you specify the maximum of 30 services, each with a display time of 3 seconds, the first service in the refresh cycle is displayed approximately every 90 seconds.

f (MainView for DB2, MainView for DBCTL, and MainView for IMS Online only) In the LOG field, indicate whether to log screen images to the terminal session image log for offline printing (Y or N).

The default is N. A dash (-) in this field indicates that image logging is not supported for the requested service.

3 When you have no more services to define for this refresh cycle, press Enter.

Pressing Enter validates the specified services and shows the current values in the input fields. You can change any of the input field values, if needed.

Note
If you use all the rows on a panel, use forward and backward scrolling to define or display additional rows.

4 (optional) If you want to save this refresh cycle in your user profile data set for later reuse, enter either of the following commands:

- SAVE xx (where xx is an alphanumeric suffix for CYC)
SAVE memName (where memName is any three- to eight-character alphanumeric member name)

This refresh cycle is saved in the BBPROF data set.

**Related Information**

- "Starting and stopping a service refresh cycle" on page 295
- "Predefining a service refresh cycle in the BBPROF data set member" on page 292

---

**Predefining a service refresh cycle in the BBPROF data set member**

Use the following procedure to predefine a service refresh cycle that you can use repeatedly. In a member of your user profile data set (BBPROF), you enter keywords to define the services and parameters for the cycle.

**Note**
Creating and saving a service refresh cycle in the Service Refresh Cycle application also creates the refresh cycle in BBPROF.

**Before you begin**

You must have a *userid*.BBPROF data set to complete this procedure.

**To create a refresh cycle in a BBPROF member**

1. Create a BBPROF member and give it a name that meets either of the following requirements:
   - A meaningful one- to eight-character member name, such as MTODMIN or OPERATOR
   - CYC xx (where xx is two alphanumeric characters)

   You will use this member name to start the refresh cycle from the COMMAND line.

2. In the designated member, enter the following keywords for each service that you want to define for the refresh cycle:
   a. Enter SERV=serviceCode, and replace serviceCode with the select code for the service (Table 22 on page 284).
b Enter **OPT=parameters** to define the applicable parameters for the selected service.

You can enter multiple parameters (up to 60 characters), and you can use blanks to separate them. You can enclose the statement within single quotation marks, or omit the quotation marks. However, if you omit the quotation marks, the statement will terminate at the last parameter or comma.

c Enter **TARGET=targetID**, and replace **targetID** with a one- to eight-character target identifier.

---

**Note**

If you omit the **TARGET** and **TYPE** keywords, the refresh cycle uses the target displayed in the **TGT** field when you select this member on the Service Refresh Cycle application's COMMAND line. If you omit **TARGET** but include **TYPE**, the cycle uses the current target for the specified product line when the member is selected.

d Enter **TYPE=productType**, and replace **productType** with the type of product line to process the requested service.

A product line type does not need to be entered when only one product line is installed. If a product line is not specified, the active product line is used. When multiple product lines are installed, a product line type must be specified if the service to be requested does not belong to the active product line.

e Enter **INTVL=seconds**, and replace **seconds** with the number of seconds (from 1 through 99) to show a service display before replacing it with the next one.

The default value for **INTVL** is 3 seconds.

f **(MainView for DB2, MainView for DBCTL, and MainView for IMS Online only)** Enter **LOG=Y** or **LOG=N** to indicate whether to log screen images to the terminal session image log for offline printing.

---

**Note**

You can include comments by starting with an asterisk in column 1.

3 When finished entering services and parameters for this cycle, save this data set member.
The **Figure 33 on page 294** shows the use of the CYCLE SETUP application.

**Figure 33: Service Refresh Cycle input panel**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>SERVICE</th>
<th>PARMS</th>
<th>TARGET</th>
<th>TYPE</th>
<th>DTIME</th>
<th>LOG</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>MFSUT</td>
<td></td>
<td>IMSPROD</td>
<td>IMS</td>
<td>3</td>
<td></td>
<td>MFS POOL UTILIZATION</td>
</tr>
<tr>
<td>SERVICE</td>
<td>DB2ST</td>
<td></td>
<td>DB2A</td>
<td>DB2</td>
<td>3</td>
<td></td>
<td>DB2 SYSTEM STATUS</td>
</tr>
<tr>
<td>SERVICE</td>
<td>DA</td>
<td></td>
<td>SYSA</td>
<td>MVS</td>
<td>3</td>
<td></td>
<td>DISPLAY ACTIVE</td>
</tr>
<tr>
<td>SERVICE</td>
<td>FILE</td>
<td></td>
<td>CICSPROD</td>
<td>CICS</td>
<td>5</td>
<td></td>
<td>FILE DISPLAY</td>
</tr>
<tr>
<td>SERVICE</td>
<td>CAOSTAT</td>
<td></td>
<td>CICSP</td>
<td>CICS</td>
<td>3</td>
<td></td>
<td>SYSTEM STATUS</td>
</tr>
</tbody>
</table>

The services defined for a refresh cycle in **Figure 33 on page 294** could be defined in a BBPROF member as shown in **Figure 34 on page 294**.

**Figure 34: Sample cycle setup member in BBPROF**

```plaintext
* SAMPLE CYCLE SETUP MEMBER
* IMS DISPLAY MFS UTILIZATION
* SERV=MFSUT,TYPE=IMS,INTVL=3
* DB2 SYSTEM STATUS
* SERV=DB2ST,TYPE=DB2,INTVL=3
* MVS ACTIVE DISPLAY
* SERV=DA,TYPE=MVS,INTVL=5
* CICS OPEN FILE DISPLAY
* SERV=FILE,OPT=* OPEN,TYPE=CICS,INTVL=3
```

Once a BBPROF member is defined, you use SELECT or SET to invoke it (before issuing GO). The BBPROF member is selected by entering its name with a SELECT or SET command on the **COMMAND** line of the Service Refresh Cycle application. SELECT can be used to select a one- to eight-character BBPROF member name across product lines. SET can be used to specify the suffix of a CYC BBPROF member.
Starting and stopping a service refresh cycle

Use the following procedure to start and stop a service refresh cycle.

To start a cycle

1. Perform one of the following actions:
   - If you are starting a cycle from the application panel, enter the GO command (F6/18).
   - If you are starting a cycle from a predefined BBPROF member, use SELECT or SET to select the member, then enter the GO command (F6/18):
     - If the member name is one- to eight-characters, the member is invoked by the SELECT command.
     - The SELECT command uses the following syntax:
       `Select member` (where `member` is the BBPROF member name).
     - If the member name is CYCxx, the member can be invoked by using the SET command.
     - The SET command uses the following syntax:
       `SET xx` (where `xx` is the CYC suffix).

   **Note**
   - Press **Enter** to display the Service Refresh Cycle application with the BBPROF member specifications. Any of the values shown in the input fields can be changed.
   - Enter the GO command (F6/18) to start the cycle.

Each refreshed service display is shown in the sequence and time (DTIME) specified.
To stop a cycle

1 To stop the cycle, press the attention interrupt key (ATTN for SNA terminals and PA1 for non-SNA terminals).

**Note**

On some keyboards, you must press the RESET key to unlock the attention interrupt key. IBM defines the attention interrupt procedure, and TSO uses the same keys.

Also, note that the Enter key is not supported as a method for exiting screen refresh mode; however, some terminal types can use this method to cancel screen refresh.

When the cycle stops, the last display shown returns to the screen in INPUT mode. You can analyze the status and request other displays as usual. Pressing PF3 returns to the Service Refresh Cycle application and shows the service names, parameters, and any short messages. To restart the cycle, enter the GO command or press PF6/18.

Displaying logs

Through the Log Display option on your product’s Primary Option Menu, you can view the BBI-SS PAS journal log.

The Log Display is a 21-line window of the BBI-SS PAS journal log data set, which contains every command recorded in the BBI-SS PAS journal log. When you access the Log Display application, the most recent log entries appear at the top of the window. Figure 35 on page 296 shows a sample Log Display window.

**Figure 35: Sample Log Display window**

<table>
<thead>
<tr>
<th>COMMAND ====&gt;</th>
<th>TGT ====&gt;</th>
<th>DB2F</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:34</td>
<td>LOG</td>
<td>#1</td>
</tr>
<tr>
<td>12:11:00</td>
<td>DS0560W</td>
<td>(04)</td>
</tr>
<tr>
<td>12:12:00</td>
<td>DS0560W</td>
<td>(05)</td>
</tr>
<tr>
<td>12:12:55</td>
<td>XS6311I</td>
<td>BBI/SESSION FOR -CPS17 - TERMINATED</td>
</tr>
<tr>
<td>12:16:00</td>
<td>DS0560W</td>
<td>(09)</td>
</tr>
<tr>
<td>12:17:00</td>
<td>DS0560W</td>
<td>(10)</td>
</tr>
<tr>
<td>12:22:11</td>
<td>XS6304I</td>
<td>BBI/SESSION FOR -LAA1 - TO -D31X- INITIATED</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(01)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(02)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(03)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(04)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(05)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(06)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(07)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(08)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(09)</td>
</tr>
<tr>
<td>13:12:00</td>
<td>DS0560W</td>
<td>(10)</td>
</tr>
<tr>
<td>13:28:48</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:28:49</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:53:02</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:54:00</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:55:01</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:56:00</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:57:01</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:00</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:59:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
<tr>
<td>13:58:12</td>
<td>DSNW131I</td>
<td>- STOP TRACE SUCCESSFUL FOR TRACE NUMBER(S) 05</td>
</tr>
</tbody>
</table>
| 13:58:12 | DSNW131I | - STOP TRACE SUCCESSFUL FOR TRAC...
The Log Display window includes the following fields:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINE(n)</td>
<td>Number of the first line of the log that is being displayed</td>
</tr>
<tr>
<td>LOG (#n)</td>
<td>Number of the journal that is being displayed There are two online BBI-SS PAS journal log data sets.</td>
</tr>
</tbody>
</table>
| STATUS     | Application mode, which can be INPUT to enter data, or RUNNING for screen refresh:  
  ■ INPUT indicates that you can enter data. Commands can be entered on the COMMAND line. A new target system can be entered in the TGT field. A refresh interval can be entered in the INTV field. Pressing the GO (PF6/18) key changes the application status mode from INPUT to RUNNING (refresh mode).  
  ■ RUNNING indicates that the setting in the service refresh cycle setup controls the refresh rate of screen data. For more information, see Starting and stopping a service refresh cycle on page 295 and Setting up a service refresh cycle (full-screen mode) on page 290. |
| TIME       | Time that the Log Display was requested |
| INTV\(===>n\) | The screen refresh interval in seconds |

You can display the BBI-SS PAS journal log that belongs to any of the following targets:  
  ■ BBI-SS PAS associated with the system identified in the target field  
  ■ BBI-SS PAS when a BBI-SS PAS ID is specified in the target field  
  ■ Terminal session when LOCAL is specified in the target field

The identifier in the target field (TGT or CICS) can be changed to point to any valid DB2 or IMS subsystem, CICS region, z/OS system, or BBI-SS PAS, or to LOCAL.
Displaying BBI-SS PAS journal logs

The Log Display application displays all messages and commands from MainView products that are running in full-screen mode. Use the following procedure to view the log, which can also include target messages.

To display the BBI-SS PAS journal logs

1. Perform one of the following actions:
   - From any Primary Option Menu, select L (Log Display application).
   - On any panel of a full-screen application, press the LOG (PF5/17) key.

2. (optional) To view the origin identifier data and a date field, move the Log Display application window to the left with the PF10/22 key.

   You can use PF scroll keys or a Log Display primary command to move the Log Display window through the BBI-SS PAS journal.

   **Note**

   For any commands that were issued with a user password, ? replaces the password in the logged command.

   For each logged message, you can see the following information:

   - Time stamp of the message or command
   - Message origin identifier data, if applicable
   - Message text, as follows:
— All BBI commands and responses that are issued on behalf of the terminal session users assigned to the BBI-SS PAS

— All commands and responses that are issued automatically by BBI EXECs if MainView AutoOPERATOR is installed

— Time stamps for BBI-SS PAS start and stop and the target system start and stop

— MainView monitor and exception warning messages

— BBI informational and error messages

— All DB2 messages issued to the system console from selected target DB2 subsystems if they have been activated in BBPARM member DMRBEX00 (see the MainView for DB2 Customization Guide)

— All IMS and DBCTL messages issued to the system console from selected target IMS subsystems if MainView AutoOPERATOR for z/OS is installed. (A rule must be defined as described in the MainView AutoOPERATOR Basic Automation Guide.)

— All IMS messages that go to the AOI exit from selected target IMS subsystems if MainView AutoOPERATOR for IMS is installed. (A rule must be defined as described in the MainView AutoOPERATOR Basic Automation Guide.)

**Using scroll commands in the Log Display**

Use the following procedures to issue scroll commands to navigate within the Log Display.

**To scroll to the top or bottom of the log**

1. On the COMMAND line, enter one of the following commands:
   - Type TOP and press Enter to scroll to the top of the log.
   - Type BOTTOM and press Enter to scroll to the bottom.
   - Type M or MAX (for maximum) and press PF7/19 to scroll to the top or PF8/20 to scroll to the bottom.

**To scroll a specific number of lines or to scroll by page**

1. On the COMMAND line, enter the specific number of lines to scroll, or enter H (to scroll half a page) or P (to scroll a full page).
2 Press **PF7/19** to scroll up or **PF8/20** to scroll down.

**To scroll a specific number of columns**

1 On the **COMMAND** line, enter the number of columns to scroll, and press **PF10/22** to scroll left or **PF11/23** to scroll right.

The default is 21 columns.

**Using primary commands for Log Display**

Use the following primary commands, unique to the Log Display, to locate data anywhere in the BBI-SSPAS journal log or to refresh the Log Display data.

**To move a specific line to the top of the display**

1 On the **COMMAND** line, use the LOCATE command by entering **L xxxxx**.

Replace **xxxxx** with the line number that you want to move to the top of the Log Display.

---

**Note**

When you access the Log Display, the initial view shows the most recent log entries. The **LINE** field shows the line number for the first of these entries.

---

**To find an alphanumeric character or string of characters**

1 On the **COMMAND** line, use the FIND CHARACTERs command by entering **F searchString**.

Replace **searchString** with the alphanumeric character or string of characters that you want to find in the log.

---

**Tip**

You can control where to start the search. Specify **PREV** to search backward from the first displayed line, or **FIRST** to search forward from the first line of the journal log.

---

The following table shows examples of valid syntax:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>F c</td>
<td>F x</td>
</tr>
</tbody>
</table>
To find a specific time in the journal log for the current date

1 On the COMMAND line, use the FIND TIME command by entering `T time`.

Replace `time` with a specific time in the journal log for the current date.

The following table shows examples of valid syntax:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>T hh:mm:ss</td>
<td>T 11:30:00</td>
</tr>
<tr>
<td>T hh:mm</td>
<td>T 11:30</td>
</tr>
<tr>
<td>T hhmm</td>
<td>T 1130</td>
</tr>
<tr>
<td>T hh</td>
<td>T 11</td>
</tr>
</tbody>
</table>

To refresh the Log Display

1 On the COMMAND line, enter GO or press the GO (PF6/18) key.

The Log Display refreshes in the seconds specified in the INTV field. You can use the ATTN key (on an SNA terminal) or PA1 key (on a non-SNA terminal) to return to INPUT mode to enter data.

To issue DB2 commands

1 On the COMMAND line of any MainView application that is running in full-screen mode, enter `-db2cmd`.

Replace `db2cmd` with the DB2 command that you want to issue against the DB2 instance specified in the TGT field.

The following table shows an example of valid syntax:
To search a subset of messages within the journal log

1. On the **COMMAND** line, enter **PROFILE**.

   This command displays an input panel where you can define a subset of messages to include or exclude in the search.

2. Specify which messages from the journal log you want to see, based on the origin of the message.

   You can include or exclude up to six message origin patterns from the journal log display. You can use generic qualifiers to define these patterns.
The following example includes all messages from CICS* and excludes all messages from CICSTEST:

**Example**

The(Profile command)

Figure 36: Defining a subset of messages with the PROFILE command

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Log Display</th>
<th>General services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date --- yy/mm/dd</td>
<td>Included Origins</td>
<td>Excluded Origins</td>
</tr>
<tr>
<td>CICS*___</td>
<td>__________</td>
<td>________</td>
</tr>
<tr>
<td>________</td>
<td>________</td>
<td>________</td>
</tr>
<tr>
<td>________</td>
<td>________</td>
<td>________</td>
</tr>
<tr>
<td>________</td>
<td>________</td>
<td>________</td>
</tr>
<tr>
<td>________</td>
<td>________</td>
<td>________</td>
</tr>
</tbody>
</table>

The PROFILE specifications are saved in `userid.BBPROF` member LDPARM00, which provides individualized application profiles.

You also can include messages from the current target specified in the TGT field by specifying the variable &target in the Included Origins column:

**Figure 37: Including messages from the current target**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Log Display</th>
<th>General services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date --- yy/mm/dd</td>
<td>Included Origins</td>
<td>Excluded Origins</td>
</tr>
<tr>
<td>&amp;target_</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 38 on page 303** shows sample output produced by the profile specified in Figure 37 on page 303. This output displays only messages from target DB2F.

**Figure 38: Viewing messages from the current target**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Log Display</th>
<th>General services</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGT ===&gt; DB2F</td>
<td>Line</td>
<td>Time 10:33:25 INTV===&gt; 3</td>
</tr>
<tr>
<td>3.913</td>
<td>Log #1 Status INPUT Time</td>
<td></td>
</tr>
<tr>
<td>15:57:01 DW0120W (02) 15:57:00 AVG ELAPSED TIME(TRANS) = 99.882 (&gt;5.000) ***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:58:00 DW0121I 15:58:00 AVG ELAPSED TIME(TRANS) NO LONGER &gt; 5.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:58:00 DS0541I 15:58:00 CSA PAGING(TOTAL) NO LONGER &gt; 1800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:59:00 DW0120W (01) 15:59:00 AVG ELAPSED TIME(TRANS) = 99.690 (&gt;5.000) ***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:00:08 DW0121I 16:00:00 AVG ELAPSED TIME(TRANS) NO LONGER &gt; 5.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17:01:02 DS0540W (01) 17:01:00 CSA PAGING(TOTAL) = 2599 IN 01:00 MIN (&gt;1800)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17:02:00 DS0540W (02) 17:02:00 CSA PAGING(TOTAL) = 2530 IN 01:00 MIN (&gt;1800)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17:03:00 DS0540W (03) 17:03:00 CSA PAGING(TOTAL) = 2341 IN 01:00 MIN (&gt;1800)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17:04:00 DS0541I 17:04:00 CSA PAGING(TOTAL) NO LONGER &gt; 1800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18:19:00 DS0540W (01) 18:19:00 CSA PAGING(TOTAL) = 2185 IN 01:00 MIN (&gt;1800)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18:20:00 DS0541I 18:20:00 CSA PAGING(TOTAL) NO LONGER &gt; 1800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:18:00 DS0540W (01) 19:18:00 CSA PAGING(TOTAL) = 2251 IN 01:00 MIN (&gt;1800)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:19:00 DS0541I 19:19:00 CSA PAGING(TOTAL) NO LONGER &gt; 1800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:31:00 DW0120W (01) 19:31:00 AVG ELAPSED TIME(TRANS) = 101.138 (&gt;5.000) **</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:32:00 DW0120W (02) 19:32:00 AVG ELAPSED TIME(TRANS) = 99.313 (&gt;5.000) ***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:33:00 DW0121I 19:33:00 AVG ELAPSED TIME(TRANS) NO LONGER &gt; 5.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:34:00 DW0120W (01) 19:34:00 AVG ELAPSED TIME(TRANS) = 99.200 (&gt;5.000) ***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:35:00 DW0121I 19:35:00 AVG ELAPSED TIME(TRANS) NO LONGER &gt; 5.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:36:00 DW0120W (01) 19:36:00 AVG ELAPSED TIME(TRANS) = 99.200 (&gt;5.000) ***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:37:00 DW0120W (02) 19:37:00 AVG ELAPSED TIME(TRANS) = 99.170 (&gt;5.000) ***</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19:38:00 DW0121I 19:38:00 AVG ELAPSED TIME(TRANS) NO LONGER &gt; 5.000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To view the origin of the messages in the Log Display, scroll to the left.
Transferring between applications in full-screen mode

You can use application transfer commands to move temporarily from one full-screen application to another in the same product line, or in different product lines.

The following tables list the valid transfer commands:

- **Table 23 on page 304** shows the commands you can enter in any full-screen MainView application to transfer to another application within the same product line.

- **Table 24 on page 305** shows the commands you use to transfer from an application in one product line to an application in another product line. On any COMMAND line, you can enter a product-line transfer command from the first column, a semicolon, and an application transfer command from the second column. Doing so transfers to the application listed in the third column (assuming the product listed in the fourth column is installed).

For example, in **Figure 39 on page 304**, DB2;AT requests a transfer from the CICS SYSTEM STATUS application (the CICS option of the MainView AutoOPERATOR product) to the MainView for DB2 Active Timer Requests application.

**Figure 39: Example of application transfer between product lines**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>DB2:AT</th>
<th>CICS SYSTEM STATUS</th>
<th>AutoOPERATOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTERVAL</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td>INPUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TGT</td>
<td>CICSA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DATE</td>
<td>yy/mm/dd</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIME</td>
<td>hh:mm:ss</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 23: Application transfer commands (same product line)**

<table>
<thead>
<tr>
<th>Application transfer command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COD</td>
<td>CODES</td>
</tr>
<tr>
<td>CYC</td>
<td>CYCLE</td>
</tr>
<tr>
<td>FOC</td>
<td>FOCAL</td>
</tr>
<tr>
<td>JOU</td>
<td>JOURNAL</td>
</tr>
<tr>
<td>KEY</td>
<td>KEYS</td>
</tr>
<tr>
<td>LOGMSG</td>
<td></td>
</tr>
<tr>
<td>TI</td>
<td></td>
</tr>
</tbody>
</table>

Note: To return to full-screen mode, press the **End (PF3)** key or use the Quit command.
### Table 24: Application transfer commands (between product lines) Part 1 of 5

<table>
<thead>
<tr>
<th>Product-line transfer command</th>
<th>Application transfer command</th>
<th>Application description</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>MainView AutoOPERATOR for CICS or MainView for CICS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAO or CICS</td>
<td>ALE or ALERTS</td>
<td>Alert Overview</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td></td>
<td>AT</td>
<td>Active Timer Requests</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>BROA or BROADCAST</td>
<td>CICS Broadcast</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td></td>
<td>CMRTOOLS</td>
<td>MainView for CICSTools Menu</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>Current Traces</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>DM</td>
<td>Display Monitors</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>DW</td>
<td>Display Warnings</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>EX or EXEC or VIEW svc parm1, parm2</td>
<td>Execute a MainView for CICS service with defaults or passed parameters</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>HIST or HISTORY</td>
<td>MainView for CICS History Selection</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>HT</td>
<td>History Traces</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>PUT</td>
<td>MainView for CICS PUT Level</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>SD</td>
<td>Statistics and Defaults</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>SM</td>
<td>Start Monitor</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>ST</td>
<td>Start Trace</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>STA or STATUS</td>
<td>CICS System Status</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td></td>
<td>UGR or UGRAPH</td>
<td>User Defined Graph Selection</td>
<td>MainView for CICS</td>
</tr>
<tr>
<td></td>
<td>XAL or XALRTS</td>
<td>Alert Detail</td>
<td>MainView AutoOPERATOR</td>
</tr>
</tbody>
</table>
Table 25: Application transfer commands (between product lines) Part 2 of 5

<table>
<thead>
<tr>
<th>Product-line transfer command</th>
<th>Application transfer command</th>
<th>Application description</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>MainView AutoOPERATOR Base</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AO</td>
<td>ALE or ALERTS</td>
<td>ALERT Overview</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>DPM</td>
<td>Dynamic Parameter Manager</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>EMA</td>
<td>EXEC Management</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>EAS</td>
<td>Event Activity Statistics</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>EXEC</td>
<td>EXEC Management</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAS</td>
<td>Event Activity Statistics</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MSGS or MSGSTAT</td>
<td>Event Activity Statistics</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>OSPI</td>
<td>OSPI Script Development</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>NV</td>
<td>NetView Operator Workstation</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>RUL or RULES</td>
<td>Automation Control</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>SOF</td>
<td>Shared Object Facility</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>TI</td>
<td>Time-Initiated EXECs</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>XAL or XALRTS</td>
<td>Alert Detail</td>
<td></td>
<td>MainView AutoOPERATOR</td>
</tr>
</tbody>
</table>

Table 26: Application transfer commands (between product lines) Part 3 of 5

<table>
<thead>
<tr>
<th>Product-line transfer command</th>
<th>Application transfer command</th>
<th>Application description</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>MainView for DB2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DB2</td>
<td>AN</td>
<td>Analyzer Display Services</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>AT</td>
<td>Active Timer Requests</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>Product-line transfer command</td>
<td>Application transfer command</td>
<td>Application description</td>
<td>Product</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------</td>
<td>------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>DB2</td>
<td>CT</td>
<td>View Current Traces</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>DM</td>
<td>Display Monitors</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>DW</td>
<td>Display Warnings</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>GC</td>
<td>General Commands</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>GT</td>
<td>Graph Thread History</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>EX or EXEC svc parm1, parm2</td>
<td>Execute a MainView for DB2 service with defaults or passed parameters</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>HT</td>
<td>HISTORY Traces</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>IO</td>
<td>I/O Analysis Options</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>CTIO</td>
<td>Current I/O Traces</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>HTIO</td>
<td>History I/O Traces</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>MN</td>
<td>Data Collection Monitors</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>PM</td>
<td>DB2 System Status</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>SD</td>
<td>Display Statistics and Defaults</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>SM</td>
<td>Start Monitors</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>ST</td>
<td>Start Application Trace</td>
<td>MainView for DB2</td>
</tr>
<tr>
<td>DB2</td>
<td>VT</td>
<td>View Current Traces</td>
<td>MainView for DB2</td>
</tr>
</tbody>
</table>

Table 27: Application transfer commands (between product lines) Part 4 of 5

<table>
<thead>
<tr>
<th>Product-line transfer command</th>
<th>Application transfer command</th>
<th>Application description</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MainView AutoOPERATOR for IMS or MainView for IMS Online (including MainView for DBCTL)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IAO</td>
<td>ALE or ALERTS</td>
<td>ALERTS Overview</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>AN</td>
<td>Analyzer Display Services</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>AR</td>
<td>Data Entry Database Areas</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>AT</td>
<td>Active Timer Requests</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>CT</td>
<td>View Current Traces</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>DB, DAT, or DATABASE</td>
<td>Database</td>
<td>MainView AutoOPERATOR</td>
</tr>
</tbody>
</table>

Chapter 8  Working with full-screen mode displays  307
<table>
<thead>
<tr>
<th>Product-line transfer command</th>
<th>Application transfer command</th>
<th>Application description</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>IAO or IMS</td>
<td>DE</td>
<td>Data Entry Databases</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>DM</td>
<td>Display Monitor Requests</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>DW</td>
<td>Display Warnings</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>EXEC <code>svc parm1, parm2</code></td>
<td>Execute a service with passed parameters</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>EX</td>
<td>Status/Exception</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>GC</td>
<td>General Commands</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>HT</td>
<td>HISTORY Traces</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>ISC</td>
<td>ISC Links</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>LINE</td>
<td>BTAM Lines</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>LT or LTERM</td>
<td>LTERMS</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>MN</td>
<td>Data Collection Monitors</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>MS</td>
<td>Main Storage Databases</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>NO or NODE</td>
<td>VTAM nodes</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>PD</td>
<td>MainView for IMS Performance Management</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>PM</td>
<td>MainView for IMS Performance Management</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>PR or PROGRAM</td>
<td>Program</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>RC</td>
<td>Fast Path Routing Codes</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>REG or REGION</td>
<td>IMS Regions</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>SD</td>
<td>Display Statistics and Defaults</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>SM</td>
<td>Start Monitors</td>
<td>MainView for IMS</td>
</tr>
</tbody>
</table>
### Table 28: Application transfer commands (between product lines) Part 5 of 5

<table>
<thead>
<tr>
<th>Product-line transfer command</th>
<th>Application transfer command</th>
<th>Application description</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>IAO or IMS</td>
<td>ST</td>
<td>Start Trace</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO</td>
<td>STA or STATUS</td>
<td>Status/Exception</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO or IMS</td>
<td>TR or TRANSACTION</td>
<td>Transaction</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>IAO</td>
<td>VT</td>
<td>View Current Traces</td>
<td>MainView for IMS</td>
</tr>
<tr>
<td>IAO</td>
<td>XAL or XALRTS</td>
<td>ALERTS Detail</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>ALE or ALERTS</td>
<td>ALERTS Overview</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>DA</td>
<td>Address Spaces</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>DASD</td>
<td>DASD Status/Control</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>DISP or DISPLAY</td>
<td>Address Spaces</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>ENQ or ENQUEUEUES</td>
<td>Enqueue/Reserve</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>OPE or OPERATOR</td>
<td>Operator Requests</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>OR</td>
<td>Operator Requests</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>REQ or REQUESTS</td>
<td>Operator Requests</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>RES or RESERVES</td>
<td>Enqueue/Reserve</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>STA or STATUS</td>
<td>System Status</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>TAP or TAPE</td>
<td>Tape Status/Control</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>MAJ or MAJNODE</td>
<td>VTAM Major Nodes</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>Product-line transfer command</td>
<td>Application transfer command</td>
<td>Application description</td>
<td>Product</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------</td>
<td>-------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>MAO</td>
<td>APPL</td>
<td>VTAM Applications</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>CDRM</td>
<td>VTAM CDRMs</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>CDRS or CDRSC</td>
<td>VTAM CDRSCs</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>LINE</td>
<td>VTAM Lines</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>CLS or CLSTR</td>
<td>VTAM Clusters</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>TERM or TERMINAL</td>
<td>VTAM Terminals</td>
<td>MainView AutoOPERATOR</td>
</tr>
<tr>
<td>MAO</td>
<td>XAL or XALRTS</td>
<td>ALERTS Detail</td>
<td>MainView AutoOPERATOR</td>
</tr>
</tbody>
</table>
Index

? password indicator 298
@ character in user messages 124
* character
   as qualifier 279
   in scope 75
   in window information line 75
+ character
   more data indicator 74
> character
   more data indicator 74

2D Area button 152
2D Bar button 152
2D Column button 152
2D Line button 152
3270 emulator
   access 61
   keyboard map 61
   node 61
3270 screens, importing 145
3D Area button 152
3D Column button 152
3D Line button 152
3D Pie button 152

A
actions
   performing in MainView Explorer 141
   performing in windows mode 70
active targets 116
address spaces
   MainView 13
address spaces, MainView 17
Alerts node 61
ALL context 30
ALT WIN field 69, 115

Alternate Access. See MainView Alternate Access
alternate window 69, 115
AO transfer command 93
application transfer
   commands 304
description 304
asterisk (*)
   as qualifier 279
   in scope 75
   in window information line 75
ASU command 179
at (@) character in user messages 124
ATTN key
   canceling refresh 277
Auto-refresh button 49
automatic data refresh
   MainView Explorer 128
   windows mode 179
automatic screen update (ASU) 179

B
background, charts in MainView Explorer 157
batch reports, historical
   setting up batch environment 257
   initiating report JCL 256
   managing JCL members 260
   overview 255
BBI architecture 15
BBI-SS PAS
   description 16
   journal log 296
BBIJNT00 member 269
BBISPRNT data set 276
BBITSP00 member
   default time interval 276
   default target 269
BBMLIB data set 124
BBPROF data set 292
BBVDEF data set 215
C

CAO transfer command 93
CAS (coordinating address space) 15
Chart button 48
chart view 29
charts
   MainView Explorer 146
charts, importing into MainView Explorer 138
charts, MainView Explorer
   arranging topology charts 159
   changing background 157
   changing chart type 154
   changing colors 155
   changing fonts 155
   changing gauge type 158
   changing items 154
   copying 160
   opening 153
   rotating 159
   saving 161
   toolbar buttons 151
CICS transfer command 93
client, MainView Explorer
   description 37
   displaying information about 112
CLIENTS view 112
CLIST, MainView 86
Close button 51
CLOSE command 120
closing a window 120
CMF MONITOR
   transfer command 90
CODES command 304
color, changing 155
colors, MainView Explorer
   changing 108
   in headings 106
colors, windows mode
   assigning to thresholds 221
column filter, MainView Explorer 205
column header, changing in MainView Explorer 188
column ID
   MainView Explorer 187
command line
   full-screen mode 268
   MainView Explorer 56
   windows mode 69
commands
   line 70
   primary 69
   using for navigation 25
CONACT view 184, 185
CONACTD view 184, 186
CONACTP view 184
CONACTZ view 185
CONASEL view 184
context
   ALL 30
   CURRSSYS 30
   defined SSI 30
   description 30, 180
   dynamic SSI 30
   in window information line 75
   overview 22
   setting in MainView Explorer 85
   setting in windows mode 180
   single system image (SSI) 30
   single target system 30
   SYSPLEX 30
   SYSTEM 30
   CONTEXT command 180
Context tree 59
context-sensitive menus 52
control area 69
conventions, documentation 11
coordinating address space (CAS) 15
Copy data button 48
CSV files, creating in MainView Explorer 132
CURR WIN field 69
current window 69
CUSTOMSYS context 30
CUSTOM command 215
customization, MainView Explorer
adjusting precision 189
changing column headers and field names 188
design data views 24
display mode 191
duplicating fields 210
editing hyperlinks 196, 199
editing thresholds 194
excluding fields 210
graph upper limit 191
Groupby List 206
header information 107
including fields 210
moving columns and fields 109
overview 187
Parameter list 208
QWHERE 204
resizing columns and fields 110
saving views 211
setting chart items 209
showing zeros 190
Sort list 207
specifying conditions 206
summary view format 192
WHERE 204
customization, windows mode
design data views 24
F option 220
filter options 232
format option 220
H option 219
hyperlinks 219
I option 218
include option 218
L option 232
online Help 33
P option 232, 235
QWHERE clause 240
S option 232
save option 232
show option 218
Summarizing view 223
WHERE clause 240
CYCLE command 304
cycle refresh. See refresh cycle
CYCLE SETUP option 283, 290

data
Summarizing view 223
data files, importing into MainView Explorer 138
data sets
print (BBISPRNT) 276
historical 247
view (BBVDEF) 215
DATAR command 176
date
changing format 248
field for history data 254
in views 75
including field 254
interval 254
DB2
issuing commands 300
message logging 298
transfer command 93
Detach this view button 48
detail view 29
display, full-screen
exiting 275
expanding 280–282
printing 276
refreshing 276
description 266
expanding 280–282
scrolling 277
displays
definition 28
DSLIST view
windows mode 247
MainView Explorer 261
DTIME field 295
Duplicate field 210
duration
TIME parameter 249
window information line 75

data files, importing into MainView Explorer 138
data sets
print (BBISPRNT) 276
historical 247
view (BBVDEF) 215
DATAR command 176
date
changing format 248
field for history data 254
in views 75
including field 254
interval 254
DB2
issuing commands 300
message logging 298
transfer command 93
Detach this view button 48
detail view 29
display, full-screen
exiting 275
expanding 280–282
printing 276
refreshing 276
description 266
expanding 280–282
scrolling 277
displays
definition 28
DSLIST view
windows mode 247
MainView Explorer 261
DTIME field 295
Duplicate field 210
duration
TIME parameter 249
window information line 75

data
design data views 24
exiting 275
expanding 280–282

E

easy menus 228, 230
edit mode 76
electronic documentation 11
emulator, 3270
   access 61
   keyboard map 61
   node 61
Enable selections button 50
END key 89
ENDQUERY command 175
Enhanced Journal Facility 300
error messages 124
excluded fields, showing
   MainView Explorer 107
   windows mode 218
EXEC
   application transfer command 306, 308
   service select code 284
exiting
   full-screen display 275
   refresh cycle 277
   TSO session 89
expand display
   EXPAND line indicators 281
   methods to 280
   selecting from EXPAND line 281
   using LINESEL 282
Explorer. See MainView Explorer
Export view data
   automatic export example 137
Export view data button 49
exporting view data
   automatic export 134
   from MainView Explorer 132
   setting automatic export 134
EZExplorer views 61
EZPLEX menu 180

F

F keys. See PF keys
F option, customization 220
field Help 33
field ID
   MainView Explorer 187
field name, changing
   MainView Explorer 188
   windows mode 220
filter masks
   change 201
   display 201
   MainView Explorer 201
   windows mode 243
filter masks, MainView Explorer 201
filter properties, MainView Explorer 203
filtering data 200
   customization options 232
   L option 232
   P option 232, 235
   view parameters 71
filters, specifying conditions in MainView Explorer 206
finding view data
   MainView Explorer 130
   windows mode 178
FNEXT command 175
FOCAL command 304
font, changing 108, 155
FORM command 175
form name 74
format option, customization 220
formatting data
   MainView Explorer 187
   windows mode 220
FPREV command 175
frame hiding, MainView Explorer 44
frame unhiding, MainView Explorer 44
full-screen mode
   online Help 34
   retrieving commands 271
   tutorial 34
   application transfer commands 304
   definition 76
   general services 283
   transfer commands 90, 91, 93, 95
function keys. See PF keys

G

Gauge button 152
general services
   CYCLE SETUP 283, 290
   LOG DISPLAY 296
   MESSAGES 124
   overview 283
GO command
  refreshing service display 276
canceling 295
description 300
greater-than (>) character
  more data indicator 74
Groupby list 206

H

H option, customization 219
H window status 253
header buttons 51
Help
  online 11
Help button 48
Help, online
  full-screen mode 34
  commands 33
  customizing in windows mode 33
  fields 33
  hyperlinks 33
  MainView Explorer 32
  views 33
  window information line 33
  windows mode 33
hidden fields, showing
  MainView Explorer 107
  windows mode 218
historical data
  in windows mode 247
  TIME command 247
  batch reports 255
  date field 254
  in MainView Explorer 261
  overview 26
  time field 254
horizontal window 118
host actions, performing in MainView Explorer 141
host server, MainView Explorer
  description 37
  displaying information about 112
HS command 118
HSINFO view 112
hybrid view
  collapsing 176
  description 29
  expanding 176

hyperlinks, MainView Explorer
  editing 196, 199
  removing 197
  specifying conditions 206
  using 106
hyperlinks, overview 25
hyperlinks, windows mode
  between windows 115
  customizing 95, 219
  in views 227
  online Help 33
to other products 227

I

I option, customization 218
IAO transfer command 93
icon for alternate form 139
icons
  charts 151
  toolbar buttons 43
  toolbar buttons for views 47
  view tabs 46
importing charts into MainView Explorer 138
importing views into MainView Explorer 138
IMS transfer command 93
include option, customization 218
information line, window 74
INITIAL command 268
initial screen, setting 122
interface options
  MainView Explorer 19
  windows mode 20
interval
  date field 254
  refresh 298
  time field 254
INTVL field 293

J

JOURNAL command 284, 304
Mainview
  executing MainView commands 111
MainView
  address spaces 13, 17
  CLIST 86
  introduction 13
  Selection Menu 86
  terminal session 79
  user interfaces 37
MainView (for CICS)
  application transfer commands 305
  service select codes 284
  transfer command 90, 93
MainView (for DB2)
  application transfer commands 306
  service select codes 286
  transfer command 90, 93
MainView (for DBCTL) 288
  application transfer commands 307
  transfer command 90
MainView (for IMS)
  application transfer commands 307
  transfer command 90, 93
MainView (for IP)
  transfer command 90
MainView (for Linux - Servers)
  transfer command 90
MainView (for UNIX System Services)
  transfer command 90
MainView (for VTAM)
  transfer command 90
MainView (for WebSphere Application Server)
  transfer command 90
MainView (for WebSphere MQ)
  transfer command 90
MainView (for z/OS)
  transfer command 90
MainView Alarm Management
  transfer command 90
MainView Alternate Access 17, 18
MainView AutoOPERATOR
  application transfer commands 306, 309
  service select codes 284
  transfer command 93
MainView batch reports
  initiating report JCL 256
  managing JCL members 260
  overview 255
MAINVIEW batch reports
  setting up batch environment 257
Index 317

MainView Explorer Viewer. See MVE Viewer
MainView SRM
transfer command 90
MainView SYSPROG Services
transfer command 90
MainView Transaction Analyzer
transfer command 90
MainView VistaPoint
transfer command 90
MAO transfer command 93
MAXIMIZE command 119
maximizing a window 119
maximum number of windows 115
menu, Primary Option 265
menus
description 25
menus, context-sensitive 52
menus, windows mode
description 228, 230
Easy 228, 230
EZPLEX 180
MainView Selection 86
object 228, 230
messages
BBI-SS PAS journal log 300
full-screen mode 124
MainView Explorer 67
windows mode 124
messages frame, MainView Explorer 67
MESSAGES option 124
moving. See transferring between products
MSG command 124, 304
multiple systems, displaying 180
MVALARM transfer command 90
MV BATCH. See MAINVIEW batch reports
MVCICS transfer command 90
MVC SMON transfer command 90
MVDAC transfer command 90
MV D2 transfer command 90
MVMQS transfer command 90
MVMVS transfer command 90
MVE viewer
overview 135
MVE Viewer
automatic export example 137
launching in a browser 136
launching with requested view 136
MVIMS transfer command 90
MVIP transfer command 90
MVNLX transfer command 90
MVMQS transfer command 90
MVMVS transfer command 90

MainView Explorer 38, 200
3270 emulator node 61
3270 keyboard map 61
3270 screens, importing 145
Alerts node 61
changing background 157
charts 146
client information 112
colored headings 106
column filter 205
column ID 187
command line 56
console toolbar 43
Context tree 59
context-sensitive menus 52
copying view data 138
description 17
detaching a view 105
editing thresholds 194
emulator access 61
exporting views 132
field ID 187
filter masks 201
filter properties 203
finding view data 130
functionality 19
header buttons 51
hiding frames 44
host server information 112
importing charts 138
importing views 138
locating a view 105
messages frame 67
navigation frame 57
online Help 32
opening a view 104
performing host actions 141
personal configurations 143, 145
Plex displays 63
Plex node 64
PLEX node 60
Plex Topology 65
Product tree 60
publishing view data 139
refreshing view data 128
saving customized views 211
selecting multiple rows 131
showing excluded fields 107
showing header information 107
sorting view data 130
specifying conditions 206
starting 79
status line 57
threshold colors 108
unhiding frames 44
using hyperlinks 106
MVPARMS command
  date format 248
  threshold conditions 221
  time and date fields 254
MVS PAS 16
MVSP transfer command 90
MVSRM transfer command 90
MVTA transfer command 90
MVUSS transfer command 90
MVVP transfer command 90
MVVTAM transfer command 90
MVWEB transfer command 90

PAS (product address space)
  BBI-SS 16
  description 16
  MVS 16
  product-specific 16
  password, ? indicator 298
personal configurations
  closing 143
  importing 3270 screens 145
  overview 143
  saving 144
  setting default 144
PF keys, full-screen mode
  changing key assignments 273
  changing labels 273
  default definitions 270
  displaying definitions 272
  KEYS command 273, 304
  overview 270
PF keys, windows mode 73
PF10/22 (Log Display left scroll) 298
PF11/23 (Log Display right scroll) 299
PF2/14 (split screen) 275
PF3/15 (exit display) 275
PF4/16 (screen copy) 276
PF5/17 (Log Display transfer) 271
PF6/18 (GO) 295
PF9/21 (swap screen) 275
Plex displays, MainView Explorer 63
Plex Manager
  description 15, 16
  example 116
  transfer command 90
  views 180
Plex Map 64
Plex Map, working with 112
Plex node 64
PLEX node 60
Plex Topology 65
Plex Topology, working with 113
PLEX view 180
PLEXAREA view 180
PLEXMGR transfer command 90
PLEXOVER view 180
PLEXPROD view 180
plus (+) character
  as qualifier 279
  more data indicator 74
PMGLAUTH program requirement 97
positional parameters 72
predefined refresh cycle 290, 292
Previous button 48
PREVIOUS command 119
primary commands
  MainView Explorer 56
  windows mode 69
Primary Option Menu 265
Print button 48
printing
  screens 276
  MainView Explorer views 140
product 304
product address space (PAS)
  BBI-SS 16
  description 16
  MVS 16
  product-specific 16
product transfer
  application transfer commands 309
  full-screen mode 93
  maximum transfers 97
  overview 123
  windows mode 90
Product tree 60
product-line transfer commands 304
product-specific PAS 16
PROFILE command 300
Properties button 47
publications, related 11
Publish view images button 50
publishing view data 139

Q
QPARM command 71
query 175
question mark (?) password indicator 298
QWHERE
  customization 232
  description 237
  usage in MainView Explorer 204
  usage in windows mode 240

R
Refresh button 47
REFRESH command 304
refresh cycle
  canceling 295
  CYCLE command 304
  stopping 295
  using predefined member 292
refreshing data
  full-screen mode 276
  MainView Explorer 128
  windows mode 179
related publications 11
relational operator 206
remote system 180
reports, historical
  setting up batch environment 257
  initiating report JCL 256
  managing JCL members 260
  overview 255
Reset button 112
Reset time to current button 48
Rest button 152
RESTORE command 119
restoring windows 119
RETRIEVE command 271
RETURN command 268
right scrolling 299
Runtime Component System (RTCS), description 16

S
S option, customization 232
Save button 48
SAVE command 291
save option, customization 232
saving customized views
  MainView Explorer 211
  windows mode 215
SBBVDEF view library 214
scope
  command 180
  display 75
screens, full-screen mode
  exiting refresh mode 276
  printing 276
  splitting 275
refresh methods 290, 292
service refresh cycles 283
screens, windows mode
  creating 121
  data set 121
  displaying 122
  importing into MainView Explorer 145
  managing windows 121
  saving 121
  setting initial 122
scrolling
  display 277
  Log Display 299
  maximized windows 119
  windows 73
SELECT command 295
service refresh cycle 283
service refresh cycles
  product line types 283
  select codes 283
  setup 290
  using 283
service select codes 288
  MainView (for DBCTL) 288
  MainView (for IMS) 288
  MainView AutoOPERATOR 284
services, general
  CYCLE SETUP 283, 290
  LOG DISPLAY 296
  MESSAGES 124
  overview 283
Session Control Parameters panel 89
sessions
  terminal 79
SET command
  context 180
  service refresh cycle 295
SETD command 180
Show excluded fields button 50
SHOWFILT command 71
single system image context
  description 180
  displaying 184
  in MainView Explorer 85
  status 184
SNA terminals:
  canceling automatic refresh 277
SORT command 177
sorting view data
  MainView Explorer 130
  windows mode 177
  split-screen mode 97, 275

splitting a window 115
SSI context
  description 180
  displaying 184
  in MainView Explorer 85
  overview 22
  status 184
Stacked button 152
stacked charts, MainView Explorer 151
starting
  MainView Explorer session 79
  TSO session 86
status line, MainView Explorer 57
stopping
  refresh cycle 295
  TSO session 89
subsystem ID 89
Summarizing view, data 223
summary view 29
Synchronize button 47
SYSNAME context 31
SYSPLEX context 30
sysplex views 180
SYSTEM context 30
systems, displaying multiple 180

T

tabular view 29
targets
  active 116
  changing 269
  context 75, 85
  parameter 293
  selecting 269
  views 180
terminal session, full-screen mode
  exiting 275
  expanding a display 280–282
  printing a screen 276
  screen copy facility 276
  splitting the screen 275
  expanding a display 280–282
  image log 293
  scrolling display 277
  specifying a target system 269
terminal session, MainView
description 17, 79
starting MainView Explorer 79
starting TSO 86

terminal sessions 79
terminating
  refresh cycle 277

TGT field
  changing 269
  default target 269
  Log Display 296, 298
  predefined refresh cycle 293

thresholds, MainView Explorer
  changing color 108
  editing 194
  specifying conditions 206
  viewing exceptions 61

thresholds, windows mode
  setting 221

TI command 304, 306

time
  examples 251
  field for history data 254
  in views 75
  including field 254
  interval 254

TIME command
  MainView Explorer 261
  windows mode 247

toolbar buttons, MainView Explorer
  charts 151
  console 43
  view 47

Topology button 48, 152

TRANSFER command
  full-screen to windows mode 90
  in MainView Explorer 106
  windows to full-screen mode 93

transferring between products
  application transfer commands 304
  full-screen mode 93
  maximum transfers 97
  overview 123
  windows mode 90

TSO session
  starting 86
  stopping 89

tutorial
  full-screen mode 34
  windows mode 33

types of views
  description 29
  MainView Explorer 46

U

UAS (user address space)
  description 17
  starting 79

UNLOCK command 176

user
  messages 124
  view library 215

user address space (UAS)
  description 17
  starting 79

user interfaces, MainView 37

USER view 244

V

view containers
  arranging views in 165
  Auto-Refresh 167
  creating 163
  detaching 166
  exporting data 170
  overview 162
  publishing images 170
  refreshing data 167
  removing views 166
  saving configuration 171
  selecting actions 168
  stopping refresh 167

view frame
  MainView Explorer 45

view tabs, MainView Explorer 46
views
  chart 29
  context 30
  definition 28
  detail 29
  hybrid 29
  hybrid, collapsing 176
  hybrid, expanding 176
  log 29
  summary 29
  tabular 29
  types 29
  working with 31
views, MainView Explorer
  adjusting precision 189
  changing colors 108
  changing column headers and field names 188
  changing font in views 108
  command line 56
  copying data 138
  customizing 187
  detaching 105
  display mode 191
  exporting 132
  filtering data 200
  finding data 130
  graph upper limit 191
  header buttons 51
  historical data 261
  importing 138
  locating 105
  locking data 128
  moving columns and fields 109
  online Help 32
  opening 104
  performing host actions 141
  printing 140
  publishing data 139
  refreshing data 128
  resizing columns and fields 110
  selecting multiple rows 131
  showing excluded fields 107
  showing header information 107
  showing zeros 190
  sorting data 130
  status line 57
  summary view format 192
  toolbar buttons 47
  types of 46
  using hyperlinks 106
views, windows mode
  historical data 247
  adding fields 218
  assigning colors 221
  changing field names 220
  creating 215
  data set 215
  date 75
  deleting user-defined 244
  description 173, 174
  displaying data in 173, 174
  elements 218
  filtering data 232
  finding data 178
  forms and queries 175
  hyperlinks 219, 227
  locating data 178
  locking data 176
  name 74
  online Help 33
  parameters 71
  performing actions 70
  refreshing data 179
  sorting data 177
  sysplex 180
  time 75
  user library 215

W
  web browser 17
  WHATis command 223, 235, 240
  WHERE
    customization 232
    description 237
    usage in MainView Explorer 204
    usage in windows mode 240
  window information line
    description 74
    online Help 33
windows
   alternate 69, 115
   changing active 115
   closing 120
   control area 69
   creating 115
   current 69
   description 68
   H status 253
   horizontal 118
   hyperlink between 115
   information line 74
   maximizing 119
   opening 115
   restoring 119
   scrolling 73
   scrolling maximized 119
   splitting 115
   Wn command 115

windows mode
   command line 69
   definition 67
   functionality 20
   online Help 33
   performing actions 70
   setting thresholds 221
   transfer commands 90, 91, 93, 95
   tutorial 33